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CartoVista Publisher Help Content 

 

 

Version:  4.1.1 

Last Update: May 6, 2016 

Welcome to the CartoVista Publisher User Guide. 

This documentation is designed to answer all of your questions about using the 
CartoVista Publisher. 

NOTE: This version of the Publisher is compatible with version 4.1.1 or higher of 

the CartoVista Flash Viewer. To see which version of the CartoVista viewer you 
have, click on the CartoVista logo at located on the bottom-right of the map. 

Getting started with the CartoVista Publisher... 

To get more information to the CartoVista solution and its capabilities, please refer 
to the CartoVista documentation. 

  

  



CartoVista Publisher Documentation 

2 

  

 

Copyright Information 

 

 

CartoVista is a registered trademark of CartoVista inc. The CartoVista 
software, including all related files and documentation is protected by 

copyright. Please refer to the CartoVista Publisher End User License 
Agreement for more information on the terms of use of the software. 

Adobe Flash and the Adobe Flash Player are registered trademarks of 

Adobe Systems Incorporated. 

  

https://www.cartovista.com/
https://cartovista.com/eula/cartovista-publisher-end-user-license-agreement
https://cartovista.com/eula/cartovista-publisher-end-user-license-agreement
http://www.adobe.com/
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Getting Support for CartoVista 

 

Contacting Technical Support 

If you encounter problems working with the CartoVista Publisher, our technical 
support experts can help. Technical support includes referrals to documentation, 

assistance with error messages and suggestions for causes of error messages. 

Technical Support is available in North America Monday - Friday from 8:00am - 
4:00pm EST, excluding holidays. Please remember to include your serial number or 
contract number when contacting technical support. 

Phone (toll free in North America): 1.866.772.2660 

Phone: 819.772.2000 

Fax: 819.772.2001 

Email: support@cartovista.com 

  

  

mailto:support@cartovista.com
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About CartoVista 

 

 

  

CartoVista makes it possible to create detailed analyses and optimized 
communications by putting that data on a map. With innovative 

solutions, CartoVista solves business problems and enables 
communication in a wide range of industries. 

The company's head office is located at: 

37 St-Joseph Boulevard, 2nd floor 
Gatineau (Québec) 
J8Y 3V8 

Canada 

For more information on our products and professional services, please 
visit our website: www.cartovista.com.  

  

www.cartovista.com
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Credits 

 

Open Source Geospatial Foundation (OSGEO) 

The CartoVista Publisher has been developed with open source technologies 
provided by the Open Souce Geospatial Foundation. CartoVista is proud to 

contribute to the OSGeo by funding some of the recent MapServer enhancements. 

The Open Source Geospatial Foundation or OSGeo is a not-for-profit organization 
whose mission is to support and promote the collaborative development of open 
geospatial technologies and data. The foundation provides financial, organizational 

and legal support to the broader open source geospatial community. It also serves 
as an independent legal entity to which community members can contribute code, 

funding and other resources, secure in the knowledge that their contributions will 
be maintained for public benefit. OSGeo also serves as an outreach and advocacy 
organization for the open source geospatial community, and provides a common 

forum and shared infrastructure for improving cross-project collaboration. 

 

OSGEO License 

Copyright (c) 1996-2008 Regents of the University of Minnesota. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this 
software and associated documentation files (the ”r;Software”), to deal in the 

Software without restriction, including without limitation the rights to use, copy, 
modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, 
and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions: 

THE SOFTWARE IS PROVIDED ”r;AS IS”, WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 

MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS 

BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 

SOFTWARE. 

Credits 

http://mapserver.org/
http://www.osgeo.org/
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Major funding for development of MapServer has been provided by NASA through 
cooperative agreements with the University of Minnesota, Department of Forest 

Resources. Additional enhancements have been made by the State of Minnesota, 
Department of Natural Resources and the Land Management Information Center. 

 MapServer and MapScript have been developed by Stephen Lime. 

 Raster access module has been developed by Pete Olson and Stephen Lime. 
 PHP/MapScript module was developed by DM Solutions and is maintained by 

MapGears. 
 Portions copyright (c) 1998 State of Minnesota, Land Management 

Information Center. 

  

http://www.dmsolutions.ca/
http://mapgears.com/
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Introduction 

 

This chapter will introduce you to the CartoVista Publisher. 

Overview 

 Key Features 
 CartoVista Architecture 
 User Interface 

 Dockable Windows 
 Drag & Drop 

Getting started 

 System Requirements 
 Supported GIS Formats 

 Supported Data Formats 
 License Management and Activation 
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CartoVista Publisher 3 versus CartoVista 

Publisher 4 
 

The CartoVista Publisher is a Microsoft Windows desktop application that allows a 
user to create, maintain and deploy all the maps & data used with a CartoVista 
deployment. 

CartoVista Publisher 4 is the next version in the evolution of the support of 

CartoVista. The publisher has been expanded to support the new features that are 
now available in CartoVista 4. Additionally, some user work flows and dialog layouts 
have been modified, as new features are added and old workflows are improved. 

With the large number of new features in CartoVista 4, along with an improved 
architecture and new types of map layers, CartoVista Publisher 4 has been designed 
to support only CartoVista 3. If you need to continue supporting CartoVista 3 

deployments, you must continue to use the CartoVista Publisher 3. 

All the existing files, whether they be data files, map files, saved maps etc., will 
seamlessly migrate to CartoVista Publisher 4. The publisher can also be installed 

along side of the CartoVista Publisher 3. (Please use a different directory!) However 
once migrated, the files cannot be safely used with the CartoVista Publisher 3. 
Please ensure that you have backups of any files you will migrate in case you need 

to use them at some future time with CartoVista Publisher 3. 
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Overview 

 

CartoVista Publisher is a Microsoft Windows desktop application designed to support 
the deployment of a CartoVista Solution. It provides a single application with a 
consistent style, interface and tools to allow a user to create and maintain all the 

maps and data used with a CartoVista deployment. 

This chapter will introduce you to some of the basic concepts and benefits of the 
CartoVista Publisher: 

 Key Features 

 CartoVista Architecture 
 User Interface 

 Dockable Windows 
 Drag & Drop 
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Key Features 

 

The CartoVista Publisher simplifies the management and creation of map and data 
files for your CartoVista projects.  The publisher has a number of manager dialogs 
that centralize the tasks associated with map files, data files and styles. 

Map Source Manager 

 

The Map Source Manager is used to manage a library of GIS data files for use in all 

your projects. This manager provides a single source for all your GIS data, no 
matter where they are located on your computer’s hard drive or network. 

By centralizing the management of your map files and their style settings, you can 

rapidly create maps without having to re-find map files every time, or re-apply style 
settings. The map source manager also allows one source file to be present in 

multiple times. Each time it appears (with a different name) it can have a different 
set of default styles. This reduces data storage, as one source map file, for example 
a street network file can be referenced with multiple display styles for different 

zoom levels. 

The Map Source Manager is organized into three sections to help you organize your 
map files. The top section contains local / flat file map files. These are GIS source 

files such as ESRI’s .SHP files, or MapInfo’s .TAB files. The second section contains 



Introduction 

11 

any spatial databases you may have connected to. These are database systems 
such as Oracle, MSSQL or PostgreSQL that support spatial data storage. Finally, the 

third section contains tile sources you may have connected to. These include tile 
providers such as Open Street Map and Bing Maps to name just two, but may also 

include custom tile sets that you have created yourself using the Publisher’s Tile 
module. 

Data Source Manager 

 

The Data Source Manager is used to manage a library of indicator data files for use 

in all your projects. This manager provides a single source for all your indicator 
data, no matter where they are located on your computer’s hard drive or network. 

The Data Source Manager is organized into two sections to help you organize your 

data files. The top section contains local data files. These are files such .CSV, 
Microsoft Excel, or even ESRI’s .SHP files and MapInfo’s .TAB files. The second 

section contains any databases you may have connected to. These are database 
systems such as Oracle, MSSQL or PostgreSQL. 

Style Manager 
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The Style Manager is used to manage predefined style settings that can be applied 
to map files. By managing the styles centrally, a consistent set of visual styles can 

be used with all maps produced by the CartoVista Publisher. 

A CartoVista style encompasses two distinct elements of how to display a 
geographic object from a map file. First, a style defines the general appearance of 

the geographic object.  Second, a style defines the font name, size, color and effect 
of the label that can appear with the geographic object. Each type of geographic 
object (Point, Label, Polyline and Polygon) has specific style settings that apply to 

it. If a map file does not have any styles associated with it, a default global style is 
applied. 

Map Windows 

A Map Window is used to design a map for publishing. The user can add or remove 
layers comprised of map files and set various properties until the desired map is 

achieved. 
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A Map Window also allows you to specify the map's thematic layers and their 

unique identifiers as well as setting the various properties for each layer. 

Theme Configuration Window 

A Theme Configuration window allows you to setup the default theme sets that are 

associated with a Map Window. After first publishing both the Map and the Data, 
the Theme Configuration Window uses the CartoVista Viewer to let the user save 
the theme sets directly from setting them up in the CartoVista Viewer. 
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Tile Windows 

A Tile Window is used to design a map for creating tiles. The user can add or 

remove layers comprised of map files and set various properties until the desired 
map is achieved. Once the desired map is complete, tiles will be created from the 
map at the zoom levels and area defined. 

These windows are only available when the Tile Module has been purchased with 

CartoVista Publisher. 
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Data Publisher Window 
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A Data Publisher is used to generate the XML data files that support the thematic 
layers of a CartoVista map. It works with data you have in various formats such as 

Microsoft Excel or delimited ASCII. 

You can include up to 20 different indicators in a single indicator table XML file. 
Multiple indicator table files can be associated with a CartoVista map, giving full 
flexibility to deploy all the data, in an organized and categorized fashion. 

Data Browsers Windows 

A Data Browser is used to look at the attribute data associated with a Map File or 
Data File. 
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CartoVista Architecture 

 

The CartoVista Publisher is a Microsoft Windows (XP, Vista, Windows 7 & 8) desktop 
application that is designed to support all aspects of publishing a CartoVista 
solution. Each module of the publisher integrates into the application, providing one 
seamless program to create, manage and deploy a complete CartoVista mapping 

solution. 

CartoVista has a flexible architecture that makes data publishing and management 
very simple. Individual parts of the solution can be updated through the use of the 

CartoVista Publisher without affecting the other parts of the solution. 

 

CartoVista Publisher (Desktop Application) 



Introduction 

19 

The CartoVista Publisher is the supporting application for managing and creating all 
the map and data files for a CartoVista solution. It uses a variety of GIS data files 

and data variable files to create the CartoVista maps and indicator data files 
needed. 

CartoVista Maps (Flash) 

CartoVista maps are optimized vector graphics in highly compressed Flash files. All 
map layers are integrated in a single document, with the ability to organize maps 
into hierarchies of hyperlinked Flash files. 

Indicator Data (XML) 

CartoVista indicator tables use XML to store the data. Data that can be grouped 
together is stored in a single XML file as a simple tabular format of rows and 

columns. Multiple indicator tables can be linked to a CartoVista map to provide 
extreme flexibility in data display. 

CartoVista Flash Viewer (Flash) 

The CartoVista Flash Viewer is the Flash executable for the map engine. To 

implement a CartoVista solution, all that is required is to load an HTML file or 
activate a Flash Viewer. Once the CartoVista Flash Viewer starts, it loads the 

configured CartoVista maps and indicator data. 

The CartoVista Flash Viewer can be deployed on the web (Intranet / Internet) or 
even locally on a CDROM, USB stick or another media. 

CartoVista Server 

The CartoVista server is an optional Microsoft Windows Server component that 
enables the support of server layers in CartoVista applications. Server-based layers 
offer a maximum of flexibility in terms of GIS map content and deployment because 

they have no limitations in terms of the number of objects. The CartoVista server 
component includes support for common raster and GIS data formats such as 

GeoTIFF, ESRI Shapes and MapInfo tables for example. Server layers can be setup 
with advanced cartographic styles and can be rendered in vector or raster format in 
the CartoVista engine. For more information on the CartoVista server component, 

please refer to the CartoVista server documentation. 

CartoVista SDK 

The CartoVista Software Development Kit is an Application Programming Interface 

(API) consisting of a set of functions that allow developers to extend and customize 
the CartoVista solution. The SDK can be used in Adobe Flex and Javascript (HTML) 
to change the user interface or add additional functionality. For example, a 

developer may choose to embed CartoVista in a Flex application with surrounding 
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information windows and graphics that react to the map selection. They could also 
create a drop down menu that allow accessing predefined thematic maps. 

The CartoVista SDK also includes a mobile component that allows developing multi-

format CartoVista applications (Apple, Android and Blackberry) on smartphones and 
tablets. 
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User Interface 

 

 

The CartoVista Publisher is a powerful application with many different operations 
that are closely linked together. Throughout the program, there is a variety of 

windows and dialogs that allow the user to create the required output files, whether 
they are a CartoVista map or a set of data for use with a map. 

All of the windows that are used with CartoVista Publisher reside within the main 

application. This is termed a Multiple Document Interface application. Multiple 
windows can be open, switched between and arranged for easy viewing 
simultaneously. Each window will have its own controls, and may activate menu 

items in the main program menu bar. 
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Dockable Windows 

 

 

Much of CartoVista Publisher’s power comes from its ability to manage a variety of 

data. From GIS files, to style settings to coordinate system properties, these 
managers provide you the tools to create your customized maps and data. 

All Manager dialogs are "dockable". This means that they can be connected to the 

sides of the CartoVista Publisher application. This allows them to remain visible and 
attainable at all times. 

It is also possible to "unpin" the dialogs, which allows them to disappear into the 

side of the application leaving just their name on the side of the main application 
window. When you hover your mouse over the dialog’s name however, the dialog 
reappears. 

Manager dialogs can also be organized beside or on top of one another, or even 

behind each other in a tab-like style. These arrangements give you the flexibility to 
create exactly the layout you prefer with the dialogs, so that they are available 
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when you need them. The placement and arrangement of these dialogs is stored 
when you exit the application so that the next time you run CartoVista Publisher, 

the dialogs will be in the same location. 
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Drag & Drop 

 

Drag & Drop is a common tool in Microsoft Windows applications. It allows you to 
click on an application piece, and by dragging it over to another application piece, 
affect a change or event to occur. 

In the CartoVista Publisher, many of the application pieces that are maintained by 

the Manager dialogs are enabled with Drag & Drop. Styles can be moved onto map 
files or map layers, quickly updating the appropriate style. Map files can be dragged 
onto the map window to instantly add the layer to the map window. Layers and 

styles from a Map Window can be dragged to other Map Windows or back to the 
Map Source Manager. 

Special notes throughout the documentation will indicate what items are draggable, 

and what items they can be dragged onto. 
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What's New with the Publisher CartoVista 

 

This chapter introduces you to the new functionality of the CartoVista Publisher 3.0, 
3.1, 3.5, 3.7, 3.8, 4.0 and 4.1 

CartoVista 4.1 - Publisher 

 New Theme Set Categories 
 Check for Updates  
 New Graduated Polygon Patterns 

 New HTML Output Packaging  
 New Metadata Field  

 New CloudVista Tile Providers Capability 
 Handling of out of Range Values 
 Increased Stroke Width Capability  

 New Confirmation Dialogs 
 Select and Unselect all Attributes  

 Print Configuration New Image Management System 
 The Option to Add a Next View and a Previous View Tool to the CartoVista 

Viewer  

 Improved Interaction with Windows  
 New Publisher to Viewer Warning Icon 

CartoVista 4.0 - Publisher 

 Enhancement of thematic analysis configurations 
 Print Configuration Dialog 

 Server Layer Management - Creating a server map 
 Server Layer - Enhanced tools for using server maps 
 Tile Generator - Performance enhancements 

 New Tile Providers 
 User Interface Enhancements 

 New user interface styles 
 Labeling option - Character Spread 
 Vertical Mapper Grid Support 

 Enhancements to the tile providers 
 Other enhancements and new features 

CartoVista 3.8 

 Blend Modes used inside the Publisher 
 Layer Effects (Inner Glow, Outer Glow and Drop Shadow) 



CartoVista Publisher Documentation 

26 

 Multiple Tile Providers in One Layer 
 Interactivity Feature Attributes & Data Display User Interface Update 

 User Specified Tile Providers 
 Other New Features / Enhancements 

CartoVista 3.7 

 Tile Publisher 
 Point Style Enhancements 

 Expanded Database Connectivity 
 Style & Manager Dialogs Redesigned 
 Viewer License Support 

CartoVista 3.5 

 Data Publisher Enhancements 
 Map File Filters 

 Setting Viewer Themes 

CartoVista 3.1 

 Multiple Map Windows 

 Data Publisher Enhancements 

CartoVista 3.0 

 Raster Tile Layers 

 Map Layer Interactivity 
 Map Viewer Configuration Dialog 
 Data Publisher Enhancements 
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Version 4.1 

 

What's new in the CartoVista Publisher 4.1 ? 

 

  

New Theme Set Categories 

The creation of Theme Set Categories is now possible. 

This new feature adds the capability to publish an unlimited number of themes and 
to present them in an organized and intuitive manner to your end user. 

A new category can be added by;  

1. Right clicking on an existing  category and selecting the “Add Category...” 
button  

2. Using the “New Category” button provided in the menu bar. 
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Check for Updates 

You can now check for and download available updates directly from within the 

CartoVista Publisher using the new “Check for Updates...” dialog available through 
the Help menu.  

This new patch system will, simplify the process of getting the latest version of the 

Publisher, provide information on the status of your current version, and inform you 
on the content of an available new version prior to downloading.  

 

  

New Graduated Polygon Patterns 

5 new graduated polygon patterns sets have been added to fill  polygons: Dots, Double 
Diagonal Hatch, Hatch 135 degree, Hatch 45 degree, Spaced Hatch 45 degree. 
Each new pattern set contains 5 graduated variations. 

These new graduated polygon patterns have been integrated within the Thematic 
Analysis creation process.  

When a new Thematic Analysis is added, to a polygon layer, Graduated polygon 
patterns can be applied to individual  values or range values depending on the indicator 
type selected. This increases the capabilities to view multiple indicators together in the 
same map within the CartoVista Viewer.  
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Furthermore, these new graduated polygon patterns have been added to the polygon fill 
palette, providing additional  mapping design options to  increase Polygon  data display 
possibilities.   

  

 

 New HTML Output Packaging 

In the Map Window, the Open HTML button now has an option to package your 
HTML output to a zip file (Create Zip). 

The new HTML Output packaging will simplify moving your publication from your 
working environment to your dedicated server. 

Furthermore, an option to open the map folder where the associated published 
.html files resides and an option to open the published map’s configuration file have 
been added to the OpenHTML button. 
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New Metadata Field 

It is now possible to add Metadata to individual layers in the Map File Property 
dialog at the Map Source level or in the Layer Properties Dialog from the Layer 

Properties dialog at the Publishing window level.  

A link to a web page, text content or other information that is required to pass 
along to CartoVista Viewer users regarding layer data sources can now be easily 

included in your publication. 
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Metadata text added to a Map File or a Map Layer can be displayed in the 
CartoVista Viewer. To achieve this, a Layer Metadata check box was added in the 
CartoVista Viewer Configuration > Map Interface Tab: Map Notices area. 
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New CloudVista Tile Providers Capability 

Cloud hosted CloudVista map tiles can now be included in your publication via the 
Tile Server Connection dialog. 

This new capability of CartoVista leverages the benefits of Cloud Storage. 
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Handling of out of Range Values 

The ability to show out of range values in the CartoVista Viewer Legend has been 

added following user demand. Out of range values apply to theme sets with 
thematic analyses by range. If this feature is set and there are values in the data 

outside of the default ranges a new item called "out of ranges" with the feature 
count will be displayed in the CartoVista Viewer’s legend box. 

To set this new feature a “Show out of Range Values” checkbox was added to the 

"Viewer Configuration > General Interface Tab". 

Furthermore, to improve usability, the “Show NA Value” and “Show Out of Range 
Values” options have been regrouped into the Legend Setting group. 
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Increased Stroke Width Capability 

Stroke width properties can be set from 1 to 25 pixels. Previously, maximum stroke 

width was limited to 10 pixels. 

This user requirement enhances the already powerful Cartographic design tools 
included in the CartoVista Publisher. 

New Confirmation Dialogs 

A confirmation dialog box is now launched when you remove a Layer from the Layer 
Control, a Map File from the Map Source Manager or a Data File from the Data File 
Manager. A "Do not ask me again" option is available within the dialogue to turn off 

the use of the launched dialog. These new confirmation dialogs can be managed 
using the Tool > Preference > General Options Tab. 3 check boxes have been 

added so you can turn on/off the warning dialogs. 

This new feature was based on user requirement to prevent aversely removing 
linked files. 
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Introduction 

37 

 

  

Select and Unselect all Attributes 

A Check/Uncheck ALL checkbox was added to the Attribute grids. You can now 
select or unselect all columns (that are not setup for use) within the Layer 

Properties > Interactivity & Thematic > Feature Attribute and Data Display Tab. 

This new check box enhances the efficiency of selecting and de-selecting attributes. 
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Print Configuration New Image Management System 

An image management system has been added to the Print Configuration window. 

You can add numerous images links in the image management system (e.g. Logos, 
photos). Stored image links can easily be retrieved and the associated image 

inserted as a Content Item in a Print Layout. 

This new feature increases the efficiency of preparing predefining print templates 
within the CartoVista Publisher before publishing to the CartoVista Viewer. 
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New Option to Add a Next View and a Previous View Tool to the 

CartoVista Viewer 

You can now add Next and Previous View tools in the CartoVista Viewer 

Configuration > Map Toolbar Tab. 

This new feature allows more design flexibility. Next and Previous View tools 
ultimately increase map navigation efficiency in the CartoVista Viewer. 
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Improved Interaction with Windows 

New Map Files that are dragged from your Windows Explorer and dropped into the 
CartoVista Publisher  Map Source Manager folder will automatically be added to that 

folder. 

You can now use the delete key to remove selected Map Files or Map File folders 
(within the current (parent) level) from the Map Source Manager. 

You can also use the delete key to remove selected Map Layers from the Layer 

Control. 

These new features enhance the interaction with the desktop. 

New Publisher to Viewer Warning Icon 
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Warning Icons are now shown where the use of a feature in the CartoVista 

Publisher does not perform the same way as in the published version in the 
CartoVista viewer. You can rollover the icon to obtain information related to the 

warning. 

  

Numerous other minor improvements were done by the CartoVista Development 
Team to improve your CartoVista Publisher experience. 
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Version 4.0 

 

What's new in CartoVista 4.0 ? 

 

What's new in the CartoVista 4.0 Publisher? 

Enhancement of thematic analysis configurations 

The CartoVista 4.0 Publisher includes new possibilities to manage the thematic 

analysis configurations by specifying custom content for the legend. This menu is 
accessible from the Themes Configuration Dialog, after creating themsets. 

 

 

For themes by unique values, it is also possible to reorder items using drag and 
drop. 
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Server Layer Management - Creating a server map 

 

CartoVista 4.0 allows data administrators to easily create and update their server 
maps. The map files used in a server map can easily be sent to the server a user 
friendly wizard. When you are updating a server map GIS data, the publisher only 

transfers the files that have changed. 

Print Configuration Dialog 

A new Print Configuration dialog is now available in the map window. It allows 

preparing print layout templates. Those templates are then available in the 
CartoVista application, as described in the New print layout management tools 
section. 

The purpose of this dialog is to let the administrator define the content of the 
templates, and the level of flexibility available to the user to modify them: paper 
size, inserting additional content, removing some of the template items, or moving 

them around, etc. The administrator can also decide to lock everything. In this 
case, the only option available to the user in the CartoVista application is to use one 

of the available templates. 

Alternatively, the administrator can decide to let the CartoVista application user 
creates its own template directly in the CartoVista Viewer. 

Server Layer - Enhanced tools for using server maps 

To use a server map in a CartoVista map, all that is required is to drag and drop the 

layer in the desired map. 
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Server map samples 

The integration of server layers in the publisher greatly simplifies the process of 

publishing different types of interactive map, no matter what the data size is. 

 
 

Display of more than 75,000 points 
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Display of more than 75,000 points - 

Heatmap View 

  

  

Display using Graduated Symbols 

(Dissemination Areas) 

  

Display of Demographics (Dissemination 

Areas) 
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Target Areas Classification and Graduated 
Symbols 

  

Business Potential Classification 

Tile Generator - Performance enhancements 
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The performance of the tile generation module has been enhanced significantly. In 
particular, working with map layers that include advanced graphic effects (inner 

glow, outer glow, blend mode, drop shadow, etc.) has been fully optimized. 

New Tile Providers 

New tiles providers are available in CartoVista to offer new cartographic base map 
options for your projects. 

 CloudVista Tiles 

 OpenStreetMap German Style 
 OpenStreetMap Black and White 

 Thunderforest OpenCycleMap 
 Thunderforest Transport 
 Thunderforest Landscape 

 MapQuest OSM 
 Esri DeLorme WorldMap 

 Esri OceanBasemap 
 Esri National Geographic WorldMap 

User Interface Enhancements 
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The Viewer Configuration dialog has been updated with a new presentation to 
integrate all of the new options . The Attribute tab in layer properties for attributes, 

info tool, data tip and search have been updated so that they are easier to work 
with when setting up the interactivity options of your layers. 

New user interface styles 

A new option in the publisher allows to select the interface style to use for the 
graphic user interface of the viewer. 

White 

 

Black 
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Earth 

 

Blue 

 

Labeling option - Character Spread 

This new option available as an advanced labeling property allows great 

cartographic rendering of linear features. When activated, the associated label text 
 is spread along the path of the line feature. 

This option is available only for tile layers and server maps. 
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Sample Labeling with Character 

Spread Disabled 

Sample Labeling with Character 

Spread - Enabled 

Vertical Mapper Grid Support 

Vertical Mapper numeric and classified grids can now be used as raster layers in 

CartoVista. 

Enhancements to the tile providers 

The tile providers tab in layer properties allows configuring some of the options for 

tile layers such as the list of providers and the order they appear for the tile base 
map. 

The tile provider for IGN (Institut Géographique National –Géoportail  in France) 
properties have been enhanced with several new options. 

A new generic World Mercator Tile provider has been added to connect to new tile 

providers. 

Other enhancements and new features 

 Duplicate layer: A new function is available in the layer menu (right click) to 

duplicate a layer. Right click & copy property values in Map file properties 
dialog 

 Redraw window: Users can now use the Control-D  keys to redraw their map 

window 
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Version 3.8 

 

Blend Modes used inside the Publisher 

 

Blend modes were always available for creating effects between two layers in the 
CartoVista Viewer. Now it is possible to see the effects inside of the Publisher as 
well. 

One example of when blend modes can be useful is in a tile map window. It allows 

to create advanced map layer compositing with a shaded relief (e.g. using the 
multiply blend mode). 

 

Sample Multiply Blend Mode on Shaded Relief Layer 

Additional information about the blend mode is available in the Layer section of the 
Layer Properties. 
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Layer Effects (Inner Glow, Outer Glow and 

Drop Shadow) 
 

 

    

No Effect Drop Shadow Outer Glow Inner Glow 

New graphic effects have been added to enhance the cartographic rendering of 
Polygon and Polyline layers. 

Inner Glow, Outer Glow and Drop Shadow effects can be used to create original 
layer outputs with precise control on the glow and shadow rendering. 

NOTE: These options are only available for tile map windows. Version 4.0 will 
support layer effects in normal map windows. 

 

Each effect option includes several parameters to control its appearance on the 

layer such as: 

 Color 
 Opacity 
 Size 

 Strength 
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Sample filters: Inner glow on hydrography and parks, drop shadow on buildings 

Additional information about the layer effects is available in the Tile Window Layer 
Glow Effects section. 
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Multiple Tile Providers in One Layer 

 

 

Having a Tile Provider as a base layer sometimes requires the ability to toggle 

between several different tile providers. An example would be to allow the user to 
switch between an aerial view to a road based view. 

It is now possible to have only one Tile Provider layer in your map, but still give the 
user a choice of multiple tile providers to display. This simplifies the layer control 

for the end user, and reduces the number of layers that are required to give the 
user options for Tile Providers. 

Additional information about the tile providers is available in the Adding Tile Layers 

to a Map section. 
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Interactivity Feature Attributes & Data 

Display User Interface Update 
 

 

The user interface to select Feature Attributes and assign Data Display options, 
such as Data Tips, Info Results, Selection columns and Searchable columns has 

been updated to make the interface easier to use. 

Additional information about the Attributes and Data Display is available in the 
Interactivity and Thematics Tab section of the Layer Properties. 



CartoVista Publisher Documentation 

58 

  

 

User Specified Tile Providers 

 

The number of tile providers that can be added by a user has been greatly 
enhanced with version 3.8. 

There are now four types of common tile providers that can be added by the user: 

 CartoVista Tile Provider from CartoVista 
 ESRI ArcGIS World Mercator 

 IGN Geoportal 3 
 Tile Cache 

  

CartoVista – North America Tiles – 
Lambert Conformal Conic 

ESRI – ArcGIS Online – Ocean Basemap 
Tiles – Mercator 
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IGN GeoPortail Version 3 Tiles – France - 
Mercator 

Tile Cache Tiles – Mercator – Vmap Level 
0 

Additional information about the new tile providers is available in the Adding a Tile 
Provider section of the Managing Your Map Files chapter. 
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Other New Features / Enhancements 

 

Packaging Maps 

The concept of map packaging is new in CartoVista 3.8 to help manage and 

facilitate data transfers. 

Packaging maps allows you to collect all the source data files, fonts, images, etc. 
that are needed for a Map Window into a single .ZIP file. This allows you to transfer 

the map between different users or computers, and ensure all the relevant data has 
been included. 

Additional information is available in the Packaging Maps section. 

Point Symbol Style Rotation from Column 

Point Symbols can now be rotated based on the values found in a specific column of 

the data set. 

Additional information is available in the Symbol Rotation Column (Point) section. 

Folders in Local Map Source Manager 

In order to assist in organizing Map Files within the Map Source Manager, you can 

now create folders for Map Files within the Local section of the Map Source 
Manager. This will allow you to easily group your map files, as well as create new 
maps from all the files within a folder quickly. 

Additional information is available in the Local Map Files Folders section. 
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Version 3.7 

 

Tile Publisher 

 

 

The new Tile Publishing Module allows you to create your own tiled base map, using 
your GIS data. 

A new type of map window, the Tile Map, has been added to the CartoVista 

Publisher to build the cartographic content for tile base maps. Additional 
parameters and extended object and labelling styles are available to create very 
high quality and customized outputs. 

Tile Base Maps can be created to match the World Mercator Projection (EPSG:3857) 

compatible with Google Maps, Microsoft Bing Maps, Yahoo Maps, Open Street Map 
and others. Tile Base Maps can also be created in any other coordinate system to 

match your specific needs. 

The tile creation process is fast, allowing generating about 30 tiles (images) per 
second on a normal workstation. Detailed zoom level control allows you to create 
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only the desired zoom levels necessary. Tiles images will be created locally or on a 
network location in a structure that is optimized for data access. 

Once the tile base map is created, it can easily be added to the list of available tile 

providers to quickly integrate into a CartoVista map output. 

For more information on this module, see Creating & Publishing Tiled Base Maps. 

NOTE: The Tile Publisher Module is an Add-In to the standard CartoVista Publisher. 
It requires the purchase of an additional license in addition to the license for the 

Publisher. 



Introduction 

63 

  

 

Point Style Enhancements 

 

The cartographic capabilities to render points has been greatly enhanced with 
version 3.7. 

There are now two possible ways to style points. It is now possible to style a point 
by using bitmap images, as well as using a TrueType font. 

The new Image Point Style offer the capabilities to construct your own symbols 

from existing images in GIF or PNG format. Since these images support 
transparency, you have the flexibility to setup custom styles with great looking 
effects very easily. 

Image Point Style allows you to specific up to three different bitmaps, one for the 

fill, one for the outline, and finally one for the rollover effect (e.g. changing color). 

For more information on how you can define point styles, see Point Layer Styles. 
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Expanded Database Connectivity 

 

Geospatial Relational Database Management System (RDBMS) 
Support 

The CartoVista Publisher 3.7 includes full support for some of most common 

relational database management systems on the market. 

Map layers can be easily created from corporate GIS databases and published in a 
CartoVista SWF map. 

The following Geospatial databases are now supported in this release: 

 Oracle Spatial 10g or later 

 PostgreSQL (PostGIS) Version 8 or later. 
 Microsoft SQL Server 2008 - Spatial 

It is also possible to connect Data Files directly to Oracle and PostgreSQL databases 

(in addition to the already existing Microsoft SQL Server). 
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Style & Manager Dialogs Redesigned 

 

The Style Editor dialogs have been streamlined to provide a simpler, cleaner 
interface to choose from the numerous style options that CartoVista offers for 
points, lines and polygon features. 

The Map File Manager and Data File Manager have now become the Map Source 

Manager and Data Source Manager with the addition of a separate panel to display 
Map/Data files that are connected to databases. The Map Source Manager also 
separates the Tile Providers into a third panel, making it easier to find exactly the 

Map/Data file that you’re looking for. 

For more information, see The Map Source Manager and the Data Source Manager. 
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Viewer License Support 

 

Starting with CartoVista 3.7, as part of a CartoVista deployment, the Viewer 
Component requires all CartoVista Maps to contain a license key. 

Support to enter your license key has been added into the Publish Options Dialog 
(see Publishing a Map). 

NOTE: Without the key, a “Demo/Evaluation” watermark will be displayed by the 

Viewer. 

For information on how to get a license key, contact CartoVista support/sales by 
email at: support@cartovista.com 

mailto:support@dbxgeomatics.com
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Version 3.5 

 

Data Publisher Enhancements 

 

CartoVista Publisher 3.5 has the following enhancements to the Data Publisher: 

 In order to publish your data, the indicator’s source data file no longer needs 
to be in the Data File Manager after the indicator is created. This makes it 
much easier to transfer maps to another CVP user. 

 You can now “locate” an Indicator’s data file if the source data file has been 

moved or is missing. 

 The maximum number of indicators can now be set as a global preference to 
values from 1 to 1000. 

 Keyboard shortcuts for deleting, copying and pasting have been enabled 
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Map File Filters 

 

Map File filters allow you to select a subset of the features in a Map File for display 
and publishing. This lets you have one source GIS data file and open it several 
times in the Map File Manager with different filters to expose only specific subsets 
of the source data file. 

Filtering is done by evaluating an expression on one (or more) attribute columns of 
the Map File. There are currently three methods of filtering available: 

1. Simple – a single attribute column is compared to a specific value 

2. RegEx – a single attribute column is compared to a Regular Expression 

3. Expression – One or more attribute columns are compared to values and if 

necessary combined using AND, OR and NOT operators. 

For more information on Filtering see the chapter on Filtering Map File Data. 
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Setting Viewer Themes 

 

To assist in configuring the published CartoVista map, the Preview button in the 
Map Window has been renamed “Themes Configuration”. A Theme is the particular 
combination of any Thematic Analysis displayed, along with the specific settings for 
how to display it, such as the number of ranges, colors etc. 

The Themes Configuration Window allows you to interact with your published Map, 
and setup one or more themes for the Map. One of these themes will be set as the 
default theme to load on startup. 

For more information on these and other enhancements to the Themes 

Configuration Window, see the Chapter on Themes Configuration. 
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Version 3.1 

 

Multiple Map Windows 

 

The CartoVista Publisher now supports having multiple Map Windows open at the 
same time. You can open additional map windows in any of the normal ways you 
can open a Map Window. 

NOTE: Do not open the same CVM file multiple times, or you may end up 

overwriting changes from one window with another window. 
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Data Publisher Enhancements 

 

CartoVista Publisher 3.1 has the following changes to the data publisher: 

 Unique IDs are now only unique within a Thematic Layer 

 An indicator has an “ignore null value” property (True/False) that causes it to 

skip 

 An alert dialog will be displayed if an Indicator cannot be located in your Data 
File Manager. This allows you to locate any missing Data Files needed to 

publish all the data. 

 The Data View  that’s linked to a Map Window is now automatically saved 
with the .CVM of the map window. This means you don’t have to give 
someone both a .CVM and .CVD when you want to pass your map to another 

person. 

 You can still save a Data View that’s linked with a Map Window to a .CVD so 
you can re-use it in other maps. 
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Version 3.0 

 

Raster Tile Layers 

 

 

CartoVista 3 introduces a new type of map layer: the Raster Tile Layer. Raster tile 
layers provide a way to break up a large raster image into smaller pieces, and send 

only the pieces needed to display the current view.  Many popular online mapping 
engines, such as Google and Bing deliver the maps to the browser as a series of 
tiles. 

By enabling the use of raster tiles, CartoVista 3 allows a multitude of layers to be 
packaged as raster images. By varying the content of the tiles at different scales, 
appropriate levels of detail can be displayed depending on the scale. 

While the potential interactivity of a vector layer is lost when it becomes part of a 

raster layer, the benefit of being able to display much more information as a 
background raster is enormous. Raster tile layers open up the ability to have highly 

detailed map backgrounds, while still retaining the extremely interactive vector 
layers that contain your data for thematic mapping. 
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For more information on how the CartoVista Publisher 3.0 incorporates Raster Tile 
Layers, see Chapter on Raster Tile Layers in Mapping Concepts. 
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Map Layer Interactivity 

 

CartoVista’s great strength is the interaction that is available between the end user 
and the map. CartoVista 3 adds new flexibility to this interaction, and the 
CartoVista Publisher 3.0 has expanded the Layer Properties to allow these 
interactions to be extensively customized. 

The Layer Properties dialog has been changed to a more traditional Tab layout, to 
provide more room for the all-new Interactivity & Thematics tab. This tab allows 
you to work with the new features for interactive layers that include: 

 Unique Identifier is always on for interactive layers. If you don’t have a 

unique ID column available, CartoVista Publisher 3.0 can auto-generate a 
unique id for each row. 

 Attributes from the Map File can now be included in the map. Each attribute 

is based on a column in the Map File and will be present for each feature in 
the map. The name of the attribute can be set individually. 

 Attributes in a map can be used to provide data for the new Info Tool, or to 
provide information for the Data Tip which appears on mouse over of an 
interactive feature 

 Multiple columns can be configured as search columns, giving end users 
more options in finding locations within the map 

For more information on these and other enhancements to the Map Layer 
Interactivity Tab, see Chapter on Interactivity Settings in Layer Properties. 
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Map Viewer Configuration Dialog 

 

With all the new options for interactivity in CartoVista 3, the CartoVista Publisher 
3.0 has completely redone the dialog that lets you set up the CartoVista 3 
environment.  More options to adjust the look and feel of the map are now available 
to be set directly from the publisher. 

For more information on the new properties in the Map Viewer Configuration Dialog, 
see the chapter on the Viewer Configuration Dialog. 
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Data Publisher Enhancements 

 

Publishing data to support CartoVista maps is an important part of the Publisher. 
CartoVista Publisher 3.0 has incorporated a number of changes to the Data 
Publisher to make publishing data easier and more intuitive. These changes include: 

 Multiple Data Publisher dialogs can now be opened at the same time 

 A new wizard has been added to  assist in adding indicators to publish 

 Data Publishers associated with a Map Window are now closely linked, even 
knowing what thematic layers are available 

For more information on these and other enhancements to the Data Publisher, see 

Chapter on Publishing a Map. 
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Getting Started 

 

This section will help you get started with the CartoVista Publisher program. 

 System Requirements 
 Supported GIS Formats 

 Supported Data Formats 
 Installation 
 Licence Management and Activation 

 Updates 
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System Requirements 

 

Operating Systems 

 Microsoft Windows XP 
 Microsoft Windows Vista 

 Microsoft Windows 7 
 Microsoft Windows 8 

Minimum System Requirements 

 70 MB free hard disk space 

Supported GIS formats and GeoSpatial databases 

Vector Data 

 MapInfo Tables (Native) 

 ESRI Shape Files 
 ESRI Personal GeoDatabase (.MDB) 

 Microsoft SQLServer 2008 Spatial 
 Oracle Spatial Version 10g or Later. 
 PostgreSQL/PostGIS Version 8 or later. 

Raster Data 

 Tagged Image File Format (. TIFF, GEOTIFF) 
 Windows Bitmat Format (. BMP) 

 Portable Network Graphics (. PNG) 
 Graphics Interchange Format (.GIF) 
 Joint Photographic Expert Group Format (. JPEG) 

 Joint Photographic Expert Group 2000 Format (.JPEG2000) 
 Enhanced Compression Wavelet (. ECW) 

 MrSID (. SID) 

Supported Data Formats and Databases 

 MapInfo Tables (Native) 
 ESRI Shape Files 

 Microsoft Excel Spreadsheets 
 Comma Separated Values (.CSV) Files 
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 Microsoft Access Database (.MDB) 
 Microsoft SQLServer Version 2008 or later 

 Oracle Version 10g or later 
 PostgreSQL Version 8 or later 
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Installation 

 

Once you downloaded the CartoVista Publisher Installation file, decompress the zip 
file and run the executable. Follow the step by step wizard to install the CartoVista 
Publisher on your computer. 

  

  

  

  

  



Introduction 

81 

  

 

License Management and Activation 

 

License Management 

The CartoVista Publisher includes a License Manager that allows the user to manage 
the software license. 

 

  

The License field displays information about the current license. Some of the 

common values that can be displayed include: 

 Your trial license has XX days left. 
 The trial period has expired. 

 CartoVista Publisher 4.x (indicates that a full license is installed) 
 There is no active license. 

The Computer ID field displays a unique identifier for your computer. Please include 

this in any correspondence about licenses with CartoVista. 
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The Installation ID displays a unique code that identifies your computer and the 
license status. Please include this in any correspondence about licenses with 

CartoVista. 

The Modules field displays the list of licensed modules. Some modules include: 

 Map Publisher 
 Data Publisher 

 Tile Creator 
 CartoVista Server Connection 

Other modules may be listed depending on the configuration purchased by the end 

user. 

Activating a Trial Version 

By default, the CartoVista Publisher installs with a 30-day trial license.  To activate 

a full purchased license, the end user will have to do an Internet Activation. 

YOUR COMPUTER MUST BE CONNECTED TO THE INTERNET FOR THIS TO 
WORK. 

Enter the supplied license code in the License Code text box and click the “Activate” 

button. A dialog containing the end-user license for CartoVista Publisher will be 
shown, and the user will be required to confirm acceptance of the license. The user 
must purchase a license of the CartoVista Publisher before activating the license 

key. 
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Click the “I ACCEPT THE TERMS IN THE LICENSE AGREEMENT” checkbox and then 

click OK. 

The License Manager will attempt to connect to the CartoVista license server and 
activate the license. On a successful activation, the following message will be 

displayed: 

 

The buttons will change to display Internet Deactivation and Manual Deactivation. 

The License field should now display “CartoVista Publisher x.x”. 

If you are unable to activate the license (for example, a firewall prevents 
connection to the CartoVista license server), follow the instructions for a Manual 

Activation. 

Moving a License to Another Computer 
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Once you have activated a license, it is not possible to activate another license for 
CartoVista Publisher on the computer. The “Activate” button will change to a 

“Deactivate” button.   

  

You can use the Deactivation option to remove the license from this computer to 
install it on another computer. 

YOUR COMPUTER MUST BE CONNECTED TO THE INTERNET FOR THIS TO WORK. 

Simply enter your license code and click Deactivate. Then install the CartoVista 
Publisher on the other computer, and activate that license code. Once you have 
deactivated the license, the button changes back to an “Internet Activation” button, 

ready for you to activate a license again. 

Manual License Activation 

Sometimes it is not possible to connect to the CartoVista license server with the 

Internet Activation option. In those circumstances, CartoVista can provide you with 
another code to activate the license without using the internet. 

Contact CartoVista and provide the Computer ID and License ID values. Use the 

copy/paste functions to copy these two values into an email and send it to 
support@cartovista.com. CartoVista will use these values to generate a manual 
activation license. This license will be emailed back to you.  Enter this key in the 

License Code box and click on the Manual Activation button. 

If you need to transfer your license to another computer, you can also do a "Manual 
Deactivation".  This will give you a code that you will need to send to CartoVista at 

support@cartovista.com. This will enable CartoVista to release the license 
installation on your computer and allow you to install it on another computer. 

  

Extending Your 30-Day Trial License 

It is possible to extend your 30-day trial license. This option is only available when 
a trial license has expired. This tab will be disabled when it is not possible to extend 
the trial. 

YOUR COMPUTER MUST BE CONNECTED TO THE INTERNET FOR THIS TO WORK. 

Select the “Extend Trial” tab. Enter your name, email address and phone number 
then click the “Request” button. 

mailto:support@dbxgeomatics.com
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The License Manager will attempt to connect to the CartoVista license server and 
extend your trial license for another 30 days. You may only extend the trial license 

once per computer. 

If you are unable to connect to the CartoVista license server, or there is a problem 
extending the trial, you will be prompted to send an email to CartoVista. If you 

select “Yes”, your default email program will launch, and a pre-populated email will 
be created that includes the Computer ID and Installation ID values, and phone 
number. Send this to support@cartovista.com. 

mailto:support@dbxgeomatics.com
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Updates 

 

You can now check for and download available updates directly from within the 

CartoVista Publisher using the new “Check for Updates...” dialog available through 
the Help menu.  

 

  

This new patch system will simplify the process of getting the latest version of the 

Publisher. It also provides information on the status of your current version, and 
inform you on the content of an available new version prior to downloading.  

Those updates are available as long as your maintenance contracts are active. 
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Mapping Concepts 

 

This chapter is an introduction to basic mapping concepts and how they are 

implemented. An understanding of these concepts will aid in creating visually 
appealing and effective maps for use in CartoVista. 

This chapter will present the following concepts: 

Layers 

 Type of Layers 
 Raster Tile Layers 

Features 

 Type of Features 

 Coordinate Systems and Projections 
 Styles 

 Labelling 
 Zoom Layering 

 Thematic Mapping 
 Attributes 

  



CartoVista Publisher Documentation 

88 

  

 

Maps 

 

A map is a graphical representation of a geographic area. Different types of maps 
can be created with the CartoVista Publisher. 

Base Map 

A base map graphically represents physically visible elements within a geographic 

area. Layers in a base map are used to provide a cartographic context for viewing 
data (e.g. roads, cities, rivers, etc.). For example, a map showing roads, lakes, 
rivers, streams and terrain would be considered a base map. 

Sample Base Map 
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Thematic Map 

A thematic map is a map that displays the spatial distribution of an attribute that 
relates to a single topic, theme, or subject of discourse. Thematic maps use a 
variety of graphic styles (e.g., colors, symbols) to better illustrate the underlying 

indicator data. Thematic maps are very useful to display geographical concepts 
such as density, distribution, relative magnitudes, gradients, spatial relationships 

and movements.  A thematic map graphically represents a relationship between 
observable occurrences found within a geographic area. 

For example, a map showing crime occurrences at specific locations would be 

considered a thematic map. Normally thematic map information is overlaid onto 
base map information to provide a location context for the theme displayed. 

Sample Thematic Map 
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Layers 

 

Definition 

A layer is a logical group of one or many map features (text, points, polylines, 
polygons or images). For example a layer can contain polygons depicting the 

vegetation within a geographic area. A layer can only contain one type of 
geographic feature. 

The specific combination of layers makes up a map. Features in a layer will 

generally obscure features in the layers below. In order to provide the most 
visibility to features, image layers are usually placed at the bottom of the layer 

stack. Image layers are usually followed by polygon, polyline and point layers. Text 
layers are usually at the top of the layer pile. Applying transparency to layers can 
assist in making obscured features visible. 

 

 

Types of Layers 

A layer can be classified according to the type of feature it contains. Various 
settings applied to layers sometime depend on the layer type. As an example, 

setting unique identifiers for interactivity would normally be only applicable to 
vector layers. 

Vector Layers 

A layer consisting of text, points, polylines or polygons is called vector layer. 
Features in vector layers are defined by a series of geographic coordinates. As 
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vector layers are expressed mathematically  in real world units, they are 
independent of the screen resolution. 

Raster Layers 

A layer consisting of an image is called a raster layer. Raster layers are made of 
pixels and have a fixed resolution. 

 

Raster Image Layer: Digital 

Elevation Data 

  

Type of Raster Layers 

There are three ways that the raster images are generally made available. 

Files 

Raster layers are most commonly based on a single raster image that is stored as a 

file. The raster layer may have an accompanying “world file” that details the 
geographic location, scale and rotation of the image. 

Web Map Service (WMS) Layer 

A Web Map Server (WMS) is an online server, referenced by an URL, that provides 

georeferenced raster map images over the internet. These map images are 
generated on request by the map server using data from a GIS database. 

The raster image generated can be blended together from multiple map layers (of 
any type of feature) to create a single raster image. The specific layers used to 
generate the image, along with the location and scale are determined when the 

request is made to the map server and are based on what data is available to the 
map server. The map server generates the map image requested and returns it 

over the internet. A WMS layer may be able to query the map server for attribute 
data. 
The specification for WMS was developed and first published by the Open 

Geospatial Consortium in 1999. For more information on Web Map Server, see the 
OGC WMS 1.1.1 specification documentation. 
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Tile Server 

A tile server is an online server, referenced by an URL, that contains a raster image 

that covers a place on the earth. The raster image is broken down into small 
regularly sized and spaced regions called tiles, organized in a row/column grid 

fashion. Assembled together the tiles form the complete visual representation of 
the entire area of coverage. For more information, see section Raster Tile Layers. 
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Raster Tile Layers 

 

The Benefits of Raster Tile Layers for Web Mapping 

Leverage Existing Maps 

Raster tile layers provide a way to break up a large raster image into smaller 
pieces, and send only the pieces needed to display the current view. 

Tiled-map deployments are a very popular method to develop mapping functionality 

on the web. This approach is used by many sites such as Google Maps, Yahoo and 
Microsoft Bing to provide rich and simple map background for web applications. The 
CartoVista Viewer has the capabilities to leverage those existing maps and simplify 

your web deployments. 

By enabling the use of raster tiles, you can allow a multitude of layers to be 
packaged as raster images. By varying the content of the tiles at different scales, 

appropriate levels of detail can be displayed depending on the scale. 

The following tile map providers are available: 

 Google Maps 
 Bing Maps 

 Yahoo Maps 
 OpenStreetMap 
 Blue Marble 

 Cloud Made 
 ArcGIS Server Tile Cache 

 Zoomify 
 CartoVista Custom Tile Base map 

Unlimited Amount of Details 

Map tiles are divided into several geographic levels (scales), displaying both general 

views and details on demand. Tiles can provide unlimited zooming from a world 
view to a detailed street map. 

Tiling systems allows including many tile layers in a map. Tile layers can be scale 

dependant and also blended together as a single layer. In this case, the end user 
can select the current provider displayed from the layer control. 
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High quality tile layer with advanced labeling 

    

Seamless Map Navigation 

The map layer being composed of pre-generated tile images, the interface reacts 
very quickly when zooming and panning. When navigating with the mouse and re-

centering the map, the surrounding map tiles are already loaded in memory which 
enables smooth panning. 

Screen Resolution Independence 

The tile system interface dynamically adjusts based on the space and display 
resolution available on the end user browser screen. When the browser window size 
is modified, the tiled map is adjusted accordingly. 

Multiple Tile Map Background 

Tile layers often offer the capabilities of changing a tile layer provider from the 
interface (in the layer control). For example, the end user can switch to an aerial 

view or satellite view. When switching from one provider view to another, the 
change is optimized to avoid having to reload  vector overlay(s) in the map, if 

present. 
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High quality tile layer with aerial imagery 

Low Server Resources Consumption 

When comparing with a traditional mapping server that generated an image on 
every map click, a tiled map background drastically reduces the use of the server 
resources. Since the web server only sends existing map images, the application 

uses a minimum of resources, optimizing the availability of the server for other 
processes. 

Overlay of Layers of Interest 

Tiling also allows overlaying one or more vector layers of interest on top of the map 
tiles. It is simple to overlay a vector layer (ex: points of interest) on top of the map 
and define the required interactivity and thematic analysis options. 
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CartoVista - North America Tiles Sample - Vancouver, B.C, Canada 

While the potential interactivity of a vector layer is lost when it becomes part of a 
raster layer, the benefit of being able to display much more information as a 
background raster is enormous. Raster tile layers open up the ability to have highly 

detailed map backgrounds, while still retaining the extremely interactive vector 
layers that contain your data for thematic mapping. 
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Features 

 

Type of Features 

Points, polylines, polygons, text and image features are used to make up a map. 
Features are stored into map files. Usually, a map file contains only one type of 

feature. 

Points 

 

Points are map objects defined by a single x,y coordinate pair. Each point object is 

represented by a symbol style (e.g. circle, square, triangle, etc.). 

Points have no length or area but simply define the coordinate location of the 
feature (survey monuments, wells, mountain peaks, building permits, and traffic 
incidents are represented as points in a map). Note that the appropriateness of 

points to represent features in a map is determined by the scale (zoom level). At a 
small scale (low zoom level) cities can be represented by a point feature whereas at 

a large scale (high zoom level) cities are better represented by a polygon feature. 

Polylines (or lines) 

Any line defined by two or more points. Polylines have a linear extent but no area. 

For example, road centerlines, stream centerlines, sewer lines, and utility mains are 
represented as polylines in a map. A single polyline feature can be constructed from 
multiple parts. 

 

Polygons (or Regions) 

A polygon is a closed area defined by joining three or more points. A single polygon 

object can be constructed from multiple parts or even contain a hole within the 
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polygon and islands within the hole. For example, property parcels, census tracts, 
and soils are represented as polygons in a map. 

 

Text 

Texts are fixed annotations that are used to identify data elements on the map. 
Texts (annotations) are created for a specific map scale and view. While texts are 

static map features, labels are created and updated dynamically as the map scale 
and center changes. 

 

Raster Images 

In computer graphics, a raster graphics image, digital image, or bitmap, is a data 

structure representing a generally rectangular grid of pixels, or points of color, 
viewable via a computer monitor, paper, or other display medium. Images format 
areas and other map features as cells of a grid matrix; the fineness of the grid or 

the size of the cells in the grid matrix determines how accurately original map 
features are represented. Raster images are commonly stored in image files with 

varying formats. Bitmap is technically characterized by the width and height of the 
image in pixels and by the number of bits per pixel (a color depth, which 

determines the number of colors it can represent). In mapping, raster images are 
used for special layers such as Aerial photography, relief, etc. 

Sample Raster Image: Satellite Imagery 

 

Sample Raster Image: Digital Elevation Model (DEM) 
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Sample Raster Image: Aerial Photography 

 

Tile Servers 

A tile server is an online server, referenced by an URL, that contains a raster image 
that covers a place on the earth. The raster image is broken down into small 
regularly sized and spaced regions called tiles, organized in a row/column grid 

fashion. Assembled together the tiles form the complete visual representation of 
the entire area of coverage. 
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The use of tile servers for online map deployment is very popular and is used by 

other web sites such as Google Maps, Yahoo and Microsoft Bing for example. Tile 
servers usually serve as base maps, and depict data that does not change very 

often. They are meant to be used as backdrop images. 

The raster image used in a tile server can be blended together from multiple map 
layers (of any type of feature) to create a single raster layer. Tile server layers do 
not have attribute data. 

There are usually several levels of tiles for each tile server; each level fixed to a 
different scale, all covering the same place on the earth. The level (and hence the 
scale) determines the number of tiles (number of rows and columns). Small-scale 

(e.g., 1:10,000,000) tile sets may only contain a handful of tiles. Large-scale tile 
sets (e.g., 1:10,000) may contain millions of tiles. 
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As you zoom in or out, the level of tiles used may change.  As you pan around the 
map, the specific tiles that are needed for the current view will change. The 

program you are using to view the tiles handles requesting individual tiles and 
assembling the final image. 

When comparing with a traditional mapping server that generated an image on 
every map click, a tile server drastically reduces the use of the server resources. 

Since the tile server only points to existing images, a minimum of resources are 
required to send the map to the viewer, optimizing the availability of the server for 

other processes. 

Some important properties of a Tile Server are: 

 URL 

 Bounding Box 
 Tile size 

 Projection 
 # of levels available 
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Coordinate Systems and Projections 

 

Definition 

A coordinate system is a reference system used to represent the locations of 
geographic features within a common geographic area. 

Each coordinate system is defined by: 

 Its measurement method which is either geographic (in which spherical 

coordinates are measured from the earth's center) or planimetric (in which 
the earth's coordinates are projected onto a two-dimensional planar surface); 

 Unit of measurement (typically feet or meters for projected coordinate 

systems or decimal degrees for latitude-longitude); 
 The definition of the map projection for projected coordinate systems; 

 Other measurement system properties such as a datum, and projection 
parameters like one or more standard parallels, a central meridian, and 
possible shifts in the x- and y-directions depending on the particular 

projection. 

Types of Coordinate Systems 

There are two common types of coordinate systems used in GIS: 

 A global or spherical coordinate system such as latitude-longitude. These 

are often referred to as geographic coordinate systems; 
 A projected coordinate system based on a map projection such as transverse 

Mercator, Albers Equal Area, or Robinson, all of which (along with numerous 
other map projection models) provide various mathematical formulas to 
project coordinates from of the earth's spherical surface onto a two-

dimensional Cartesian coordinate plane. Projected coordinate systems are 
sometimes referred to as map projections. 

Spherical Coordinate System 

Latitude and longitude are angles that uniquely define points on a sphere. 
Together, the angles comprise a coordinate scheme that can locate or identify 
geographic positions on the surface of planets such as the earth. 



CartoVista Publisher Documentation 

104 

 

Latitude is defined with respect to an equatorial reference plane. This plane 

passes through the center O of the sphere, and also contains the great circle 
representing the equator. The latitude of a point P on the surface is defined as the 

angle that a straight line, passing through both P and C, subtends with respect to 
the equatorial plane. If P is above the reference plane, the latitude is positive (or 
northerly); if P is below the reference plane, the latitude is negative (or southerly). 

  

 

Longitude is defined in terms of meridians, which are half-circles running from pole 
to pole. A reference meridian, called the prime meridian, is selected, and this 

forms the reference by which longitudes are defined. On the earth, the prime 
meridian passes through Greenwich, England; for this reason it is also called the 
Greenwich meridian. The longitude of a point P on the surface is defined as the 

angle that the plane containing the meridian passing through P subtends with 
respect to the plane containing the prime meridian. If P is to the east of the prime 

meridian, the longitude is positive; if P is to the west of the prime meridian, the 
longitude is negative. 
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On a plan representation (the sphere projected), the origin (0,0) is defined as the 

intersection between the Equator and the Prime Meridian (Greenwhich Meridian). 

The X positive values are on the East of the Prime Meridian, the Y positive values 
are on the North of the Equator. The X coordinate is in the range [-180;180] and 

the Y coordinate is in the range [-90;90]. 

Map Projections 

A map projection is a system of mathematical equations used in cartography to 
represent the curved surface of the earth on a plane. A projection can retain 

accuracy in either distance and direction or area, but never both. 

Main projections: Cylindrical, Azimuthal and Conic 

Projections can be grouped by the general approach used to map spherical 
coordinates onto a plane. The three main groups of projections are Cylindrical, 

Azimuthal and Conic. Specific examples from these groups would by Lambert 
Conformal Conic, Azimuthal Equal Area and Mercator. 

Cylindrical 
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Source: USGS 

Azimuthal 

 

Source: USGS 

Conic 

 

Source: USGS 
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Styles 

 

Styles are a collection of predefined ways of representing map features. Width, 
pattern and color are common style attributes that are associated to polyline 
features. Outline width, outline color and fill color are styles applied to polygon 
features. Point features can be defined using symbol, color and size. Finally, text 

features can be differentiated using font, color and size styles. 

Applying styles to your map features allows you to follow a mapping standard and 
helps promote consistency in your organization's maps. Map communication is more 

effective when using familiar styles that enable people to easily explore, 
understand, and analyze a map. 

CartoVista comes with a default styles template. Styles within this template can be 

easily applied to map features using the Style Manager. The Style Manager also 
allows removing and altering existing styles. New styles can also be added. 

CartoVista Style Manager Window 

 

CartoVista styles as applied to polylines, polygons and points features in a map. 
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For more information on styles, see the CartoVista Publisher Style Manager. 
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Labelling 

 

Labelling is an easy way to add descriptive text to features on your map. 

CartoVista includes two methods to label your maps: you can either use dynamic 

labelling or fixed annotations (layers of text). 

Dynamic Labelling 

In the CartoVista Viewer by default, map labels are dynamically placed. The label 

placement changes as you navigate within a map. When the SWF is created, each 
layer has an associated label column and style. The label text itself is then based on 
the map feature attribute information. The dynamic label is created on-the-fly by 

the Flash engine when the map loads. CartoVista has a sophisticated labelling 
engine that detects and prevents text overlaps. 

Dynamic Labelling Sample Map with 2 views (zoom in) 
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Annotations (Fixed Text) 

In addition to dynamic labelling, CartoVista supports annotations which are layers 
of text feature that are set to a specific scale. Annotations are created with GIS 
software. If the map you are publishing is set to a specific view with no specific 

requirements to zoom-in and out too much, fixed annotations are a good approach 
to develop high quality, cartographic labels. 

Base Map Fixed Text Sample - Major Roads and Highways 
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Base Map Fixed Text Sample - Local Roads 
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Zoom Layering 

 

Maps viewed in a digital context, either within a computer mapping application or 
within an interactive web mapping application, have zoom in and zoom out 
functions.    

Managing what is or is not visible at various zoom levels (scales) is important. This 

viewing management is known as zoom-layering.   

For example, if you take a street map for a city and zoom out to view all the streets 
that are available, there is too much detail to make the map useful. To manage the 
amount of detail appearing on a map, you can use the zoom-layering feature. 

Zoom-layering features allow you to specify a range of zoom values depicting when 

a specific layer’s elements will be displayed. 

Zoom Layering - Sample Map 1: San Francisco View 
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Zoom Layering - Sample Map 2: Local View 

 

Zoom Layering - Sample Map 3: Detailed Street View 
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Thematic Mapping (Themes) 

 

The strength of communicating information lies in the method used to represent it. 
Maps prove to be a valuable method of representing a relationship between 
observable occurrences found within a geographic area. Maps that display the 
spatial distribution of an attribute are known as thematic maps. CartoVista provides 

a variety of thematic mapping techniques to display your strategic data in 
innovative and meaningful ways. 

When you publish and select indicators in as style and overlay themes, CartoVista 

automatically selects the type of thematic map you can display based on the data 
type chosen. The following paragraphs introduce the type of thematic maps 

supported by CartoVista 

Once the theme is displayed, the thematic style dialog is accessible to customize 
the settings (change the colors, classification method, etc.) 

Style Themes 

Style themes modify the style of each of the features contained in the chosen 
thematic layer. The following style themes are available in CartoVista. 

Polygon Style Theme 

A type of theme that modifies the polygon feature styles in a layer (color and fill 

pattern) based on one or more indicators. Polygon themes are often associated with 
some data classification, either with ranges or discrete values. The values are 

represented by different colors and/or fill patterns on the layer. 

For polygons, the following types of analysis are available: 

 By Color – Range of Values 
 By Color – Gradient 

 By Color - Individual Values 
 By Fill-Pattern – Individual Values 
 By Fill-Pattern - Range of Values 

Polyline Style Theme 

A type of theme that modifies the polyline feature styles in a layer (color, stroke 
width and stroke pattern) based on one or more indicators. The following thematic 

analysis options are available: 
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 By Color - Range of Values 
 By Color – Gradient 

 By Color - Individual Values 
 By Stroke Width – Individual Values 

 By Stroke Pattern - Individual Values 

Point Style Theme 

A type of theme that modifies the point feature styles in a layer (color, symbol size 
and symbol shape) based on one or more indicators. The following thematic 

analysis options are available: 

 By Color – Range of Values 
 By Color – Gradient 

 By Color – Individual Values 
 By Graduated Symbols 

 By Symbol Shape - Individual Values 

Overlay Themes 

Overlay themes are displayed on top of the map to add another dimension to style 
themes. Using symbols and charts, you can show and easily compare numerical 

values in your data. 

Overlay themes are essentially adding new objects (symbols, charts, etc.) on top of 
the thematic layer features. Overlay themes have other properties such as the 

opacity to control how the objects are displayed on top of the map features. 

The following types of overlay themes are available and apply to all vector layer 
types (point, polyline, polygons) 

Symbol Overlay Themes 
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A type of theme that adds symbols on top of the map features as an overlay. 
Symbols can be displayed with different color, shape and sizes. Symbol overlay 
themes have the same characteristics as Point Style Themes, except that in this 

case, the points are created on top of the layer map features. 

The overlay symbol shapes are limited to the 13 shapes available with CartoVista. 

Chart Overlay Themes 
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A type of overlay theme that add a chart on top of every map feature in a thematic 
layer. The following overlay themes are available. 

Pie Chart Theme 

  

A type of overlay theme that displays pie charts on top 
of map features. Pie chart themes are constructed from 
a collection of indicators, which have to be of the same 

data unit. 

Bar Chart Theme 

  

A type of overlay theme that displays bar charts on top 
of map features. Bar chart themes are constructed 

from a collection of indicators, which have to be of the 
same data unit. 

HeatMap Themes 

Heatmap themes are using color variations to display the density of a point layer 
coverage. 

This type of data representation by color is useful to understand the geographic 

distribution of a geographic fact or measure. 

In this type of thematic analysis, low density areas are usually represented with 
cold colors (blue, green) while areas of higher density are displayed with warmer 

tones (yellow, orange, red). A multi color-gradient legend typically accompanies a 
heatmap. 



CartoVista Publisher Documentation 

120 

 

Sample Heatmap Thematic Analysis 
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Attributes (Interactive Layers) 

 

In vector layers, attributes are information attached to map features. In GIS files 

like ESRI shape files and MapInfo tables, attributes are available as "columns" that 
each contain specific data about the point, polyline or polygon features of a layer. 

As part of the publishing process, you can decide which layer will have interactivity 
enabled in your map output. These map layers can feature some actions such as 

the display of datatips as well as search and info tool capabilities. 

Minimum Requirements for Interactive Layers 

Setting an interactive layer requires at least one feature attribute, used to establish 

unique identifiers (ID) for the map feature. 

Unique identifiers are used to establish data binding with indicator (thematic) data. 

It is possible to attach multiple attributes to features. 

Attributes vs Indicators 

Feature attributes are not to be confused with indicators. Indicators are the data 

values that a potential user would like to see in a thematic analysis on the map. 
Attributes are more descriptive, they provide contextual information about the 

object itself. Often, attributes tend to be more static and not change much over 
time. 

In a CartoVista map, attributes are stored directly in the flash objects, in the 

resulting swf map layers. In contrast, indicators are stored as XML files, so that 
they can be updated easily. 

Name Attribute 

The most common attributes are names, such as the name of the geographic 

features in a map layer. In the case of a polygon layer, a typical attribute maybe 
the name of each of the region. Very often, features in a layer can use this name 

for data tips, info tool or to create map labels for the layer. 

Example 

For instance, if we have a polygon layer of Census Subdivisions, the user can attach 

a series of key attributes that help define and identify each object in the map, such 
as: 
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• The Census Subdivision Codes 

• The Census Subdivision Name 

• The Census Subdivision Name (French) 

• The Census Subdivision Type 

• The Province Abbreviation 
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Managing Your Data 

 

This chapter will explain how to manage your data in the CartoVista Publisher: 

Managing Your Map Files 

 The Map File Manager 
 Adding New Map Files 

 Map File Actions 
 Managing Missing Data 
 Map File Properties 

 Browsing Map File Data 
 Filtering Map File Data 

 The Web Map Service (WMS) Map File 

Managing Your Data Files 

 Data File Manager 
 Adding New Data Files 

 Data File Actions 
 Managing Missing Data 

 Data File Properties 
 Data Column Actions 
 Data Column Properties 

 Browsing Data File Data 

Stylizing Your Map Files: The Style Manager 

 Adding New Styles 

 Polygon Layer Styles 
 Polyline Layer Styles 

 Point Layer Styles 
 Font Styles 
 Assigning Styles to Features 

Managing Coordinate Systems 

 Coordinate System Manager 
 Defining New Coordinate Systems 

 Importing Coordinate Systems 
 Changing a Map Coordinate System 

 Coordinate System Selection Dialog 
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Managing Your Data 

 

Creating a Map for CartoVista requires coordinating various different types of data. 
You will have your geographic data, depicting boundaries, points and other map 
geographies. You will have your data variables that you wish to display 
thematically.  Additionally, you will have a set of styles to apply to the geographic 

objects, and a coordinate system to apply to the map. 

The CartoVista Publisher simplifies the management and creation of all the different 
types of files, styles and coordinate systems for your CartoVista project. Four 

specific managers manage the Map Files, Data Files, Styles and Coordinate systems 
respectively. 

This section of the user guide describes each of the managers and the tasks you 

can perform to manage your data in a simple system that promotes re-use rather 
than starting from scratch for each new map. 
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Managing Your Map Files 

 

The Map Source Manager is designed to help you manage your geographic data. 
You can display the Map Source Manager from the main menu bar. Select View > 
Map Source Manager. 

The Map Source Manager allows you to create Map Files. Each Map File refers to a 
specific geographic data file. It will have its own style, labeling and zoom-layering 
properties. A single geographic data file can be referenced by many different Map 

Files, each with its own unique name and settings. This allows a single geographic 
data file to be re-used without having to create multiple copies of the same source 

file. For example a street network file can be referenced with different display styles 
appropriate for use at different scales. 

 

NOTE: A Map File’s settings are independent of any Map Window in which the Map 
File is used. In other words, if you use a Map File to build a map and then you 

change the settings in the map, those settings are not applied to the Map File in the 
Map Source Manager. 

The Map Source Manager allows you to create an unlimited library of reusable Map 

Files. By centralizing the management of your map files and their style settings, 
you can rapidly create maps without having to re-find source geographic data every 
time, or re-apply style settings to those files. 
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The Map Source Manager divides Map Files into three distinct categories: Local, 
Database and Tile. Each category has its own section in the Map Source manager. 

Local Map Files represent a geographic data file that is on the local machine or 

network. These files contain Text, Point, Line, Polygon or Raster data. Database 
Map Files represent a geographic data file this located in a remote database, such 

as Oracle, Microsoft SQL Server or PostGIS. The geographic data can represent 
Points, Lines or Polygons. 

Tile Providers represent a collection of small raster images obtained over the 

internet that when assembled together form a complete image of the layer. For 
more information on Tile layers, see section Raster Tile Layers or Creating & 
Publishing Tiled Base Maps. 

It is also possible to use WMS layers. These are raster images that are obtained 

from a WMS Server over the internet using the WMS web protocol from the OGC. 
For more information on WMS layers, see section The Web Map Service (WMS) Map 

File. 

Some properties and settings will only be available for specific types of Map Files, or 
for the specific geographic data type of the source file. 

  



Managing Your Data 

127 

  

 

The Map Source Manager 

 

The Map Source Manager is a dockable window that contains a tree structure 
displaying all the available Map Files. If the Map Source Manager is not visible, 
select View -> Map Source Manager from the main menu. Since the Map Source 
Manager is a dockable window, it can also be minimized to the edges of the main 

application window. 

 

The Map Source Manager has three sections, one for Local Map Files, one for 
Database Map Files, and one for Tile Providers. Each section contains a tree 

structure displaying all the available Map Files sorted alphabetically. 

Map Files that can have style settings assigned to them have sub-nodes that depict 
the style settings in use. This can be either  a single <<Default>> style, that will 

be applied to all objects in the Map File, or multiple nodes with one node for each 
unique identifier in the Map File’s unique identifier column. Style nodes will display 
a visual representation of the style assigned to the identifier. 
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By right-clicking outside of a Map File node, you can bring up the Map Source 
Manager context menu. This menu will let you add a new map file appropriate t the 

category you have open, as well as launch the dialog for creating a new Map, 
Server or Tile Window. For more information on these options see section Adding 

New map Files and section on Creating a Map Window, Creating a Server Window 
and Creating a Tile Window respectively. 

It is also possible de create folders/sub-folders to organize and classify the map 

files within the map file manager. Simple drag and drop will let the user organise 
the content of the map source manager. 

The Map Source Manager will alert you if the source geographic data for one of the 
local Map Files is missing. Map Files that are missing their geographic data source 

are highlighted in yellow in the Map Source Manager. Maps that have been created 
with missing source data will still display, with the caveat that the missing layer is 

not drawn and the layer will also be highlighted in yellow in the layer control. To 
correct the file path of a Map File, click on the map file and use either of the Locate 
or the Locate Main Folder menu options. See section on Managing Missing Data for 

more information on locating missing map files. 
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Adding New Map Files 

 

You can use one of the following methods to add new map files to the Map Source 

Manager. 

1. Within the Map Source Manager, right click in any white space in the Map 
Source Manager  then select the menu "Add Local Map File...", "Add 
Database Map File" or "Add Tile Provider", depending on which category is 

open. 

 

2. From the main menu, select File - > New - > Map Source and choose either 
Local, Database or Tile Provider. 

 

NOTE: You currently cannot add any additional WMS Layers. For information on 
how to use a WMS layer, see section The Web Map Service (WMS) Map File. 

Adding a Local Map File 

If you have chosen to add a new local Map File, you will be prompted to select the 
file from a file selection dialog.  Make sure you set the file type to display to the 
correct type of geographic data you are trying to add. Your choices include: 

 Vector Formats (both .TAB and .SHP files) 

 Raster Formats (all raster extensions supported) 

 MapInfo Tables (.TAB files) 
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 ESRI SHP Files (.SHP files) 

 ESRI Personal GeoDatabase Files (.MDB files) 

 All Files 

For most geographic data files, the file is then added to the Map Source Manager 
with the same name as the filename you have selected. 

ESRI.SHP files without a .PRJ file 

Note: the following is only applicable to ESRI Shapefiles. 

If you are selecting a ESRI .SHP file that does not have a corresponding .PRJ file, 
you will be prompted to choose the projection for the Map File. 

 

Select the projection that matches the projection used in the .SHP file. Selecting 
the incorrect projection will lead to the data being placed in the wrong location. For 

more information on projections, refer to section Managing Coordinate Systems. 

ESRI Personal GeoDatabase 

An ESRI Personal GeoDatabase file can contain multiple geographic data source 

files. You will be prompted to choose one or more files from the Personal 
GeoDatabase to add as Map Files. 
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Raster Images 

When opening raster images, the Map Source Manager needs to know how to 
position the raster image and its coordinate system. 

Positioning the raster image with regards to real world coordinates is done with a 

“world file” that is associated with each raster image. A world file describes the 
location, scale and rotation of the image. 

A world file is a six-line text file with decimal numbers on each line. The name of 
the file is the same as the associated raster file, with a modified extension. 

The following conventions are used to name the world files: 

Raster Image 
Type 

World File Extension 

.jp2 .j2w 

. ecw .wld 

.tif, . tiff .tfw 

. sid   .sdw 

. jpg , . jpeg .jgw 

. png .pgw 

. bmp .bpw 

The Map Source Manager will prompt you to select a coordinate system when 
opening a raster image. Select the projection that matches the projection used in 
raster image file. Selecting the incorrect projection will lead to the data being 

placed in the wrong location. For more information on projections, refer to section 
Managing Coordinate Systems. 
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NOTE: If you are working with raster images registered as a MapInfo table with a 
corresponding .TAB file, the Map Source Manager has all the information it needs. 
You will not need a world file, nor will you be prompted to select a projection. 

  

Multiple Feature Types in Map Files 

NOTE: The following is only applicable to MapInfo tables, as ESRI Shapes do no 
support mixed geometries. 

If you have selected a MapInfo table that contains more than one type of feature 
(ex: Polygon and Points), the Map Source Manager will automatically select the 
geometry type of the first record in the table. 

If this is not the correct geometry type to use, it is possible to change the geometry 

type by right clicking on the Map File in the Map Source Manager and selecting the 
Set Geometry Type menu option. 

 

The Select Data Type dialog will let you choose the correct geometry type. If 

desired, you can click the Count button to display the number of objects of each 
geometry types in the MapInfo table.  If you have a large file, this may take several 

seconds. 
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Adding a Database Map File 

If you have chosen to add a new Database Map File, you will be presented with a 
wizard that will guide you through the steps. 

 

You must first know the type of database you are trying to connect to, and the 

server address of that database. Currently CartoVista Publisher supports Microsoft 
SQL Server 2008, Oracle 11g and PostgreSQL (PostGIS). If you do not know the 
name of your server address, please contact your IT administrator, or the IT 

administrator of the database you wish to connect to. They will be able to help you 
with this and the other information such as the Port number you will need to 

connect. 

Enter the database name, username and password that have permission to connect 
to that database. 

Once a connection is established to a database, you must enter the name of the 

table (or view) that you wish to use. Please note that the table names ARE case 
sensitive. 
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Finally, you will select the columns from the Table/View to use as columns in your 

Map File. 

 

There are 2 options to determine which columns are selected: 

Selecting ALL Columns: If no specific columns are selected, a “*” will appear in 
the Selected list. This is a short form for “All Columns”. 

Selecting Specific Columns: Select one or more columns from the list of available 

columns in the Available list and add them to the right hand Selected list using the 
> button. Use the < button to remove one or more columns from the Selected list 
and return them to the available list. 

NOTE: It is better to use all columns (“*”) rather than manually select all the 
columns individually. 

Feature ID Column: The Feature ID Column in the Database Connection Wizard 
must be set to the column in table which contains the Geographic Features Unique 
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Identifier. This unique identifier is distinct from the table’s primary key and servers 
to reference the geometry of feature; because of this the Feature ID will not be 

available in the layers Table and cannot be used for data joins. When the wizard 
connects to a table it attempts to auto detect the Feature ID column, in which case 

not further action is required by the user and the Feature ID parameter of the 
wizard will be automatically populated. If the Feature ID column is not auto 
detected the user will need to select the column from the drop down list. 

Geometry column: The Geometry Column in the Database Connection Wizard 
should be set to the column of the table which contains the feature geometry of the 
layer. 

Adding a Tile Provider 

There are four different styles of Tile Providers that you can add to the available tile 
providers: 

 

For CartoVista, ESRI and IGN, enter a name for the new tile provider, and in the 

Server Address enter the URL where the tiles are located. 

If you select a Tile Cache Tile Provider, there are additional parameters that must 
be provided. Contact the creator of the Tile Cache Provider to find out the exact 

values that must be entered in order for the tiles to appear correctly. 
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Request Type: the type of request to make to the Tile Cache server. Options are 
Disk Cache, World Wind and Tile Mapping Service. 

Image Type: the type tile image returned by the Tile Cache Server. Options are 

PNG, GIF or JPG. 

Projection: The projection of the tile set. By default, the Spherical Mercator 
projection (used by most popular tile providers like Google, Bing and Yahoo) is 
preselected. However if the Tile Cache Server has tiles in another projection, click 

the Set button and select the appropriate projection. 

Map Extents: The bounding box of the top level of the tileset. 
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Tile Zoom Levels: Specifies how many zoom levels are available, and what the 
scale of the zoom levels are. 
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Zooms: By selecting this option, the scale of the zoom levels is calculated based on 
the initial Extents. The user has to specify the maximum number of zoom levels 
that are available, and each level is double the scale of the previous zoom level. 

Zooms specified by User Resolutions: By selecting this option, the resolutions 
and number of zoom levels is provided by the user. In the “<Insert Resolution 
Here>” line, enter each resolutions that are available in the Tile Cache Provider. 

Multiple resolutions can be entered at one time, as long as they are separated by a 
comma. 

Zooms specified by User Scales: By selecting this option, the scale and number 

of zoom levels is provided by the user. In the “<Insert Scale Here>” line in the 
Resolution Scale, enter each of the scales that are available in the Tile Cache 
Provider. Multiple scales can be entered at one time, as long as they are separated 

by a comma. 
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Duplicate File Name 

The Map Source Manager expects that each Map File will have a unique name. If 
you add a new Map File that has the same name as an existing Map File,  the Map 
Source Manager will display a dialog asking you to enter a different name. 

 

Once you have entered a name that does not conflict with an existing Map File, the 
new Map File will be created. If you want to abort the creation of a new Map File at 
this point, click on the red X button at the top right of the dialog. 

Local Map Files Folders 

Local Map Files can be sorted into folders to help with organization. Folders can be 
created by right clicking outside of the tree structure and selecting Add New Folder. 

 

This will create a new top level folder. It can not have the same name as an 
existing folder or Map File. 

Folders have the following options available via their right click menu: 

Rename: Change the name of the folder. The new name must not already exist in 

the Map Source Manager at the same level as the folder. 

Remove: Removes both the folder and any sub-folders or Map Files that are inside 
of the folder. 
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Create Map Window: Creates a new Map Window with any Map Files that are 
within the folder or its sub-folders. 

Create Tile Window: Creates a new Tile Window with any Map Files that are 

within the folder or its sub-folders. This option is only available if you have 
purchased the Tile Module add-on for the Publisher. For more information about 

creating tiles see section Creating & Publishing Tiled Base Maps. 

Add New Folder: Creates a sub-folder within the folder. 

Map Files can be added to folders using Drag & Drop in the Map Source Manager, or 
their Folder property in the Map File Properties Dialog. When setting the folder in 

the Map File Properties dialog, separate sub folders using the “\” character. 
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Map File Actions 

 

When you right click on a Map File, a contextual menu is displayed. Some menu 
items may be disabled depending on the type of Map File. 

 

Assign Styles: This option is available for Point, Polyline and Polygon Map Files. It 
allows you to specify how the geographic objects will be displayed in the Map 

Window. For more information about assigning styles, see section Assigning Styles 
to Features. 

Browse Data: This option is available for Annotation, Point, Polyline and Polygon 

Map Files. It allows you to view the data attached to the geographic objects. For 
more information about browsing data see section Browsing Map File Data. 

Create Map Window: This option allows you to create a new map based on the 
selected Map Files. For more information about creating maps see section Creating 

and Configuring a Map. 

Create Tile Window: This option is only available if you have purchased the Tile 
Module add-on for the Publisher. It allows you to create a new tile map based on 

the selected Map Files. For more information about creating tiles see section 
Creating & Publishing Tiled Base Maps. 

Locate: This option allows you to point the Map File at a different geographic data 

source file, or to update the information if the geographic data source file has been 
modified. For more information on locating the geographic data source see section 
Managing Missing Data. 

Clear Cache: This option is only available for Tile Map Files. It allows you to clear 
any tiles that have been cached locally on your computer. 
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Locate Main Folder: This option allows you to point multiple layers to different 
geographic data source files all at once by specifying a root directory for all the 

source files. 

Set Geometry Type: This option allows you to select the geometry type of a Map 
File that is created from a MapInfo Table. 

Remove: This option allows you to remove a Map File from the Map Source 

Manager. It does not delete the underlying geographic source file, nor does it affect 
any maps that were created with this Map File. 

It is also possible to remove Map Files and Map Files Folders using the Delete key 

from the keyboard. 

New Confirmation Dialogs 

A confirmation dialog box is now launched when you remove a Layer from the Layer 
Control, a Map File from the Map Source Manager or a Data File from the Data File 

Manager. A "Do not ask me again" option is available within the dialogue to turn off 
the use of the launched dialog. These new confirmation dialogs can be managed 
using the Tool > Preference > General Options Tab. 3 check boxes have been 

added so you can turn on/off the warning dialogs. 

 

Properties: This option allows you to see the properties associated with a specific 

Map File. See section Map File Properties for more information. 
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Managing Missing Data 

 

The Map Source Manager will alert you if one of the Map Files that you have been 
working with is missing its source geographic data file. Map Files that are missing 
are highlighted in yellow in the Map Source Manager. 

Maps that have been created that contain layers with missing Map Files will still 

display, with the caveat that the missing layer is not drawn and the layer will also 
be highlighted in yellow in the layer control. 

To correct the location of a Map File that is missing, click on the Map File and use 
either of the Locate or the Locate Main Folder menu options. 

NOTE: You can also select more than one map file and then click on Locate Main 

Folder to reset the base folder for all files. 

When you click on locate, the Locate Map File Dialog is displayed. 

 

Use the Find button to locate the missing map file and click on OK. 

NOTE: You can use the Locate action to update a Map File if the source geographic 
data has changed its column structure. Locating a Map File when this has happened 
will result in the list of columns available within the Map File to be updated. 
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Map File Properties 

 

The Map File Properties dialog allows you to see all the properties associated with 

the Map File. Changing these properties does not affect any Map File that is already 
in use in a Map Window. It simply sets the default properties for the next time this 
Map File is used. 

You can use one of the following methods to access the Map File Properties Dialog: 

1. Double click on the Map File node in the Map Source Manager 
2. Right click on the Map File node in the Map Source Manager and chose one of 

the options in the Properties’ submenu. 

 

This will take you directly to that tab in the Map File Properties Dialog. 

General Tab 

The General Tab displays basic information about the map file . 

Map File Name: This is an editable property. You can specify any name. To edit 

the name, type in the name box. Map file names must be unique within the Map 
Source Manager. 

Folder: The folder in the Map Source Manager where this Map File will be found. 

This is an editable property. You can specify any folder name. A folder of the 
appropriate name will be automatically created if necessary. 

File Path: The path to the GIS file providing the feature data. 

Source: The type of GIS source. One of the following: 

 MapInfo Table 

 ESRI Shape File 
 GeoDatabase File 
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 Raster File 
 WMS Layer 

 Tile Layer 
 Database Connection 

Data Type :The type of data stored in the map file. One of the following: 

 Polygon 

 Polyline 

 Point 

 Annotation 

 Raster 

 WMS 

 Tile 

Coordinate System: The GIS file’s coordinate system. The text displayed here will 
be one of the following three options: 

1. PROJ4 format – PROJ4 is a cartographic projections library originally written 
by Gerald Evenden. Visit http://trac.osgeo.org/proj/ for more information 

2. WKT format – WKT is a text markup language for representing vector 
geometry objects on a map and spatial reference systems. Visit 

http://geoapi.sourceforge.net/2.0/javadoc/org/opengis/referencing/doc-
files/WKT.html for more information 

3. User Defined Name – CartoVista Publisher maintains a list of projections in 

WKT format that have been given a useful projection name and category. 
This allows for easier interaction with coordinate systems, as they can be 

categorized into meaningful categories (e.g. UTM Zones) and given 
meaningful names (e.g. UTM Zone 18, NAD83, Canada) 

Metadata (Sources): This field is available to enter Metadata on each Mapfiles. 

The field supports text and hyperlinks.  

NOTE: See Tools and Preferences - > Projection Settings for information on 
how to change the program settings or how to display projections. 

By double-clicking on the coordinate system name, you can choose two of the 
following options: 

 "View properties" displays a dialog with a list of the coordinate system 
properties. 
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 "Add to Coordinate System Manager" allows you to add the map file 

coordinate system to the Coordinate System Manager in a specific category 
and with a given name. The "Save Coordinate System as..." dialog is 
displayed. 

 

For more information on Coordinate Systems, Categories and Names, see section 

Managing Coordinate Systems. 

The following Map File attributes are only present when displaying the properties for 
a Tile Map File. 

 Tile Provider: The name of the type of Tile Provider 

 Tile URL: The URL of the Tile Provider 
 Raster Type: The type of raster images that the Tile Provider sends 

 Closest Zoom: The closest level of detail provided by the Tile Provider. 
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The following Map File attributes are only present when displaying the properties for 
a Database Map File. 

 Address: The server address of the database. 

 Port: The port used on the server. 
 Database: The name of the database used. 

 Table: The name of the table/view used. 
 User Name: The username used to log into the database. 

Style Settings Tab 

The style settings tab provides information on how to render the geographic objects 
for the Map File. 

For Point, Polyline and Polygon Map Files, the Style Property section is enabled. 

Annotation Map Files have no style settings to set, and as such do not have this 
section. For Raster, WMS and Tile Map files, only the Transparent Color (Raster) 
section is enabled. 

For Point Map Files, a symbol rotation column can be configured. This setting allows 

the user to rotate the symbol for the point to a specific angle based on that object’s 
field entry in the user specified column. 

 

Style Property 

This section controls how styles are displayed for Point, Polyline and Polygon Map 

Files. There are three ways in which styles can be displayed: 
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1. Default Style: A single style will be used for all geographic objects. To 
change the default style, click on the Edit Style Button. 

2. Coloring Scheme: A style will be applied to the geographic objects based on 
the value in the specified attribute column. Each unique value within the 

column will have a unique style assigned automatically. 

 

 For more information on style assignment see Assigning Styles to Features. 

Show unassigned identifiers option 

Choose this option to display all the unique identifiers, even if they have not been 
assigned a style. If this option is not selected, only identifiers with an assigned style 
(including identifiers auto-assigned by the default style) are displayed. 

3. MapInfo Table Style: This option is only available when the source 

geographic data file is a MapInfo Table (.tab). When this option is selected, 
the style information for each feature will be read directly from the 

information stored in the MapInfo Table. 

NOTE: Some of the MapInfo style options such as fill and stroke patterns are not 
supported by the CartoVista Publisher. 

Transparent Color (Raster) 

This section controls how transparency is handled for the Raster, WMS and Tile Map 
Files. 

By selecting the “Enabled” checkbox, you can specify a specific color to be 
transparent. Click on the Color button to choose the specific color that will be 

transparent. 

Symbol Rotation Column (Point) 

This section controls how points styles can be rotated based on a data column. 

By selecting a column containing numeric data, the point symbol displayed will be 

rotated based on the value of column for that point. 
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Filter Tab 

The Filter tab provides information on the filter (if any) that is applied to the map 
layer. 



CartoVista Publisher Documentation 

150 

 

For more information on setting filter options, see Filtering Map File Data. 
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Browsing Map File Data 

 

Browsing your Map File data allows you to see the attribute data attached to each 
of the geographic objects.  This option is only available for Annotation, Point, 
Polyline and Polygon data types. Raster, WMS and Tile Map Files have no data to 
view. 

To browse a Map File, select the Map File in the Map Source Manager, right click 
and select “Browse…”. 

The Map File Table Browser displays all data records associated with the map file. If 
a filter is applied, only the records that match the filter will be displayed. The total 

number of rows in the map file is displayed in the status bar. 

 

  

TIP: You can use the column headings to sort records in the table. 
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Filtering Map File Data 

 

Filtering your Map File data allows you to display only certain features from a Map 
File rather than all of the features. When filtering is enabled, the features that are 
displayed will depend a comparison of one or more of the map file’s attributes to a 
user supplied value. This option is only available for Point, Polyline and Polygon 

data types. 

To filter a Map File, select the Map File in the Map Source Manager, right click and 
select “Filter…” from the Properties menu. The Filter Settings tab of the Map File 

Properties dialog allows you to set one of three methods for filtering, and enter the 
information to filter on. 

 

Filter Property 

Enabled: When enabled, the filter will be applied to the Map File. The icon 
representing the type of Map Layer will change to indicate a filter is applied: 

 

Polygon layer with 

filtering 
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Polyline layer with 
filtering 

 

Point layer with 
filtering 

Filter Type: The following filter types are available: 

Filter Type Description 

Simple A single attribute in the feature is compared to a string value. 

RegEx 
A single attribute in the feature is matched with a regular 

expression. 

Expression 
One or more attributes in the feature are compared using 

logical operators. 

Depending on the filter type selected, one of the following filter editors will appear. 

Simple Filter Properties 

Filter Column: This identifies the attribute column in the source GIS data that will 
be used in the filter. 

Operation: This identifies the operator that will be used in the comparison 

between the feature’s attribute and the user entered value. If the comparison 
returns TRUE, then the feature will be displayed. 

Operation Description 

Equals 
Does an exact, case sensitive match to determine if the 

attribute is identical to the value. 

Not Equal To 
Does an exact, case sensitive match to determine if the 

attribute is not equal to the value. 

Less Than 
Does a String comparison to determine if the attribute is less 
than the value. (See notes below on string comparison rules.) 

Greater Than 
Does a String comparison to determine if the attribute is 
greater than the value. (See notes below on string comparison 

rules.) 

Less Than and 
Equal To 

Does a String comparison to determine if the attribute is less 
than or equal to the value. (See notes below on string 

comparison rules.) 

Greater Than and 
Equal To 

Does a String comparison to determine if the attribute is 

greater than or equal to the value. (See notes below on string 
comparison rules.) 

In Set Of 
Does an exact case sensitive match to determine if the 

attribute is in any number of comma separated strings in the 
value. (NOTE: Do not add extra spaces) 
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Not in Set Of 
Does an exact case sensitive match to determine if the 
attribute is NOT in any number of comma separated strings in 

the value. (NOTE: Do not add extra spaces) 

STRING Comparison Rules: 

The attribute’s value is compared character by character to the value until either all 

characters are determined to be identical, or a difference is found. 

Space < Everything 

A < B, a < b 

Uppercase < Lowercase 

Number < Alphabet 

NOTE: Be careful comparing numeric values this way. Because each number is 

compared one digit at a time, the result can be counter-intuitive. For example, “80” 
is greater than “1000” because the first digit comparison sets the result for the 
whole comparison. If you need to do numeric comparisons outside of EQUAL, use 

Expression filters. 

Value: This is the string value that will be compared to the feature’s attribute. 

RegEx Filter Properties 
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Filter Column: This identifies the attribute column in the source GIS data that will 

be used in the filter. 

RegEx: The regular expression to match against the attribute’s value. 

Regular Expressions (RegEx) 

A regular expression provides a concise and flexible means for "matching" 
(specifying and recognizing) strings of text, such as particular characters, words, or 

patterns of characters. It is often more concise to specify a set's members by such 
an expression than by a list. For example, ab*c matches "ac", "abc", "abbc", 

"abbbc", and so on. 

Symbol Description 

. Matches any single character. For example, a.c matches "abc", etc. 

[ ] 

A bracket expression. Matches a single character that is contained within 

the brackets. For example, [abc] matches "a", "b", or "c". [a-z] specifies a 
range which matches any lowercase letter from "a" to "z". These forms 

can be mixed: [abcx-z] matches "a", "b", "c", "x", "y", or "z", as does [a-
cx-z]. 

[^] 

Matches a single character that is not contained within the brackets. For 

example, [^abc] matches any character other than "a", "b", or "c". [^a-z] 
matches any single character that is not a lowercase letter from "a" to "z". 

As above, literal characters and ranges can be mixed. 
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^ 
Outside square brackets, matches only at the beginning of the string. For 
example, ^abc will find abcdef but not xyzabc. 

$ 
Matches only at the end of the string. For example $abc will find xyzabc 
but not abcdef. 

* 

Matches the preceding element zero or more times. For example, ab*c 

matches "ac", "abc", "abbbc", etc. [xyz]* matches "", "x", "y", "z", "zx", 
"zyx", "xyzzy", and so on. \(ab\)* matches "", "ab", "abab", "ababab", and 

so on. 

More information on additional RegEx options can be found on the web. As a good 
start, we recommend http://en.wikipedia.org/wiki/Regular_expression. 

Expression Filter Properties 

 

Expression: The expression to evaluate for each feature. 

Expressions 

Expressions are comparisons that evaluate to a TRUE or FALSE result. They differ 
from RegEx expressions in that they can involve more than one attribute column 

and besides pure logical operations there are also operators that allow certain 
arithmetic, string and time operations. 
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An expression has two values, and an operator that determines the type of 
comparison. Expressions can be enclosed in parentheses “(“ and “)” and then 

combined with AND, OR and NOT operators. 

String Expressions 

“String1” <operator> “String2” 

String1/String2 are values enclosed in double quotes. They can reference an 
attribute column name by enclosing the attribute column name within square 

brackets inside the double quotes. 

For example, “abcxyz”  is a string value, whereas “[STATENAME]” will substitute 
the feature’s attribute from the STATENAME column. 

String 

Operations 
Description 

+ 
Adds two strings together to form one string. This does not result 
in a TRUE/FALSE value, but can be used to create composite 

strings for use in a string expression. 

= 
Does an exact, case sensitive match to determine if the first string 

is identical to the second string. 

=* 
Does an exact, case INSENSITIVE match to determine if the first 
string is not equal to the second string. 

!= 
Does an exact, case sensitive match to determine if the first string 
is not equal to the second string. 

< 
Does a String comparison to determine if the first string is less 
than the second string. (See notes on string comparison rules) 

> 
Does a String comparison to determine if the first string is greater 

than the second string. (See notes on string comparison rules) 

<= 
Does a String comparison to determine if the first string is less 

than or equal to the second string. (See notes on string comparison 
rules) 

>= 
Does a String comparison to determine if the first string is greater 

than or equal to the second string. (See notes on string comparison 
rules) 

IN 
Does an exact case sensitive match to determine if the first string 
is in any number of comma separated strings in the second string. 
(NOTE: Do not add extra spaces) 

~ 
Returns TRUE when the first string matches the Expression 
contained in the second string. 

~* 
Returns TRUE when the first string matches the Expression 
contained in the second string and the comparison is done case 
INSENSITIVE. 
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Numeric Expressions 

Number1 <operator> Number2 

Number/Number2 are numeric values. They can reference an attribute column 

name by enclosing the attribute column name within square brackets. For example, 
[POPULATION] will substitute the feature’s attribute from the POPULATION column. 

Numeric operators are: =, !=, <, >, <=, >=, IN 

The following operations can be performed with numbers. They do not return a 

TRUE/FALSE value, but can be used to create a number for use in a numeric 
expression: +, - *, / , ^ 
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The Web Map Service (WMS) Map File 

 

CartoVista can include one or more dynamic Web Map Service (WMS) layers in its 
maps. When displaying the map in the CartoVista Viewer, the content of these 
layers is obtained from the external WMS map server. 

WMS Layers in the publisher are represented by a “place holder” WMS Map File 

named "{WMS Layer}". Simply add this layer to your map like any other layer. 
Nothing will be displayed in the Publisher’s Map Window, but there are some 
properties that can be set on its layer node in the layer control. 

NOTE: You cannot create a map that consists only of a single WMS layer. 

You can add the WMS Map File multiple times to a Map Window. Each WMS layer 

will have to be configured separately after the map is published. For more 
information, see section on configuring your WMS Layers. 
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Managing Your Data Files 

 

The Data Source Manager is designed to help you managed your indicator data. You 
can display the Data Manager from the main menu bar. Select View > Data Source 
Manager. 

The Data Source Manager allows you to create Data Files. Each Data File refers to a 
specific local file or database table. It will have a collection of columns which can be 
used as indicators for creating thematics. 

 

The Data Source Manager allows you to create an unlimited library of reusable Data 

Files. By centralizing the management of your data files, you can rapidly publish 
data without having to re-find source files every time. 

Data Files are displayed as a tree with all the columns for a data file listed as sub 

nodes. The column nodes are displayed with an icon that identifies the type of data 
contained in the column: String, Float, Integer, Byte, DateTime. 
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Data Source Manager 

 

The Data Source Manager is a dockable window that contains all of the available 
data files. 

If the Data Source Manager is not visible, select View > Data Source Manager from 
the main menu. Since the Data Source Manager is a dockable window, it can also 

be minimized to the edges of the main application window. 

The Data Source Manager has two sections, one for Local Data Files and one for 
Database Data Files. Each section contains a tree structure displaying all the 
available Data Files sorted alphabetically. 

 

By right-clicking outside a data file node or on the Data File category node, you can 

bring up the Data Source Manager context menu. This menu will have on option 
depending on which section of the Data Source Manager you are in. For more 

information on adding Data Files, see section Adding New Data Files. 

The Data Source Manager will alert you if the source file for one of the Data Files is 
missing. Data Files that are missing their source file are highlighted in yellow in the 
Data Source Manager. To correct the file path of a Data File, click on the data file 

and use the Locate menu option. See section Managing Missing Data for more 
information on locating missing Data Files. 
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Adding New Data Files 

 

You can use one of the following methods to add new data files to the Data Source 
Manager. 

1. Within the Data Source Manager, right click in any white space in the Data 
Source Manager or on the main Data Files node then select the menu “Add 

Local Data File” or “Add Database Data File” depending on which category is 
open in the Data Source Manager. 

 

2. 2. From the main menu, select File -> New -> Data Source and choose either 
Local or Database. 

 

Adding a Local Data File 

If you have chosen to add a new local data file, you will be prompted to select the 
file from a file selection dialog. Make sure you set the file type to display the correct 

type of file you are trying to add. Your choices include: 

 MapInfo Tables 

 ESRI Shape Files] 

 ESRI Personal Geodatabase Files 

 Excel Spreadsheets 

 CSV Files 

 Text Files 

Excel File Workbook Options 
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If you selected an Excel spreadsheet, you will be prompted to pick on worksheet 
from the worksheets in the spreadsheet. You will also be asked to indicate if the top 

row of data contains column headers, rather than data. 

 

CSV and Text File Options 

If you selected a CSV or a Text file, you will be prompted to set one or two options. 
If you selected Text file, you will be asked to specify the delimiter character, which 

separates columns in the file. Two common choices (Comma and Tab) are provided 
as radio options, while “Other” lets you specify any single character you wish. You 

will also be asked to indicate if the top row of data contains column headers, rather 
than data. 

 

ESRI Personal Geodatabase Options 

If you selected a ESRI Personal Geodatabase, you will be prompted to select the 
tables from within the database that you wish to add. You can select more than one 

table to add at the same time to the Data Source Manager.’ 

NOTE: You can use this option to open a Microsoft Access Database as well. 
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Adding a Data File from a Database 

If you have chosen to add a new Database data file, you will be presented with a 
wizard that will guide you through the steps required to add a Database table. 

 

You must first know the type of database you are trying to connect to, and the 
server address of that database. Currently CartoVista Publisher supports Microsoft 
SQL Server 2008, Oracle 10g and PostgreSQL. If you do not know the name of your 

server address, please contact your IT administrator, or the IT administrator of the 
database you wish to connect to. They will be able to help you with this and the 

other information such as the Port number you will need to connect. 

Enter the database name, user name and password that have permission to 
connect to that database. 

Once a connection is established to a database, you must enter the name of the 
table (or view) that you wish to use. Please note that the table names ARE case 

sensitive. 



Managing Your Data 

165 

 

Finally, you will then select the columns from the Table/View to use as columns in 

your Data File. There are 2 options to determine which columns are selected: 

1. ALL Columns: Select the “Select Columns” radio button, but remove any 
column names from the “Selected” list. This will result in a “*” appearing in 

the Selected list. This is a short form for “All Columns”. 

2. Specific Columns: Select the “Select Columns” radio button  and the select 
from the list of available columns in the left hand listbox and add them to the 

right hand Selected list box using the > button. Use “>>” to move over all 
selected columns. You can use the < button to remove a column, or << to 
remove all columns. 

NOTE: It is better to use all columns (“*”) rather than manually select all the 

columns individually. 

Duplicate File Name 

The Data Source Manager expects that each Data File will have a unique name. If 

you add a new Data File that has the same name as an existing Data File, the Data 
Source Manager will display a dialog asking you to enter a different name. 
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Once you have entered a name that does not conflict with an existing Data File, the 
new Data File will be created. If you want to abort the creation of a new Data File at 

this point, click on the red X button at the top right of the dialog. 
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Data File Actions 

 

When you right click on a Data File, a contextual menu is displayed. 

 

Browse Data: This option allows you to view the data file. For more information 
about browsing data see section Browsing Data File Data. 

Locate: This option allows you to point the Data File at a different source file, or to 

update the information if the source file has been modified. For more information 
about Locating Data Files, see section Adding New Data Files. 

Locate Main Folder: This option allows you to point multiple layers to different 
geographic data source files all at once by specifying a root directory for all the 

source files. 

Remove: This option allows you to remove a Data File from the Data Source 
Manager. It does not delete the underlying source file. 

New Confirmation Dialogs 

A confirmation dialog box is now launched when you remove a Layer from the Layer 
Control, a Map File from the Map Source Manager or a Data File from the Data File 
Manager. A "Do not ask me again" option is available within the dialogue to turn off 

the use of the launched dialog. These new confirmation dialogs can be managed 
using the Tool > Preference > General Options Tab. 3 check boxes have been 

added so you can turn on/off the warning dialogs. 

 

Properties: This option allows you to see the properties associated with a specific 
Data File. See section Data Files Properties for more information. 
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Managing Missing Data 

 

The Data Source Manager will alert you if one of the Data Files that you have been 
working with is missing its source file. Data Files that are missing are highlighted in 
yellow in the Data Source Manager. 

To correct the location of a Data File that is missing, click on the Data File and use 

the Locate menu option. 

When you click on locate, the Locate Data File Dialog is displayed. 

 

Use the Find button to locate the missing file and click on OK. 

NOTE: You can use the Locate action to update a Data File if the source data has 

changed its column structure. Locating a Data File when this has happened will 
result in the list of columns available within the Data File to be updated. 
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Data File Properties 

 

The Data File Properties dialog allows you to see all the properties associated with 
the Data File. There is only a General Tab available, although some properties only 
appear if the Data File is based on a Database source. 

You can use one of the following methods to access the Data File Properties Dialog: 

1. Double click on the Data File node in the Data Source Manager 

2. Right click on the Data File node in the Map File Manager and choose 
Properties. 

 

General Tab 

The General Tab displays basic information about the data file. 

 

Data File Name: This is an editable property. You can specify any name you want 

for the data file. To edit the name, type in the name box. Names must be unique 
within the Data Source Manager. 
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File Path: The path to the source file for the data. 

Source Type: The type of the data file. One of the following: 

 MapInfo Table 

 ESRI Shape File 

 ESRI Personal Geodatabase 

 CSV 

 Text File 

 Excel File 

 Database Connection 

Identifier Column: This is an editable property. You can specify the column that 
contains the unique identifier to bind the data. If the column does not actually 
contain unique values for each record, you will not be able to select the column as 

the Identifier column. 

Metadata (Sources): This field is available to enter Metadata on each Mapfiles. 
The field supports text and hyperlinks. 

NOTE: The unique identifier column will be used to link the data values in the Data 

File to features in a thematic layer via that layer’s unique identifier column. Make 
sure that when you are publishing data, the unique identifiers in both the Map 

Layer and the Data File match, or no data will be published by the data publisher. 

The following properties will only appear if the Data File is based on a Database. 

RDBMS: Identifies the type of database. Currently only Microsoft SQL 2008 is 
supported. 

Server: Identifies the Server address of the database. 

Database: Identifies the specific database  that is being used. 

Table: Identifies the specific table or view in the database that is being used. 

SQL: Identifies the SQL statement used to generate the columns for the Data File. 



Managing Your Data 

171 

 

 

Data Column Actions 

 

- When you right click on a Column of a Data File, a contextual menu is displayed. 

  

- Set as Unique Identifier Column: This option allows you identify this column as 
the unique identifier column for the data file. 

NOTE: a data file cannot be used in the data publisher unless a unique identifier 

column has been set. 

- Properties: This option allows you to see the properties associated with a specific 
Column. See section Data Column Properties for more information. 
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Data Column Properties 

 

The Data Column Properties dialog allows you to see all the properties associated 
with a single column within a Data File. 

You can use one of the following methods to access the Data File Properties Dialog: 

1. Double click on the column node in the Data Source Manager 
2. Right click on the column node in the Map Source Manager and select 

Properties. 

 

Column Type: The type of data this column contains. The type of column affects 
the types of thematic that are available in the CartoVista viewer. The types of 

columns available are: 

 Unknown 

 String 

 Float 

 Integer 

 Byte 

 Date/Time 

Description: A user provided text description of the column. 

Label: A user editable label for the column. 
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Name: The name of the column from the source data file. 

Precision: A user editable setting for how many digits of precision will be provided 
in the data publisher when the column type is FLOAT. 

Source: A user editable setting for a description of the source of the data. 

Source Column Index: The index of the column from the source data. 

Source Column Name: Name of the column from the source data. 

Source Column Path: The full path to the source data file. 

Time Stamp: A user editable setting for a time stamp value. 

Time Stamp Type: A user editable setting for the type of time stamp used. The 
types of time stamps are: 

 None 

 Year 

 Day 

Units: A user editable setting for a description of the units. 
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Browsing Data File Data 

 

Browsing your Data File data allows you to see the column values for each of 
records in the data file. 

You can create a new Browser Window from your Data Files using one of the 
following methods. 

1. In the Data Source Manager, select one or more Data Files, right click and 

select “Browse…”. 

2. In the Data Source Manager, select one or more Data Files. Drag and drop 
the Data File(s) into the main application window. 

 

TIP: You can use the column headings to sort records in the table. 
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Stylizing your Map Files 

 

The CartoVista Publisher includes many options to help you manage the 
cartographic styles of your maps in an easy way. The support for drag and drop will 
simplify your work when assigning styles to the values in your map files. 

Having a style library is also a great way to define standard map styles and color 
schemes and apply it consistently. In addition to the typical polygon, polyline and 
symbol styles, the CartoVista Publisher includes the ability to define map label 

styles for all features. This is very useful to create a set of unique reusable styles. 

Getting started quickly with styles: 

 The Style Manager helps you create or edit current styles. 
 The Polygon, Polyline, Point and Font Style dialogs are used to define the 

properties of each style. 
 The Assign Styles to Features Dialog helps you associate styles with values in 

your map files. 
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The Style Manager 

 

Style Manager 

The Style Manager is designed to help content creators work with their map styles. 
To display the Style Manager Window: 

From the menu bar, select View -> Style Manager 

The Style Manager allows you to create an unlimited library of reusable styles. Each 

style in the manager can be saved with its own parameters and labeling settings. 
Having the Style Manager helps you organize and name the usual styles you work 
with. 

 

The Style Manager introduces 4 types of styles: 

 Polygon Styles 

 Polyline Styles 

 Point Styles 

 Font Styles 
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Each style in the Style Manager includes a name, an icon that identifies the style 
graphically and the label which is shown with the appropriate font style. 

The Style Manager includes a contextual menu to manage each individual style. 

 

  

To access the menu, double- click or right-click on a style: 
  

 Click on Create Copy to create a copy of the style. 

 Click on Delete to delete the style from the library. 

 Click on Save to Disk to save this style to your hard drive and share it. 

 Click on Properties to modify the style. 
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Adding New Styles 

 

You can use one of the following methods to add new styles to the Style Manager. 

Within the Style Manager 

 Right-click in the Style Manager 

 Select the menu "Add New Style..." 
 Choose the type of style you would like to add 

 Click on OK 

file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
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Polygon Layer Styles 

 

Polygon Style Properties Dialog 

 

The polygon style properties are used to specify the settings used to fill and stroke 

polygon layer features. 

Style Name 

Specifies the style name. Enter/modify the text in the text box to change the style 
name. 

Polygon Style 

This section displays the various properties that make up the polygon’s style. 

Fill Style 

This line controls how the fill of the polygon is drawn. There are five ways in which 

the fill can be drawn: 

1) None 

No fill is drawn for the polygon. 
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2) Solid 

The fill is a single color, selected using the color button next to the drop down. 

 

3) Linear Gradient 

The fill starts as one color and gradually changes to a second color from left to 

right. The start and end colors are selected using the two color buttons next to the 
drop down. 

 

4) Radial Gradient 

The fill starts as one color and gradually changes to a second color starting at the 

center of the polygon and progressing outwards. The start and end colors are 
selected using the two color buttons next to the drop down. 

 

5) Pattern 

A single color is used as a background, while a pattern in a second color is drawn 

over top. The background color is selected using the first color button next to the 
dropdown and the pattern color is selected using the second color button. 

 

The following patterns are available: 
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NOTE: This fill type is only valid when creating Tile Maps. If this fill type is selected 
in a normal Map Window, the fill type behaves as if it was set to Solid. 

Stroke Style 

This line controls how the stroke of the polygon is drawn. There are four ways in 
which the stroke can be drawn: 

1) None 

No stroke is drawn for the polygon. 

 

2) Line 

The stroke is a solid line. The color is selected using the color button next to the 

drop down. 

 

3) Dashed 

The stroke is a dashed line. The color is selected using the color button next to the 
drop down. The dash pattern is expressed by a series of alternating numbers 
(on/off) of pixel width in the edit box beside the color button. E.g. [pixels on] 

[pixels off] [pixels on] ... 
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To enter a pattern for your polygon stoke, simply type in the numbers separated by 

a space character in the pattern text box. 

4) Pattern 

The stroke is one of a preset number of patterns. The color is selected using the 
color button next to the drop down. 

 

The following stroke patterns are available: 
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NOTE: This stroke type is only valid when creating Tile Maps. If this stroke type is 
selected in a normal Map Window, the fill type behaves as if it was set to Solid. 

Stroke Width 

This line controls how the width of the stroke of the polygon is drawn. The Hairline 
option is a fine pixel stroke that displays with a minimum width. The Pixel Width 
options specify a specific pixel width for the stroke between 1 and 10 pixels. 

Label Style 

This section displays the various properties that make up the polygon’s label style. 
For more information, see the section on font styles. 
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Polyline Layer Styles 

 

Polyline Style Properties Dialog 

 

The polyline style properties are used to specify the settings used to stroke polyline 
layer features. 

Style Name 

Specifies the style name. Enter/modify the text in the text box to change the style 
name. 

Stroke Style 

This section displays the various properties that make up the polyline’s style. 

Stroke Style 

This line controls how the stroke of the polyline is drawn. There are four ways in 
which the stroke can be drawn: 

1) None 

No stroke is drawn for the polyline. 
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2) Line 

The stroke is a solid line. The color is selected using the color button next to the 
drop down. 

 

3) Dashed 

The stroke is a dashed line. The color is selected using the color button next to the 

drop down. The dash pattern is expressed by a series of alternating numbers 
(on/off) of pixel width in the edit box beside the color button. E.g. [pixels on] 
[pixels off] [pixels on] ... 

 

 

To enter a pattern for your polyline stoke, simply type in the numbers separated by 
a space character in the pattern text box. 

When using the dashed option, you also need to specify a dash pattern. 

4) Pattern 

The stroke is one of a preset number of patterns. The color is selected using the 
color button next to the drop down. 
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The following stroke patterns are available: 

 

Stroke Width 

This line controls how the width of the stroke of the polyline is drawn. The Hairline 
option is a fine pixel stroke that displays with a minimum width. The Pixel Width 
options specify a specific pixel width for the stroke between 1 and 10 pixels. 

Cap 

This option controls how the end of the polyline is drawn. There are four ways in 
which the cap can be drawn: 

1. Rounded: line extends slightly beyond the ends with a rounded 

extension 
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2. Square: line extends slightly beyond the ends with a square extension 

3. Butt: stops exactly at the end 
4. Triangle: line extends slightly beyond the ends with a triangle 

extension 

NOTE: This option is only valid when creating Tile Maps. If this stroke type is 
selected in a normal Map Window, the stroke type behaves as if it was set to Butt. 

Corner 

This option controls how corners of polylines are drawn. There are four ways in 
which the corner can be drawn: 

 

NOTE: This option is only valid when creating Tile Maps. If this stroke type is 
selected in a normal Map Window, the stroke type behaves as if it was set to Bevel. 

Label Style 

This section displays the various properties that make up the polyline’s label style. 

For more information, see the section on font styles. 
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Point Layer Styles 

 

The point style properties are used to specify the settings used to display point 
layer features. There are two different ways to define the point style: Font Symbol 
or Image Symbol. 

Style Name 

Specifies the style name. Enter/modify the text in the text box to change the style 

name. 

Point Style 

This section displays the various properties that make up the point’s style. 

Type 

This line controls the choice of a Font Symbol or an Image Symbol. 

Point Style Properties Dialog - Font Symbol 

 

Font 



Managing Your Data 

189 

The True Type font used to display the points. Only True Type fonts that are 
flagged as symbol fonts are displayed. The size of the symbol is set using the edit 

box next to the drop down. The color is selected using the color button next to this. 

Symbol 

The specific symbol from the font that will be used to display the point. 

Rotation 

The angle of rotation for the symbol. 

NOTE: This option is only valid when creating Tile Maps. In a normal Map Window, 

the rotation will always be 0. 

Effects 

This line controls the two types of effects that can be applied to the point symbol: 

1. Dropshadow: when enabled, creates a shadow effect for the point. The color of 

the shadow can be selected using the color button next to the drop shadow label. 

2. Halo: when enabled, creates a halo effect around the point. The color of the halo 
can be selected using the color button next to the halo label. 

Point Style Properties Dialog – Image Symbol 

 

Fill 
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This line controls the graphic image that will be used as the “fill” of the symbol. The 
drop down provides a list of all images added to the Style Manager for use as Point 

Styles. To add a new image, use the "plus button" next to the drop down. 

Roll Over 

This line controls the graphic image that will be used when the mouse moves over 
the symbol. The drop down provides a list of all images added to the Style Manager 

for use as Point Styles To add a new image, use the "plus button" next to the drop 
down. 

NOTE: This option is only valid when creating regular Maps. In a Tile Window this 

setting does not apply, and the Fill symbol will always be displayed. 

Stroke 

This line controls the graphic image that will be used as the “stroke” of the symbol. 
The drop down provides a list of all images added to the Style Manager for use as 

Point Styles. To add a new image, use the "plus button" next to the drop down. 

The stroke of a point style is colorized when the symbol is selected in the Viewer. In 
order to see the “fill” of the symbol, the image used as a stroke symbol should be 

transparent to allow the “fill” to be visible. 

Rotation 

This option controls the rotation for the point’s style (in degrees). 

Point Label Style 

The Label Tab allows to attach and specify label properties to a point style. For 
more information, see Font Styles. 
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Font Styles 

 

Font Style Properties Dialog 

 

The font style properties are used to specify the settings used to create labels for a 
layer’s features. 

The font style exists in each style, as well as a separate category of styles so that 
the other style’s label properties can be easily changed via drag & drop. 

Style Name 

Specifies the style name. Enter/modify the text in the text box to change the style 

name. 

Label Style 

This section displays the various properties that make up the label’s style. 

Font 

The True Type font used for the labels. The font style is set using the dropdown 
after the font name. Possible font styles are Regular, Bold, Italic, and Bold & Italic. 
The size of the font is set using the edit box next to the font style drop down. The 

color is selected using the color button at the end of the line. 

Effects 

This line controls the two types of effects that can be applied to the label style: 
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1. Dropshadow: when enabled, creates a shadow effect for the label. The color of 
the shadow can be selected using the color button next to the drop shadow label. 

2. Halo: when enabled, creates a halo effect around the label. The color of the halo 

can be selected using the color button next to the halo label. 

Background 

This line controls the background of the label. There are three ways in which the 

background can be drawn: 

1. None 

No background is drawn for the label 

2. Color 

A solid color is drawn behind the label Use the color button next to the drop down 
to select the color. 

3. Image 

A graphic image is drawn behind the label. Use the drop down to select any of the 

images that were added to the Style Manager for use as background images. 

NOTE: This option is useful to create road shields for example. 

Priority 

This line controls the priority for this label style. Priority ranges from 1 (low) to 10 
(high). Priority determines which labels are drawn first when labelling a layer. 
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Assigning Styles to Features 

 

The CartoVista Publisher is designed to make it simple to assign styles to features 
in a map file or a layer that is part of a working map. You can either use the drag 
and drop capabilities or the Assign Style dialog to do this. 

Assign Styles using Drag and Drop 

To apply a specific style to a map file or a map layer, simply expand the style with 
the expand button  in the tree view. Then drag the style you want to apply into 
the target layer / map file style. The style is applied and showed on the map if this 

is a map window. 

Assign Styles Dialog 

This dialog allows the user to easily assign styles to features in a map layer. To 

access this dialog: 

 Right-click on a map file in the Map Source Manager and select Assign 
Styles 

 Right-click on a layer in the Layer Control and select Assign Styles 

A map layer or map file can be setup with multiple styles, based on values in a 
specific column . To setup the column used to define styles, see Map File Style 
Settings. 

 

file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
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To assign a style, select a style from the Styles list box. Next, select one or more 
identifiers from the Unique Identifiers list box that you want to assign the style(s) 

to and click on the << button. The style is assigned to the value and displayed in 
the left list. You can also drag & drop a style directly from the right hand list onto 

an identifier in the left hand list. 

Use default style for unassigned unique identifiers option 

Use this option to apply the default style to unassigned identifiers. 

Clear 

Use this button to remove assignments from the styles selected in the Unique 

Identifiers list. 

New Style 

Click on the "New Style..." button to create a new style. 
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Managing Coordinate Systems 

 

The CartoVista Publisher is designed to read coordinate information from GIS map 
files and make the coordinate system management as easy as possible. Drag and 
drop operations make coordinate system change very easy. 

The Coordinate System Manager contains predefined coordinate systems as well as 
the ability to import and define new coordinate systems from recognized and 
standard GIS projection parameters. 
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Coordinate System Manager 

 

Map Files and Coordinate Systems 

Each map file has a corresponding coordinate system. The CartoVista Publisher 
automatically detects the map file coordinate system if available. This is the case 

for MapInfo tables and ESRI Shape with .PRJ files. 

Get Information on the Coordinate System of a Map File 

To get information about a file coordinate system, click on the map file and select 
Properties. The coordinate system information is displayed in the General Tab of the 

Map File Settings and Properties Dialog. 

Default Map Coordinate System 

By default, when you create a map with the CartoVista Publisher, the first layer in 

the map defines the coordinate system of the map window. 

Predefined Coordinate Systems 
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The Coordinate System Manager comes with over 21 coordinate system categories, 
containing more than 1400 coordinate systems. Each category can contain one or 

more coordinate systems.  The predefined coordinate system range from world 
projections to local coordinate systems. To get specific information about a 

coordinate system in particular, select it from the list and click on the Properties 
menu. 

Coordinate System Properties 

To access this dialog, click on a coordinate system name in the Manager and select 

"Properties". The Coordinate System Properties dialog is displayed. 
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Each of the coordinate system parameters (projection, datum, false easting, false 
northing, units, etc) is displayed in the dialog tree view. 

Customizing and Changing Coordinate Systems 

 To create a new coordinate system, see Defining new Coordinate Systems 
 To import coordinate system from existing GIS definitions such as MapInfo, 

Well Known Text (WKT), EPSG codes or ESRI.PRJ files, see Importing 
Coordinate System. 

 To modify a map coordinate system, see Changing a Map Coordinate System. 
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Defining New Coordinate Systems 

 

The CartoVista Publisher includes the ability to create new coordinate systems by 
importing standard GIS coordinate system definitions. You can choose of the 
following methods to define the coordinate system parameters and import it in the 
Coordinate System Manager. 

 MapInfo Coordinate System Expression 
 OGC Well Known Text 
 PROJ4 Coordinate System Expression 

 EPSG Code 
 ESRI PRJ Coordinate System Expression 
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Importing Coordinate Systems 

 

To import a coordinate system, click on one of the existing categories and choose 
one of the methods below. 

Importing from MapInfo Coordsys Clause 

 

MapInfo stores its Coordinate System Clause in a string that defines all of the 
coordinate system parameters. For information on the MapInfo Coordsys Clause, 

see the MapBasic Help. 

To import a MapInfo Coordinate System Clause: 

 Enter a category in the text field 
 Enter a name in the text field 

 Enter the Coordinate System Clause (MI Coordsys) in the text field 
 Click on OK 

Importing from an ESRI PRJ Projection 

 

ESRI Shapes use files with the .PRJ extension to store coordinate system 
parameters. 

To import an ESRI PRJ coordinate system: 

 Enter a category in the text field 

file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
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 Enter a name in the text field 
 Enter the PRJ file path in the text field 

 Click on OK 

Importing from EPSG Codes 

It is very common in GIS to define projections using the European Petroleum 

Survey Group (EPSG) codes. 

 

To import a coordinate system by EPSG code : 

 Enter a category in the text field 
 Enter a name in the text field 

 Enter the EPSG code in the text field 
 Click on OK 

Importing from PROJ4 

 

To import a coordinate system by PROJ4 : 

 Enter a category in the text field 
 Enter a name in the text field 
 Enter the PROJ4 string in the text field 

 Click on OK 
  

Importing from Well Known Text (WKT) 

file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
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To import a coordinate system by WKT: 

 Enter a category in the text field 
 Enter a name in the text field 

 Enter the WKT string in the text field 
 Click on OK 
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Changing a Map Coordinate System 

 

Changing the Map Coordinate System by Drag and Drop 

Drag a coordinate system from the Coordinate System Manager into the map. 

Changing the Map Coordinate System from the Map 
Settings Dialog 

 

The text displayed in the projection group box will depend on your settings in the 

Tools > Preferences > Projection Settings dialog. 

If you have checked the “Display Projection Name if Available”, the Category and 
Projection name will be displayed. The category name will be enclosed in square 

brackets (‘[‘ and ‘]’) while the Name will be displayed on the row below. 

If the projection has not been given a category/name, the name will be “Unnamed”. 
This simply means that there is no human-attributed text associated with that 

particular projection. 
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If you have not checked the “Display Projection Name if Available”, the projection 
will be displayed in either the Proj4 format, or the Well Known Text (WKT) format. 

For more information on Proj4, see http://trac.osgeo.org/proj/. 

Click on the "Set..." button to display the Coordinate System Selection dialog and 
choose a coordinate system. See Coordinate System Selection Dialog for more 

information. 

 

http://trac.osgeo.org/proj/
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Coordinate System Selection Dialog 

 

The Coordinate System Selection dialog allows you to select a coordinate system 
from the many coordinate systems that are available. The CartoVista Publisher 
ships with over 21 coordinate system categories that contain more than 1400 
coordinate systems. More coordinate systems can be added by the user. 

 

Category: A group of coordinate systems. This dropdown lists all the categories 

that are present in the Coordinate System Manager as the top level nodes. 

Coordinate System: A specific coordinate system. This lists all the individual 
coordinate systems that are part of the selected category. 

NOTE: Double clicking on a coordinate system in the Coordinate System list will 

open the Coordinate System Properties dialog to display the properties of that 
particular coordinate system. 

The names given to each category and/or coordinate system are designed to assist 
users in selecting the correct Coordinate System to use. Users are free to name 

categories and coordinate systems in any manner they choose. For example, a 
category may be called “Company Projections” and the coordinate systems within it 

may be called “Project1”, “Project 2” etc. 
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Creating Maps for CartoVista 

 

The CartoVista Publisher’s primary focus is to assist you in creating the map you 
need to deploy with your CartoVista solution. 

You can either create a new map, or open an existing map.  Once you have created 
the map you want, publish your map to create the files needed for deployment to 
the CartoVista solution. Saving the map creates a map definition in a .CVM file that 

can be reopened later. 

Here are the topics of this chapter: 

Creating Maps for CartoVista 

 Creating a Map Window 

 Layer Selection Dialog 
 Adding Tile Layers to a Map 

 Importing MapInfo Workspace (.MWS) 

The Map Window 

 Main Toolbar 

 Map Toolbar 
 Map Window Menu 
 Map View Settings Dialog 

 Map Settings Dialog 
 Viewer Configuration Dialog 

The Layer Control 

 Changing Map Layers 
 Layer Actions 

 Managing Missing Data 
 Layer Properties 
 Setting Legend Options for Map Layers 

 Publishing a Map 
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Creating a Map Window 

 

You can create a Map Window from an existing .CVM file using one of the following 
methods: 

1. Open an Existing .CVM file 

From the main menu, select File > Open menu option. A dialog will prompt 
you to locate the .CVM file that defines the map. Once you have selected a 

.CVM file, a Map Window will open as defined in the .CVM. 

2. Drag & Drop an existing .CVM file 

You can drag and drop a .CVM file from Windows Explorer onto the main 
application. This will open a Map Window as defined in the .CVM. 

3. Double-click an existing .CVM file 

You can double click a .CVM file from Windows Explorer. This will start up the 

Publisher and automatically open the Map Window as defined in the .CVM. If 
the Publisher is already running, the Map Window will open in the Publisher 

without starting a new instance. 

NOTE: CartoVista Publisher 4.1.1 can open any .CVM created with any previous 
version of the CartoVista Publisher. However if you save the map from CartoVista 
Publisher 4.1.1, you will not be able to use the .CVM with a previous version of the 

Publisher. 

You can also create a new Map Window using one of the following methods: 

1. From the Main Menu New option 

In the Main Menu, click on File > New Map…. For more information on the rest 
of the process see Layer Selection Dialog. 

2. From the Map Source Manager shortcut menus 

Right click on one or more Map File nodes. From the context menu, select 
“Create Map Window”. 
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Right click away from Map File Nodes. From the context menu, select “New 
Map Window..”. For more information on the rest of the process, see Layer 

Selection Dialog. 

Right click on a Folder Node. From the context menu, select “Create Map 
Window”. This will create a map from all the Map Files within the folder and its 

sub-folders. 

3. Drag & Drop from the Map Source Manager 

Select one or more Map Files. Drag and drop the map files into the main 
application window. A new Map Window will be created from the map files you 

have selected. 

Select a Folder node. Drag and drop the folder node into the main application 
window. A new Map Window will be created from all the Map Files within the 

folder and its sub-folders. 

4. Drag & Drop existing Map Layers(s) 

In an existing Map Window, select one or more Layers from the Layer Control. 
Drag & Drop the layers into the main application window. A new Map Window 
will be created based on the layers you have selected and the map you 

dragged them from. 

5. Press F2 

Pressing F2 at any time will start the creation of a Map Window. For more 
information on the rest of the process, see Layer Selection Dialog. 

6. Convert from a Tile Window 

When a Tile Window is the active window, in the Main Menu, click on File > 
Convert To > Map Window. A file save dialog will prompt you for a name to 
save the new .CVM as, and then the Map Window will open based on the 

existing Tile Window. 

NOTE: If you include a TILE layer in your map window, you will be alerted via a 
dialog to the Terms of Use of that Tile Layer. You will have to click “I Accept” to 

include that layer in your map. You may also have to enter a key from the tile 
provider as well. For more information see section Adding Tile Layers to a Map 
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Layer Selection Dialog 

 

The Layer Selection Dialog allows you to select the layers to appear in the map, 
their order, and set the name of the layer to something other than the name of the 
Map File. 

 

You can access the Layer Selection Dialog using one of the following methods: 

1. While creating a new map from the Main Menu 

From the main menu, select File > New Map. 

2. From the Map Source Manager 

In the Map Source Manager, right click on a Category node, or outside of an 
existing node. From the context menu, select “Create Map Window…”. 

3. From the Layer Control 

In the Layer Control, right click on the root Layer Control node. From the context 
menu, select “Select Layers”. 

Adding Layers 

 Select one or more map files from the left list box and click on the Add >> 
button to add it to the map. You can also double-click on a layer in the map 
files list. 
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 Layers will be inserted into the Map Window list layers depending on their 
layer type, and the existing set of layers in the list. Text layers will be put 

above a layer of any other type, while points will appear above the first 
polyline layer, polylines above the polygon layers and raster images at the 

bottom of the list. 

Removing Layers 

Select a layer from the right list and pick the << Remove button to remove it from 

the map. You can also click and drag layers up and down within the Map Window 
list. 

Reorder Layers 

Select a specific layer and click on the Move Up / Move Down buttons to change the 

map layers order. 

Layer Names 

Layers will be added to the Map Window list named the same as they were found in 

the map files list. However if you add a layer to the Map Window list more than 
once, the layer name that will be used will appear besides the map file name with 

parenthesis {}. 

You can change the name of a layer by right-clicking on the layer in the list on the 
right. This will bring up a menu option called "Edit Layer Name…". Select this menu 

option to bring the Set Layer Name dialog. 

Set Layer Name Dialog 

The Set Layer Name dialog allows you to set the name of a layer in the Map. 

 

Layer Name: The name of the layer in the map window. This name must be 

unique within the map layers. 

NOTE: By default, a layer is named the same as the Map File you use to create the 
layer. If you use a Map File multiple times, the layer name will automatically have 

an underscore (“_”) and a number appended to the end of the layer name. 
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Adding Tile Layers to a Map 

 

Any time you add a Tile Layer to a Map, you will be alerted via a dialog to the 
Terms of Use and the Copyright of that Tile Layer. The Terms of Use are set by the 
creator/owner of that set of tiles. It is your responsibility to ensure that you have 
read the terms of use, and that you have permission to include that Tile Layer in 

your map and that it conforms to the Terms of Use. 

 

Some Tile Layers will require you to enter a key obtained from the creator/owner of 
that set of tiles. Enter that key in the Key: field in the dialog to ensure the key is 

properly published to the map. 

If you do not agree with the terms of use, click the Cancel button, and the Tile 
Layer will not be added to the Map. 

Tile layers are unlike other layers, in that multiple tile providers can all be added to 

a single tile layer. The map creator is able to select which will be the default tile 
provider used when the map is displayed, but the end user can change this to any 
of the tile providers available. 

When a Tile Layer is added to a Map, the layer is automatically called “Tile Base 

Map”. This name can be changed in the Layer Properties dialog, General Tab.  The 
tile provider that was added appears as a sub-node underneath the layer node. 
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Additional Tile Providers can be added via Drag & Drop by selecting a tile provider 
from the Map Source Manager and dropping it onto the Tile Base Map node. You 
can only add each tile provider once. 

The currently active tile provider will have an open eye besides its name. You can 
change to another tile provider by clicking on the closed eye next to it. 

 

The Layer Properties dialog will display a special tab for Tile Layers that allow you 
to manually select the tile providers and the active tile provider. See section Layer 

Properties for more information. 
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Importing MapInfo Workspaces (.MWS) 

 

The Publisher has the capabilities of importing MapInfo Workspaces, stored with the 

MapInfo Workspace Format (.MWS). This functionality has the following 
advantages: 

 Boost the MapInfo Professional user productivity and workflow by leveraging 
their existing workspaces (map files, styles, zoom layering, etc.); 

 Allow MapInfo Professional users to use a GIS environment they are already 
familiar with to create and setup their maps. 

 

MapInfo Workspace Format (.MWS) 
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Since MapInfo Professional Version 8.0, users can save their workspace in the MWS 
format. To save your map window in the MWS format in MapInfo Professional: 

1. Select the menu File - > Save Workspace 

2. From the dialog box, pick the MapInfo Workspace Format (.MWS) in the Save 
as type option. 

Importing a MapInfo Workspace (.MWS) 

To import a MapInfo workspace in the CartoVista Publisher: 

1. Select the menu File - > Open Map 
2. From the files of type dropdown in the file open dialog, select the MapInfo 

Workspaces (.mws) option 
3. Browse to your computer and select the .MWS file you wish to import 

4. Click on OK 

The corresponding map is created in the CartoVista Publisher. 

Support Notes 

Map layers retain their visibility, zoom layering and labelling settings. 

Style Handling 

 Style modified on layers are converted to their corresponding default styles 
in the CartoVista Publisher 

 Styles of individual values themes are converted to layer classes (multiple 

styles) in the CartoVista Publisher 

Other Restrictions 

 Only MapInfo native layers are supported (native .tab files) in the import 

process. 
 Range, pie chart, bar chart, graduated symbols and dot density thematic 

layers are ignored 

 Some of the styles available in the map may be mapped to regular styles in 
the CartoVista Publisher. For example, fill patterns will be mapped to normal 

(solid) colors. 

Logging 

When importing a workspace, a Log.txt file is created in the folder where the 
workspace resides. The Log file contains information about the conversion and 

potential unsupported nodes in the XML. 
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Sample Log.txt file 

INFO - Starting the process 

INFO - Reading DataSourceDefinitionSet 
INFO - Reading TABFileDataSourceDefinition 

INFO - Reading MapDefinitionSet 
WARN - Unsupported node:DisplayConditions.ResizeMethod 
WARN - Unsupported node:DisplayConditions.RasterConditions 

INFO - Reading LayerList 
INFO - Reading FeatureLayer CAN_Provinces 

WARN - Unsupported node:MapDefinition.MapLegendSet 
WARN - Unsupported node:WorkSpace.MapinfoApplicationData 
INFO - Process ended successfully 

INFO - Starting the process 
INFO - Reading DataSourceDefinitionSet 

INFO - Reading TABFileDataSourceDefinition 
INFO - Reading MapDefinitionSet 
WARN - Unsupported node:DisplayConditions.ResizeMethod 

WARN - Unsupported node:DisplayConditions.RasterConditions 
INFO - Reading LayerList 

INFO - Reading FeatureLayer CAN_Provinces 
WARN - Unsupported node:MapDefinition.MapLegendSet 
WARN - Unsupported node:WorkSpace.MapinfoApplicationData 

INFO - Process ended successfully 
INFO - Starting the creation of the map window 

INFO - Layer creation done successfully 
INFO - Map window creation done successfully 
INFO - Write done successfully 
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The Map Window 

 

The CartoVista Publisher Map Window visually displays the map files which 
comprise the map with their associated styles and settings applied 

The Map Window is composed of the following 4 parts: 

Map Display 

Displays the map as determined by the layers selected and the style and other 

settings applied to each layer. 

Main Tool Bar 

A toolbar containing options for actions that will be performed with the map. 

Map Tool Bar 

A toolbar containing options for navigating and altering the map. 

Layer Control 

Lists the layers present in the map and allows the user to adjust the settings used 

for each layer. 
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Main Toolbar 

 

Save Button 

 

The Save Configuration button saves your current map to a .CVM file. 

When you save a .CVM file, you are saving the settings, layout and other attributes 
needed to recreate the map window. You are not saving the underlying GIS files, 
simply a reference to where they are located. 

If you want to give someone a copy of your map, ensure they already have the GIS 

files loaded into CartoVista Publisher with the same names, or include the source 
GIS files in the package you transfer so they can add them. 

Publish Button 

 

The Publish button will publish the current map with the existing settings without 
any user interaction. If you want to change the publish settings, click on Publish 
Options button. 

NOTE: If you have not previously published the map and set the map output name, 

the Publish Options Dialog will be displayed so that you can set the map output 
name. 

Publish Options Button 

 

Click on the Publish Map button once you are ready to publish your CartoVista 
map. The button then displays the Publish Options Dialog so that you can specify 

the map output name and folder output. 
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Viewer Configuration Button 

 

The Viewer Configuration button will display the Viewer Configuration Dialog so 

that you can set up the CartoVista Viewer which will be used to display the 
published map. 

Themes Configuration Button 

 

To assist in configuring the published CartoVista map, the Themes Configuration 

button allows you to interact with your published Map and setup the default themes 
for the initial view of the map. 

The Themes Configuration button will open a new window in the Publisher that 

contains the Adobe Flash player, which will display the published map. Add the 
appropriate theme(s) to your map until you are satisfied and then click the “Save” 
button. This will update the configuration file so that the current theme set will be 

loaded by default when the map is viewed. 

If you have not yet published your map, this button will not be active. 

Print Configuration Button 

 

It is possible to configure print templates for every map deployed in CartoVista. The 

Print Configuration button allows you to setup the content of those templates and 
define the default one. It will open a new window in the Publisher that contains the 
Adobe Flash player, which will display the published map. Create the appropriate 

print templates by selecting which items should be displayed in the templates, and 
the level of interaction you decide to give to the end user. 

You will be able to visualize the results of your configurations directly in the dialog. 

When you are done, you just need to "Save" your templates in your cvm, and 
"Publish" them in the configuration file. 

If you have not yet published your map, this button will not be active. 
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Open HTML Button 

 

The Open HTML button will open your default browser and open the published map 
in the browser. 

If you have not yet published your map, this button will not be active. 

This button now includes additional options, available by cliking on the right side 

arrow. 

 

Map Folder: this menu opens the published map folder. 

Map Configuration: this menu opens the published map XML Configuration File. 

Create ZIP: this menu creates a ZIP File including the published map and all files 

required to deploy on a web server. 
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 Map Toolbar 

 

Map Navigation Tools 

Zoom-In Tool 

 

Display a closer view of the map. 

Use this tool to display a closer view in the current map. 

 Select this tool from the tool bar. 
 Click on the map to zoom-in. 
 The map is zoomed-in by a factor of 2. 

TIP: You can also draw a rectangle on the map (click and drag) to closely define the 

area you want to zoom to. 

Zoom-Out Tool 

 

Display a wider view of the map. 

Use this tool to display a wider view in the current map. 

 Select this tool from the tool bar. 
 Click on the map to zoom out. 

 The map is zoomed-out by a factor of 2. 

Pan Tool 

 

Recenter the map. 

Use this tool to re-center the current map. 

 Select this tool from the tool bar. 
 Click and drag the map to recenter. 
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 Once the map is recentered as you need it, release the mouse. 

Previous View Tool 

 

To display the map from the previous view. 

Use this tool to display the previous view from the current map view. 

 Select this tool from the tool bar. 

 Click on the tool. 
 The view comes back to the previous zoom level. 

Change View Tool 

 

Change the current map view by entering coordinates. 

The Change View tool is used to access the Change View Dialog to set the view of 

the Map. 

View Entire Layer Tool 

 

Set the map view to the extent of a map layer. 

Use this tool to access the view entire layer dialog to set the map bounds to the 

extent of a specific layer. 

View Entire Layer Dialog 
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To set the map view to all layers in the map window, select <<ALL LAYERS>>. 

To set the map view to a specific layer, select it from the list and click on the Zoom 
button. 

  

Map Settings Tool 

The Map Settings tool is used to access the Map Settings dialog to set the title, 
coordinate system and dimension (width and height) of the map. For more 

information on map settings, see the Map Settings Dialog. 

Scale / Width Display 

Depending on the application preference setting, either the map scale (e.g. 1: x) or 
the Map Width (e.g. x Kilometers) will be displayed after the Info tool. 

Info Tool 

 

Use this tool to get attribute information about map features. 

Select this tool from the tool bar and click on a map location. The info tool window 

displays a list of all objects at the location of the click. 

Info Tool Window 
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If you have only selected a single object from the map, the field names and values 
for that object are displayed. If the location you clicked has multiple objects (same 
layer or different layer) the Info Tool window displays a list of objects at the top of 

the dialog. Selecting the different objects updates the fields/values to the selected 
object. The status bar at the bottom tells you exactly how many objects have been 

selected from how many layers in the Map Window. 
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Map Window Menu 

 

The Map Window Menu is in the main menu and is only active when the map 
window is open. 

Layer Selection 

Opens the Layer Selection Dialog. See section on Layer Selection Dialog for more 
information. 

Change View 

Opens the Map View Settings Dialog. See section on Map View Settings Dialog for 
more information. 

Previous View 

Returns to the Map Window to the previous zoom/scale and location. If you have 
not moved/panned or otherwise changed the view of the map, this has no effect. 

This option is also available in the popup menu available when you right click in the 

Map Window. 

View Entire Layer 

Opens the View Entire Layer Dialog. If you have only one layer in the Map window, 
the Map Window automatically zooms to the extents of that layer. 

Settings 

Opens the Map Settings Dialog. See section on Map Settings Dialog for more 
information. 

Save Map Window As 

This option allows you to save the current map as a raster image. 

Publish 

Automatically publishes your map using the existing settings. See section on 
Publishing a Map for more information. 
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Publish Options 

Opens the Publish Options Dialog. See section on Publishing a Map for more 

information. 

Themes Configuration 

Opens the Themes Configuration Dialog, in order to prepare the themesets that will 

show by default when opening the CartoVista application. 

Print Configuration 

Opens the Print Configuration Dialog, to let the user prepare the print templates. 

Open HTML 

Opens the default browser and opens the published map in the browser. If you 

have not yet published your map, this menu option will not be active. 
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 Map View Settings Dialog 
 

This dialog has three uses: 

 You can set the current map view by specifying a scale or zoom and with the 
map’s centroid or bounding coordinates; 

 You can also set the maximum view possible for the map by setting bounding 
coordinates. 

 You can set the zoom layering that applies to the whole map. 

This dialog can be accessed by choosing Map Window > Change View from the main 

menu, clicking on the Change View button in the Map Window’s Map Toolbar   or 

by right clicking in the map window and selecting Change View from the popup 
menu. 

Map View Settings Dialog 

 

Use Lat/Long Coordinate System Values Option 

Many of the edit boxes in this dialog require coordinates. The values entered will be 
in the coordinate system of the Map Window. However, if your map is projected to 
a coordinate system other than Latitude/Longitude, you have the option to set the 

coordinates using Latitude/Longitude anyway. 

Check the “Use Lat/Long Coordinate System Values”  checkbox at the bottom of the 
dialog box. All coordinate system values in this dialog will then be required to be 
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entered in Latitude/Longitude values. Uncheck this setting to return to the 
coordinate system units of the projection of the Map. 

If the map is already in a Latitude/Longitude projection, this checkbox will be 

disabled. 

For more information on coordinate systems, see section Managing Coordinate 
Systems. 

Current View 

 

The current view of the map window is determined by two factors. The scale of the 

map and the coordinates of the center of the map window. 

Map Scale / Map Width 

There are two methods to set the scale of the map: 

1. Using a Scale: A map scale is simply the ratio that compares a distance on a 

map to the actual distance on the ground. It is typically denoted as 1 : X, 
where 1 represents one inch on the map, and X represent how many inches 
in the real world. Small-scale maps (e.g., 1:10,000,000) typically depict a 

large area, such as a continent or a country. Large-scale maps (e.g., 
1:10,000) depict much smaller areas, such as a city block-level. 

2. Using a Map Width: Some users are more familiar with setting a map’s width 
to a specific distance. Specify the distance (e.g. 5 kilometers) that you wish 
the map to display, and the map will adjust its scale to accommodate the 

required distance. 
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Once the scale has been determined, set the center of the map by entering the X, Y 
or Latitude/Longitude coordinates. If the Map’s projection is “Latitude/Longitude”, 

you will only be able to set this by entering Latitude/Longitude values.  If the Map is 
projected to another coordinate system, the values will be in the X, Y units of the 

specified coordinate system. (Usually either meters or feet). 

Map Center 

Set the center of the map by entering the coordinates. 

Map Extents 

Set the bounds of the map by entering the coordinates of the bottom left and top 

right corners. Press the Set button to apply the coordinates to the map 
immediately. 

Maximum Extents 

 

The maximum extents determines how far out a user can zoom on the map. 
Normally these extents are set to the same value as the Current Extents that are in 

use when the map is published. The “Use Current Extents when Publishing” will be 
checked in this case. 

In some cases, you may wish to start with an initial view that is not the maximum 

extent. This allows users to zoom in or out from the initial appearance of the map. 
Uncheck the “Use Current Extents when Publishing” checkbox to allow a specific 

maximum extent to be set. 
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When you uncheck the “Use Current Extents when Publishing” checkbox, the 
Bottom Left Corner and Top Right Corner coordinate boxes become enabled. You 

can set these values to the specific maximum extent you wish the user to be able 
to zoom too. 

The “Set From Current Extents” button is a quick way to update the Bottom Left 

and Top Right corner settings. Set the map to the maximum extent you wish to be 
available to the user, and then click the “Set from current Extents” button to update 

the Bottom Left and Top Right corner settings appropriately. Clicking this button 
automatically un-checks the “Use Current Extents when Publishing” checkbox. 

If you wish to see what the maximum extent is actually set to, you can use the 
“Zoom to Maximum Extent” button to set the current view to be equal to the 

Maximum Extent. This button is not available when the Maximum extent is using 
the Current View setting. 

Zoom Restrictions 

 

Zoom restrictions set a minimum & maximum zoom when the Map is being viewed 

in the Viewer. These restrictions will prevent the viewer from zooming the map 
closer in or farther out than the values you have set. 
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Map Settings Dialog 

 

This dialog lets you set the title, dimensions and the coordinate system of the map. 

This dialog can be accessed by choosing Map Window > Settings from the main 

menu, clicking on the Settings tool button in the Map Window’s Map Toolbar    or 

by right clicking in the map window and selecting Map Window Settings from the 
popup menu. 

Map Title 

The map's title can be entered by typing in the text box at the top of the Map 
Settings dialog. 

  

The map title is displayed in the CartoVista map output, in the title section at the 
top of the map. Since unlimited themes can be created with external XML data in 

CartoVista, the best practice is to create a title that is a simple geographic 
description of the area covered for the map. For example, if you create a map of 
the United States (showing state boundaries), you should name your map USA. 

Size 
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In the CartoVista Publisher, the map size is defined in pixels. 

To enter a specific map size in pixels, enter values in the map size width and height 
text boxes. 

NOTE 1: If you resize the map window in the CartoVista Publisher, the width and 
height in pixels also change. To prevent accidentally resizing the window, you can 
Lock the Size of the Map Window. 

NOTE 2: Be careful when you use the "MAXIMIZE" button on the map window. 

Although the map window will take up as much space as available inside the 
CartoVista Publisher, the width and height setting when you publish the map will be 

what is set in the Map Settings dialog. This may be considerably smaller than what 
is displayed on the screen! 

The Lock Size option fixes the map dimensions when enabled. By default, 

CartoVista does not lock the map size. When you resize the map window in the 
publisher, the size of the map in pixels changes. When the Lock Size option is 
enabled, you will not be able to change the size of the map window. 

Window 

The Window section allows you to edit the settings that apply to the Map Window in 
general. 

  

Map Window Display Units 

This defines the units used to display linear information such as the map width. 
Choices are: inches, feet, miles, meters, kilometers. 
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Background Color 

This defines the color that is in the background of the map. Choose a color with the 

color picker. The default background color can also be specified in the Tools and 
Preferences Dialog - Map Window Settings Tab 

Show Scalebar in Map Window 

This checkbox allows you to display a scale bar in the bottom left corner of the Map 
Window. The scale bar will only show inside the Map Window. If you wish to display 
a scalebar in the final output map, use the Show Scalebar option in the Viewer 

Configuration Dialog. 

Projection 

The Projection section displays the currently selected coordinate system for the Map 

Window. 

  

The coordinate system information is dependent on the Publisher application 

settings. (see Tools and Preferences - Projection Settings) There are three ways 
that the information could be presented: Well Known Text (WKT), PROJ4, or a User 
Name. 

If you want to change the map coordinate system, you can click on the Set... 

button to display the Coordinate System Selection dialog and choose a new 
coordinate system. 
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NOTE 1: You can also change the coordinate system by dragging a coordinate 
system from the Coordinate System Manager and dropping it directly onto the Map 

Window. 

NOTE 2: If you have a Tile Server layer in your map window, you will not be able to 
change the projection. This is because the map needs to be in the same projection 

as the Tile Server in order for the map to appear correctly a line. 
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Viewer Configuration Dialog 

 

The CartoVista Viewer Configuration dialog provides a set of options to configure 

the CartoVista Viewer.  Customizable options include the tools that are available, 
the menu options and the language and additional map dialogs that are present. 

The dialog is accessed by clicking the  button in the Map Window. 

Map Toolbar Tab 

 

Map Toolbar Section 
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The  Map Toolbar Section allows you to define the tools that will be available in the 
CartoVista Viewer.   

The order that the tools appear in the list is the order they will appear in the 

CartoVista Viewer toolbar. 

To add a tool (or a spacer between tools), select the tool from the drop down list 
and click the “Add” button. 

Use the  button to remove a tool. 

Use the  button to move a tool down one row. You cannot move the tool in the 
list down. 

Use the  button to move a column up one row. You cannot move the first tool in 

the list up. 

List of tools: 

Icon as it 

will appear 
in the 

CartoVista 
Viewer 

Name of the Map Tool 

Icon 
Description 

 

 Zoom In Zooms in by 2x 

 

Zoom Out Zooms out by 2x 

 

Initial Extents Zooms to the initial map view 

 

Pan 
Lets the user drag the map up/down and 
left/right 

 

Previous View To display the map from the previous view 

 

Next View 
To display the next view (after clicking on 

Previous) 

 

Ruler Measure distances on the map 

 

Area Calculator 
Calculate the area of an object drawn on the 
map 

 

Info 
Opens an info dialog and displays information 

about any selectable 

 

Hyperlink 
Navigate to different when using a drill-down or 
access normal hyperlinks 

 

Selection 
Gives the user a choice of the available 

selection tools 

 

Unselect All Clears the current selection 
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Layer Control Opens the Layer Control dialog 

 

Search Opens the Search dialog 

 

Drawing/Annotation Opens the drawing/annotations toolbar 

 

Thematic Styles Opens the Thematic Styles dialog 

  Spacer Puts a small space between tool buttons. 

Toolbar Options Section 

Selected Tool: this drop down list is used to define which tool be selected by 

default in the toolbar when launching the CartoVista application. 

Tools Style: This dropdown determines the style for the buttons in the Map 
Toolbar. There are three options available: 

1. Small buttons with icon: 

 

(Published CartoVista Viewer output sample) 

2. Small buttons with icon and text: 

 

(Published CartoVista Viewer output sample) 

3. Large buttons with icon and text: 

 

(Published CartoVista Viewer output sample) 

Selection Tools 

The selection methods that are available to the Selection Tool in the toolbar. 

Selection Method: When using one of the selection tools that creates an area for 

selection, this dropdown determines if objects that intersect that area are selected. 

There are three options available: 
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1. Centroid: the centroid of the objects must be within the area of the 
selection tool to be included. 

 
2. Shape: some portion of the object must be within the area of the selection 

tool to be included. 
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3. Bounding Box: the enclosing bounding box of the object must be within the 
area of the selection tool to be included. 

 

  

Selection Stroke Color: Check this option to enable a selection stroke color effect. 
Whenever an object is selected, the object’s stroke will turn the color selected from 

the color selection button. 

NOTE: Some objects do not have a stroke associated with them. E.g. Point objects, 
Text Objects. In such cases, there will be no effect. Some objects only have a 

stroke associated with them. E.g Polyline objects. 

There are four different methods of selecting objects that can be available: 

1. Simple Selection : Allows you to click on the map and select one object. 

2. Rectangular Selection : Allows you to click and drag on the map to 
create a rectangular area for selecting objects. 

3. Circular Selection : Allows you to click and drag on the map to create a 
circular area for selecting objects. 

4. Polygonal Selection : Allows you to draw a polygon on the map to 

create an area for selecting objects. 

Check all the selection methods that you wish to be available. When you click on 
the selection tool in the toolbar, an additional toolbar will display allowing you to 
select the specific selection tool to use. 
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In addition, the dropdown at the beginning of the selection toolbar lets you pick 

which layer the selection will be from. 

While making a selection, you can hold the SHIFT or CONTROL key down to add 
additional objects to the selection. You can even change the selection tool and 
continue to add objects to the current selection using the SHIFT or CONTROL key. 

Pan Tool 

Use Inertia Panning: When this box is checked, this option adds visual effects 
when panning on the map. 

General Interface 
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This tab is used to define the configuration referring to the CartoVista application 
general interface. 

Top Menu Bar 

The top menu bar is the right hand part of the title bar that appears to the right of 

the  symbol. (Click on the arrow to hide the top menu bar.) 

Check all the options that you wish to be available in the top menu bar. 

Several menus and buttons can be added to the Top Menu Bar that is displayed at 

the top right corner of the application. 

 

The following options will appear under the  menu: 

Add Thematic Analysis Menu: Adds a new thematic analysis to 
one of the interactive layers in the map. An Add Thematic Analysis Dialog is 

displayed to choose the indicator(s) to display and the representation method. 

Add New Chart Menu: Add a new chart. An Add Chart Dialog is 

displayed to choose the layer and indicator(s) to use to create the chart 

Add New Data Table Menu: Adds a new data table. An Add New 

Data Table Dialog is displayed to choose the layer, attributes and indicators. 

Add Annotation and Drawing Tools: Adds the annotation and 
drawing toolbar, to add drawings and annotations on the map. 

After choosing this option in the drop down list, the following toolbar is available 

below the standard toolbar: 

 

The following options will appear as their own button in the Top Menu Bar: 

 Save and Print Menu: Saves the current map or prints itA Save 

and Print Dialog is displayed to choose different output options (print, PDF or PNG). 
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If print templates have been prepared, they will be available after clicking on this 
button. 

Language Button: Chooses the language for the user interface. 

Help Button: Provides access to the built-in HTML help system. 

Full Screen Button: Switches to a full screen view of the map. 

About CartoVista Button: Displays the CartoVista About Dialog. 

Language 

Available: Lists the current supported languages available for CartoVista. By 

selecting a language in this list, it can be selected as the default language and will 
appear as a choice when the user clicks on the Language Button in the Top Menu 

Bar. 

Startup: Sets the language selected by default when the map is first displayed. 
The list of languages is based on the languages selected in the Available Languages 

list. 

Info Window 

Determines if coordinates are displayed at the top of the info tool window when you 
click on the map. 

Show Decimal Coordinates:  Coordinates are displayed with decimal precision. 

Show Degree/Minute/Seconds: Coordinates are displayed in Latitude/Longitude 
in Degree/Minute/Seconds format. 

Legend Settings 

The first two check boxes will defined how to display some additional information 

about the data in the legend: 

- Show N/A Values: to display in the legend an additional color for the objects for 
which there is no data available in the dataset. Additional parameters can be 

defined in the indicator properties to set which value should be considered as being 
not available. 

- Show Out of Range Values: to display the objets for which the indicator value falls 
outside the ranges of values defined for the displayed theme. 
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The other checkboxes will define which functionalities will be available through the 

Settings menu  accessible from the legend. 

Thematic Definition: To open the dialog to edit the content of the 

thematic. The user can modify the thematic analysis displayed on the map. 

Edit Styles: To open the dialog used to change the thematic styles. 

Remove: To remove the thematic analysis from the map. 

View as Chart: To view the indicator in a chart. 

View as Data Table: To view the indicator in a data table. 

Appearence 

It is now possible to change the look and feel for the CartoVista application, 
choosing one of the following style: White, Black, Earth and Blue. 

  

Map Interface 
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Map Notice 

The Map Notice is text that appears at the bottom of the map and contains 

information about the source, copyright and thematic data sources. 

Position: Positions the text at the bottom of the map either Left, Center or Right. 

Metadata (Sources) Window: When checked, turns the data source text into a 
button that opens a dialog showing all data source information. If unchecked, the 

data will be displayed at the bottom of the map, one after the other depending on 
which sources are made available. 

Layer Metadata (Sources): When checked, automatically includes Map Files 

sources logged in the Map File General Properties, for the layers included in the 
map. 

Indicator Metadata (Sources): When checked, automatically includes 

information about the data sources used in the thematic analyses displayed. 
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Custom Text: When checked, includes the User specified text in the Map Notice. 

  

Map Interface Options 

 Show Scalebar: Check to display the Scalebar at the bottom left corner of 

the application. 

 

 Show Zoombar: Check to display a vertical zoom bar for zooming in and 
out in the map window. 
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 Show Overview Map: Check to display the overview window at the top 
right corner of the map. 
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 Show Context Help:  Check to allow access to contextual help; this will add 
a question mark at the top right corner of each dialog box. 

Interactivity 

Rollover Fill Color: Check this option to enable a fill rollover effect. Whenever the 

mouse is over a geographic object that is in an interactive layer, the object’s fill will 
turn the color selected from the color selection button. 

Rollover Stroke Color: Check this option to enable a stroke rollover effect. 

Whenever the mouse is over a geographic object that is in an interactive layer, the 
object’s fill will turn the color selected from the color selection button. 

For more information on Interactive Layers see section on Interactivity and 

Thematics Tab. 

  

Thematic 
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Range Thematic 

  

Default Calculation Method: You can choose the classification method used to 

calculate the default ranges by choosing from this drop down list. The following 
methods are available: 

Quantiles 

A range classification method that distributes a set of values into groups 
that contain an equal number of values. This method places the same 

number of data values in each class and will never have empty classes 
or classes with too few or too many values. It is attractive in that this 
method always produces distinct map patterns. 

Jenks 

A range calculation method (also referred to as Natural Breaks 
Classification method) designed to determine the best arrangement of 

values into different classes. This is done by seeking to minimize each 
class’s average deviation from the class mean, while maximizing each 
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class’s deviation from the means of the other groups. In other words, 
the method seeks to reduce the variance within classes and maximize 

the variance between classes. 

Equal 
Ranges 

A calculation method that simply divides records across ranges of equal 
size. 

  

Default Color Palette: You can choose the default color palette for ranges 
thematic analysis. The following options are available: 

Color Palette Name 

 

Green 

 

Orange 

 

Blue 

 

Purple 

 

Red 

 

Magenta 

 

Yellow 

 

Grey 

 

Green-Yellow 

 

Green-Blue 

 

Red-Orange 

 

Red-Purple 

 

Blue-Purple 

 

Blue-Green 

 

Purple-Blue 

 

Purple-Red 

 

Blue-Green-
Yellow 

 

Red-Orange-
Yellow 

 

Brown-Orange-
Yellow 

 

Green-Blue-
Purple 

 

Orange-Purple 
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Red-Blue 

 

Red-Yellow-Blue 

 

Red-Yellow-

Green 

 

Spectral 

  

Default Overlay Color Palette: You can choose the default range color palette for 
overlay themes. The following options are available: 

Color Palette Name 

 

Green 

 

Orange 

 

Blue 

 

Purple 

 

Red 

 

Magenta 

 

Yellow 

 

Grey 

 

Green-Yellow 

 

Green-Blue 

 

Red-Orange 

 

Red-Purple 

 

Blue-Purple 

 

Blue-Green 

 

Purple-Blue 

 

Purple-Red 

 

Blue-Green-

Yellow 

 

Red-Orange-
Yellow 

 

Brown-Orange-
Yellow 

 

Green-Blue-
Purple 
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Orange-Purple 

 

Red-Blue 

 

Red-Yellow-Blue 

 

Red-Yellow-
Green 

 

Spectral 

Fill Pattern Thematic 

Default Pattern Color: to define the default color used to display patterns. The 

user can change the color afterwards using the Edit Style Menu. 
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Layer Control 

 

Each CartoVista Publisher map includes an integrated layer control, which displays 
the list of layers in the map. 

 

The layer tree contains one node for each layer in the Map Window. Layers that 
have style settings assigned to them have sub-nodes that depict the style settings 

in use. This can be either  a single <<Default>> style, that will be applied to all 
objects in the Map File, or multiple nodes with one node for each unique identifier in 
the Map File’s unique identifier column. Style nodes will display a visual 

representation of the style assigned to the identifier. 

NOTE: The styles of layers in a Map Window are completely independent from the 
Map File Manager. Any changes you make to the style of a map layer will NOT be 

reflected in the Map File that was used to create the layer from the Map File 
Manager. 

The Layer Control will alert you if the source geographic data for one of the layers 

is missing. Layers that are missing their geographic data source are highlighted in 
yellow. The Map will still display, with the caveat that the missing layer is not 
drawn. To correct the file path of a Layer, click on the layer node and use either of 

the Locate or the Locate Main Folder menu options. See section on Managing 
Missing Data for more information on locating missing layers. 

Layer Control Icons 
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The layer control includes icons for each map layer to help you quickly identify 
important properties of the layer. The Visibility and Labels icon also allow you to 

toggle the properties without having to use the Layer Control Dialog. 

Visibility Icons 

This icon indicates if the map layer is visible or not. Clicking the icon will toggle the 

visibility on or off. 

 

Layer is visible 

 

Layer is normally visible, but the layer is currently not 
visible due to the scale of the map and Visibility Range 

restrictions. See Visibility Ranges Tab in Layer Properties. 

 

Layer is NOT visible. 

Labels Visibility Icons 

This icon indicates if the layer’s labels are visible or not. Clicking the icon will toggle 
the visibility on or off. 

 

Labels are visible. 

 

Labels are normally visible but the labels are currently not 
visible due to the scale of the map and Visibility Range 

restrictions. See Visibility Ranges Tab in Layer Properties. 

 

Labels are NOT visible. 

NOTE: If labels are not yet setup, clicking on the icon to turn them on will 
automatically select the first column to be the label column. 

Layer Types and Icons 

This icon indicates the layer’s base geographic data type. If the icon is colored, 

interactivity has been enabled for the layer. 

 

Polygon layer 

 

Polygon layer with interactivity activated 

 

Polygon layer with filtering 

 

Polygon layer with interactivity activated and filtering 

 

Polyline layer 

 

Polyline layer with interactivity activated 

 

Polyline layer with filtering 

 

Polyline layer with interactivity activated and filtering 

 

Point layer 

 

Point layer with interactivity activated 
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Point layer with filtering 

 

Point layer with interactivity activated and filtering 

 

Annotation layer 

 

Annotation layer with interactivity activated 

 

Raster (image) layer from a file 

 

Raster (image) layer from a WMS Server 

 

Raster (image) layer from a Tile Server 
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Changing Map Layers 

 

Once a Map Window has been created, it is still possible to add, remove or reorder 
the layers. 

Using the Layer Selection Dialog 

By right clicking on the Map Layers node in the Layer Control, you can access the 
Layers Selection dialog from the popup menu that appears. You can use this dialog 

to add, remove, reorder and rename layers. For more information see section on 
Layer Selection Dialog. 

 

Using Drag and Drop 

You can add more layers to the Map Window by dragging and dropping one or more 

Map Files from the Map File Manager. You can drop the Map Files into either the 
Layer Control or the Map Display area. 

You can also add more layers to the Map Window by dragging and dropping one or 

more Layers from another Map Window directly into the Layer Control. 

Where layers that are added by drag and drop will be inserted into the existing map 
will depend on where they are dropped. 

If you drop outside of the Layer nodes (anywhere in the Layer Control), or onto the 
Map Layers node, the layers will be inserted based on their data type. Text 
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(Annotation) layers will always appear as the topmost layers. Other layer types will 
be inserted above the first layer of a similar type or above the first layer of the next 

layer type. Refer to Layer Types and Icons to determine the layer type order. 

If you drop inside the Layer nodes (between 2 Layer nodes), the layers will be 
inserted above the layer you have dropped onto. A black insert bar will appear in 

the Layer Control to visually indicate where the layers will be inserted. 

NOTE: If a new layer is added via drag and drop with the same name as an existing 
layer, the new layer’s name will have an _2 appended. (Or _3, or _4 depending on 

the existing layer names.) 

You can also reorder the layers of a Map Window using drag and drop. Simply 
select it the layer control and drag it to the desired location. 

NOTE: Once a layer has been added to the Map Window, changes you make to the 

layer properties and styles do NOT change the properties of the source Map File in 
the Map File Manager. This allows you to customize your map files within a Map 
Window as needed. If you want to make changes to a Map File that will be persisted 

to other maps, make the changes in the Map File Manager. 
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Layer Actions 

 

When you right click on a Layer’s node, a contextual menu is displayed. Some 

menu items may not be present depending on the type of Layer. 

 

Browse Data: This option is available for Annotation, Point, Polyline and Polygon 
layers. It allows you to view the data attached to the geographic objects. For more 
information about browsing data see section Browsing Map File Data. 

View Entire Layer: Sets the current Map Window’s view to the extent of the layer. 

Assign Styles: This option is available for Point, Polyline and Polygon layers. It 
allows you to specify how the geographic objects will be displayed in the Map 
Window. For more information about assigning styles, see section Assigning Styles 

to Features. 

Duplicate: This option creates a new layer in the map window that is an exact 
duplicate of the selected layer. 

Locate: This option allows you to point the layer to a different geographic data 

source file, or to update the information if the geographic data source file has been 
modified. For more information on locating the geographic data source, see section 
on Managing Missing Data. 

Locate Main Folder: This option allows you to point multiple layers to different 
geographic data source files all at once by specifying a root directory for all the 
source files. 

Remove: This option allows you to remove a layer from the Map Window. It does 

not delete the underlying geographic source file. 

It is also possible to remove Map Files using the Delete key from the keyboard. 

NOTE: You cannot remove the last layer from a Map Window 
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New Confirmation Dialogs 

A confirmation dialog box is now launched when you remove a Layer from the Layer 
Control, a Map File from the Map Source Manager or a Data File from the Data File 

Manager. A "Do not ask me again" option is available within the dialogue to turn off 
the use of the launched dialog. These new confirmation dialogs can be managed 

using the Tool > Preference > General Options Tab. 3 check boxes have been 
added so you can turn on/off the warning dialogs. 

 

Properties: This option allows you to see the properties associated with a specific 
Layer. See section Layer Properties for more information. 
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Managing Missing Data 

 

The Layer Control will alert you if one of the layers that you have been working with 
are missing their source file. Layers that are missing are highlighted in yellow in the 
Layer Control. 

To correct the location of a Layer that is missing, click on the Layer and use the 

Locate menu options. 

When you click on locate, the Locate Data File Dialog is displayed. 

 

Use the Find button to locate the missing file and click on OK. 

NOTE: You can use the Locate action to update a Layer if the source data has 

changed its column structure. Locating a Layer when this has happened will result 
in the list of columns available within the Layer to be updated. 
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Layer Properties 

 

The Layer Properties Dialog allows you to see and modify all of the properties 

associated with the Layer included in a Map Window. 

The general information about the name, visibility and format 
The styles 
The filtering 

The labelling 
The visibility ranges for both the layer and the labels 

The interactivity and thematic settings 

You can use one of the following methods to access the Layer Properties Dialog 
within a Map Window: 

1. Double click on the Layer node in the Layer Control 

2. Right click on the Layer node in the Layer Control and chose one of the 
options in the Properties’ submenu. 

 

This will take you directly to that tab in the Layer Properties Dialog. 

NOTE: Not all tabs are available for all layer types. 

General Tab 

The General Tab displays basic information about the layer and allows the user to 
set the visibility, as well as the opacity, the blend mode, the qaulity and the output 

format of the layer. 
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Name: This is an editable property. You can specify any name you want for the 

layer. To edit the name, type in the name box. Names must be unique within the 
Map Window. 

File Path: The path to the GIS file providing the feature data. This field cannot be 

changed, but the path can be copied/pasted elsewhere. 

Layer Unique ID: A Unique ID assigned to this layer (the unique ID is usually the 
name of the source file). This cannot be changed, but the label can be 

copied/pasted elsewhere.  

Visibility 

Visible: The map layer visibility. Click on the check box to make the layer visible or 
invisible. By default, this option is checked. 

Show in Legend: This option controls if the map layer will be shown in the 

CartoVista legend or not. By default, this option is unchecked and map layers are 
not shown in the legend. 

NOTE: This option is not available for Annotation and Raster (all types) layers. 



CartoVista Publisher Documentation 

262 

Show in Layer Control: This option controls if the map layer will be shown in the 
CartoVista layer control or not. By default, this option is checked. 

Show Style Classes: This option controls if the classes defined in the map layer 

will be shown in the CartoVista layer control or not. By default, this option is 
checked. The style classes will be set in the Style Tab.  

NOTE: This option is not available for annotations, raster layers, tiles and WMS 

layers. 

Layer 

Opacity: The opacity of the map layer. Use this property to set the map layer 

opacity (in percentage) from 0 (Transparent) to 100 (Fully Opaque). 

Blend Mode: The following blend modes are available: 

Blend Mode Description 

normal The display object appears in front of the background. Pixel 

values of the display object override those of the background. 
Where the display object is transparent, the background is 
visible. 

layer Forces the creation of a transparency group for the display 

object. This means that the display object is pre-composed in a 
temporary buffer before it is processed further. This is done 
automatically if the display object is pre-cached using bitmap 

caching or if the display object is a display object container with 
at least one child object with a blendMode setting other than 

BlendMode.NORMAL. 

multiply Multiplies the values of the display object constituent colors by 
the colors of the background color, and then normalizes by 
dividing by 0xFF, resulting in darker colors. This setting is 

commonly used for shadows and depth effects. 

For example, if a constituent color (such as red) of one pixel in 
the display object and the corresponding color of the pixel in the 

background both have the value 0x88, the multiplied result is 
0x4840. Dividing by 0xFF yields a value of 0x48 for that 
constituent color, which is a darker shade than the color of the 

display object or the color of the background. 

screen Multiplies the complement (inverse) of the display object color by 
the complement of the background color, resulting in a bleaching 

effect. This setting is commonly used for highlights or to remove 
black areas of the display object. 

lighten Selects the lighter of the constituent colors of the display object 
and the color of the background (the colors with the larger 

file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
file:///C:/Projects/0010_CartoVistaPublisherDocumentationRoboHelp/RoboHelp/en/javascript:textpopup(this)
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values). This setting is commonly used for superimposing type. 

For example, if the display object has a pixel with an RGB value 

of 0xFFCC33, and the background pixel has an RGB value of 
0xDDF800, the resulting RGB value for the displayed pixel is 

0xFFF833 (because 0xFF > 0xDD, 0xCC < 0xF8, and 0x33 > 
0x00). 

overlay Adjusts the color of each pixel based on the darkness of the 
background. If the background is lighter than 50% gray, the 

display object and background colors are screened, which results 
in a lighter color. If the background is darker than 50% gray, the 
colors are multiplied, which results in a darker color. This setting 

is commonly used for shading effects. 

hardlight Adjusts the color of each pixel based on the darkness of the 
display object. If the display object is lighter than 50% gray, the 

display object and background colors are screened, which results 
in a lighter color. If the display object is darker than 50% gray, 
the colors are multiplied, which results in a darker color. This 

setting is commonly used for shading effects. 

difference Compares the constituent colors of the display object with the 
colors of its background, and subtracts the darker of the values 

of the two constituent colors from the lighter value. This setting 
is commonly used for more vibrant colors. 

For example, if the display object has a pixel with an RGB value 
of 0xFFCC33, and the background pixel has an RGB value of 

0xDDF800, the resulting RGB value for the displayed pixel is 
0x222C33 (because 0xFF - 0xDD = 0x22, 0xF8 - 0xCC = 0x2C, 

and 0x33 - 0x00 = 0x33). 

invert Inverts the background. 

alpha Applies the alpha value of each pixel of the display object to the 

background. This requires the blendMode setting of the parent 
display object to be set to BlendMode.LAYER. For example, in the 

illustration, the parent display object, which is a white 
background, has blendMode = BlendMode.LAYER. 

erase Erases the background based on the alpha value of the display 
object. This requires the blendMode of the parent display object 

to be set to BlendMode.LAYER. For example, in the illustration, 
the parent display object, which is a white background, has 

blendMode = BlendMode.LAYER. 

NOTE: Of all of the Blend modes only Alpha and Layer will not have a visible effect 

in the Publisher. In order to see the effect of these two blend modes, you must 
publish the map and use the Viewer. 

Quality: 
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Quality: Defines how accurate the vector output will be for a map layer. The 
publishing process simplifies map features by eliminating duplicate nodes in 

polygon and polyline layers. This setting affects the node reduction so that at a 
higher quality, there is less node reduction. 

The quality can be: 

 Normal 

 Improved 
 Enhanced 

 High 
 Highest 

  

NOTE: If the layer is meant to be published at a large view (small scale), meaning 

without too many zoom-in based on the visibility ranges, then the Normal quality 
should be appropriate. If you would like to enable zooming a lot (large scale), the 
increasing the quality will produce better cartographic results when zoomed in. 
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ADVISE: Aside from setting the quality in the CartoVista Publisher, generalizing 
your GIS data remains important, depending on what you want to publish. 

  

Format: You have the option to choose the output format. Two choices are 
currently available: Flash (.swf) and Geometry (.shp). 

  

The following tables are explaining some of the differences between the two 

formats Flash (.swf) and Geometry (.shp) 

Initial loading time in the CartoVista Viewer  

Flash 
  

It is not possible to confirm that a format is faster than the other. 

  

Geometry 

  

Maximum number of objects 

Flash Around 5 000 polygons. 

Geometry  Around 15 000 polygons. 

NOTE : In summary, the limit in the number of vector objects will be depend on the 
acceptable loading time in the CartoVista Viewer.  

When preparing a map for CartoVista, it is important to remember the following: 

Using a Tile Base Map will limit the usage of vector data. 

The CartoVista Server component has been developed to overpass the limitations in 

the number of vector objects. The CartoVista Server will store data on the server 
and render information based on the extent of the view, which will also limit the 
loading time. 

For more information on the CartoVista Server: 
http://cartovista.com/cartovistaserver.aspx?language=en 

Displaying the map when panning inside the CartoVista Viewer 

Flash The view is constantly refreshed in the CartoVista Viewerh. 

http://cartovista.com/cartovistaserver.aspx?language=fr
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Geometry  
The view is refreshed from time to time in the CartoVista 

Viewer 

Additional visual effects (Style Tab) 

Flash Additional visual effects are not available for Flash layers 

Geometry
  

Drop Shadow, Outer Glow and Inner Glow 

 

  

  

File size 
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Flash Really compact, smaller. 

Geometry  Larger. 

NOTE : the size of the output file has an impact on the uplaod time to deploy the 
application on the web server. It does not have such an impact on the download 
time within the CartoVista Viewer. 

  

Compatibility with mobile devices (important in case of development of a CartoVista 

application with the mobile SDK) 

Flash Not compatible. 

Geometry  
Compatible. This format is the one to be use for a CartoVista 
mobile deployment.  

  

Styles Tab 

The Styles tab provides information on how to render styles for the map layer. 

The content of the dialog will depend on the output format defined in the general 

parameters (General Tab), and the type of layer on which the style is applied. 
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Styles Property 

This section controls how styles are displayed for Point, Polyline and Polygon Map 
Files. There are three ways in which styles can be displayed:T 

1. Default Style: If this option is checked, a single style will be used for all 

geographic objects of the layer. To change the default style, click on the Edit 
Style Button. 

2. Coloring Scheme: If this option is checked, a style will be applied to the 

geographic objects based on the value in the specified attribute column. Each 
unique value within the column will have a unique style assigned 

automatically. 
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 The styles applied on the layer, and the names can be modified afterwards. For 

more information on style assignment see Assigning Styles to Features. 

Show unassigned identifiers option 

Choose this option to display all the unique identifiers, even if they have not been 
assigned a style. If this option is not selected, only identifiers with an assigned style 

(including identifiers auto-assigned by the default style) are displayed. 
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3. MapInfo Table Style: When this option is selected, the style information for 
each feature will be read directly from the information stored in the MapInfo 

Table. This option is only available when the source geographic data file is a 
MapInfo Table (.tab).  

NOTE: Some of the MapInfo style options such as fill and stroke patterns are not 

supported by the CartoVista Publisher. 

Effects 

When the output format is Geometry (.shp), advanced graphic effects options are 

available.  

 

  

Transparent Color (Raster) 
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This section controls how transparency are handled for the Raster, WMS and Tile 
Map Files. 

By selecting the “Enabled” checkbox, you can specify a specific color to be 

transparent. Click on the Color button to choose the specific color that will be 
transparent. 

Symbol Rotation (Points) 

For Point Map Files, a symbol rotation column can be configured. This setting allows 
the user to rotate the symbol for the point to a specific angle based on that object’s 
field entry in the user specified column. 

Filter Tab 

The Filter tab provides different options to filter geographic objects within a map 
layer. 

 

For more information on setting filter options, see Filtering Map File Data. 

Labelling Tab 
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The labelling tab allows you to specify how map labels are rendered for a layer. 

 

Standard Properties 

Label Using Column 

Choose the column to use for labelling . 

Visibility 

Labels Visible: Define if labels are visible or not. To make labels visible, enable 
the check box. 

Allow Duplicates: This option controls if objects duplicate label names are allowed 
within a layer. For example, you may have a street layer with multiple segments 
having the same name (MAIN ST for example). If you want to label "MAIN ST" only 

once on the map, do not check this option. If you want to allow duplicate labels on 
the map, enable the check box. 

Allow Overlap: This option controls if label overlaps are allowed for this map 

layer. When enabled, , label text can overlap other labels of the map. When 
disabled, map labels do not overlap. 
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Priority: The Priority option is used to define which labels are rendered first on the 
map. Each map layer can have a priority ranging from 1 (low) to 10 (high). By 

default, map layers have a priority of 5 (medium). 

Position 

Position: You can use this option to control the anchor point of the map label. You 
can choose from the following position options by selecting from the drop down list. 

 

The text alignment for each line of a multi-line label will follow the Left, Middle or 
Right position defined by this setting. 

An “Auto Placement” position is also available in the drop down list. This will 

attempt to place the label to the Center Right, but if the label cannot be placed 
there due to an existing label, the other positions will be tried until either an 
acceptable placement is found, or no placement is possible, in which case the label 

will not be displayed. 

Offset X and Y: The offset X and Y option defines a distance in pixels to offset the 
position the label in relationship to the feature. Specify a value in pixels to enable 

this option for both X (Horizontal) and Y (Vertical) positions. 

Rotation: Use this option to specify a rotation angle for the map labels. Enter an 
angle in degrees. 

Font 

To specify the font style setting for the label, click on the Font Button. See section 

on Font Styles in Stylizing your map Files. 

Labelling Tab (Extended Properties) 

Extended labelling properties are available if you are creating a Tile Window. The 

Label tab will have two sub-tabs, “Standard”, described above, and “Extended”. The 
extended properties allow you to have even more control over how map labels are 
rendered for a layer. 
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Enabled: A global enablement for all properties in the extended tab. Check this 
option to use these properties. 

Align: Specifies text alignment for multiline labels. When extended properties are 
not available, everything is always aligned Left.. 

Rotation: Specifies how labels will be rotated. 

1. None: The label is not rotated. 

2. Double: Sets a specific rotation for all labels. Use the text box under the 
drop down to specify the angle. 

3. Auto: The rotation is calculated by the Map Window based on the linear 

feature. 

4. Follow: Computes a curved label for appropriate linear features. 
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5. Attribute: Allows a feature’s field value from a column to be used. The Use 
column for Angle dropdown specifies the column to use. 

Buffer: A padding, in pixels around the labels. It is used to maintain spacing 

around the text to maintain readability. Other labels won’t be placed into this 
space. 

Max Font Size: The maximum font size to use when scaling text in the map. 

Min Font Size: The minimum font size to use when scaling text in the map. 

Max overlap angle: The angle threshold to use in filtering out ANGLE FOLLOW 
labels in which characters overlap (floating point value in degrees). 

Min Distance: The minimum distance between duplicate labels in pixels. 

Force Labels Visible: Forces labels to appear, regardless of collisions with other 
labels. 

Allow Partial Labels: Permits labels to run off the edge of the map. 

No Clip Label Position:  Disables the clipping of shapes to the map extents when 
determining label anchor points. This avoids changes in label position as extents 
change between map draws. 

Follow Character Spread: Labels along polylines will be spread out across the 

entire length of the polyline. The AUTO rotation option MUST be set to permit this 
option to work. 
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Min Feature Size: Determines how big a feature has to be before it will be labeled. 

1. Auto: The feature must be bigger than the label. 

2. Integer: Specifies the feature must be bigger than the size specified in the 
edit box (in pixels) below the dropdown. For line data the overall length of the 

displayed line is used, for polygons features the smallest dimension of the 
bounding box is used 

Repeat Distance: The interval in pixels that a label will be repeated on every line 

of a multi-part line or polygon. 

Max Length: When the Wrap Character is set, line breaks only occur after the 
defined number of characters. 

Wrap Character Max Length = 0 Max Length > 0 Max Length < 0 

Set 
Always wrap at 
wrap character 

newline at the first 

WRAP character 
after MAXLENGTH 
characters 

always break at 
exactly MAXLENGTH 

characters 

Not Set No effect 

skip label if it 
contains more than 

MAXLENGTH 
characters 

always break at 
exactly MAXLENGTH 
characters 
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Wrap Character: The character that represents an end-of-line condition in label 
text, thus resulting in a multi-line label. 

Visibility Ranges Tab 

The visibility settings are used to specify if the layer and/or labels for a layer are 
shown at a certain map scaleaving scale-dependant layers is very useful to provide 

appropriate data views for the layer. To enable visibility ranges, click on the check 
box to enable the option and specify minimum and maximum values. 

 

Layer 

The Layer settings apply to the layer as a whole, including the labels. 

Enabled: When enabled, if the Map Window scale is not within the Minimum and 
Maximum values, the layer will not display. The layer visibility icon will change to 

   in the Layer Control. 

Minimum: The minimum scale for which the layer is displayed. Below this scale the 
layer will not be visible (inclusive). 
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Maximum: The maximum scale for which the layer is displayed. At this scale and 
above the layer will not be visible (exclusive). 

Labels 

The Labels settings apply to only the labels (this option is available only if labels 
have been enabled in the Labeling Tab). 

Enabled: When enabled, if the Map Window scale is not within the Minimum and 

Maximum values, the labels will not display. The layer label icon will change to   
 in the Layer Control. 

Minimum: The minimum scale for which the labels is displayed. Below this scale 
the labels will not be visible (inclusive). 

Maximum: The maximum scale for which the labels is displayed. At this scale and 
above the labels will not be visible (exclusive). 

Tile Providers Tab 

The tile providers tab allows you to specify the tile providers that are available in a 
tile layer and choose the default provider. 
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The available providers grid lists all the Tile Providers available in the Map Source 
Manager, plus any additional ones that were unique to this layer. Checking the 

checkbox next to the provider name will include the tile provider and it will be listed 
as a sub-node under the layer node in the layer control. 

The Label column allows you to change the text that will appear to the end user in 

the Viewer’s layer control. 

Use the Active Tile Provider to set which of the selected tile providers is currently 
displayed in the Publisher, as well as which one will be automatically displayed 

when the map is loaded in the Viewer. 

Interactivity and Thematics Tab 

The interactivity and thematics tab allows you to specify the user’s interactivity with 

the layer. There are five ways to make a layer interactive: 

1. Data Tips: When you move the mouse over a geographic object in the layer, 

a data tip window will appear that contains information about the geographic 

object your mouse is over. When you move off a geographic object, the 

window closes. 

2. Information Dialog: When you click in the Map with the Info Tool, the Info 

Tool Dialog appears containing information about all the geographic objects 

that lay under the mouse click. 

3. Hyperlink: When you click on a geographic object with the Hyperlink Tool, 

the URL stored in the geographic object is opened. Hyperlinks can also be 

used to identify other maps to open in a “drill down” situation. 

4. Searching: You can define a layer as searchable so that specific geographic 

objects can be located and zoomed to in the map. 

5. Thematic Analysis: Thematic analysis allows you to display indicator data 

as either a style override on the layer, or as an overlay addition to the layer. 

After checking the “Interactivity Enabled” check box, you will have access to the 
four additional tabs: 

 Interactivity Setup 

 Feature Attributes 
 Data Display 
 Thematics 
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Interactivity Setup 

This tab should be setup first, as the remaining tabs depend on the unique identifier 

column that is set here. 

 

Unique Identifier Column: This identifies the column in the source GIS data that 
contains the unique identifier for each record. 

If you try to chose a column that does not contain a unique identifier for each 

record, you will be alerted that you cannot use that column. 

If you do not have a column that contains unique identifiers column, chose 
“<AUTO-GENERATE>” which will use the record’s row number as its unique 

identifier. 

NOTE: Thematic Analysis requires that a specific column be selected, and will not 
work with a unique identifier column of “<AUTO-GENERATE>”. 

Feature Name Column: This identifies the column in the source GIS data that 

contains the “feature name” for each geographic object. This name is the one that 
is most commonly included in the data-tip. 
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Hyperlink Column: This identifies the column in the source GIS data that contains 
a valid URL. 

Hyperlink Target: This allows you to chose how the URL specified in the hyperlink 

column will be opened. 

Target value Description 

Current Window Open the hyperlink in the 

current window (replaces 
CartoVista). 

Drill down If the hyperlink is a CartoVista 
map, the linked map will be 

opened in the map window. 

New Window Opens the hyperlinks in a new 
browser window. 

  

Feature Attributes 

The feature attributes tab lets you define which columns in a layer’s source GIS 
data are available as Attributes. Attributes are information attached to map 
features and are used in the display of Data Tips as well as the Info Tool and 

Selection and Search capabilities. 
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The tab displays all the columns that are available. Checking the checkbox next to 

the column name will include the columns’ data when the map is published, and it 
will be available for use as a Data Display element. 

The Label column allows you to change the text that will appear to the end user 
that identifies the column. 

The   and    buttons at the bottom of the tab allow you to change the order of 
the columns. 

NOTE: The Unique Identifier, Feature Name and any column used as a DataDisplay 

will be automatically checked. If the column is used in any of these ways, you will 
not be able to unselect it in this tab. 

Data Display 

This Data Display tab will let you define which attributes of a geographic object will 

be displayed in one of the four ways in the Viewer: 

Data Tip: Displayed in the rollover information bubble. 

Info Tool: Displayed in the Info Window when using the Info Tool 
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Selection Dialog: Displayed in the Selection Dialog when a selection is made 

Search Dialog: Available as a column in the Search Dialog when the Search 
tool is used. 

 

Checking the checkbox next to the column name will include the column in the 
appropriate display. The label used to identify the data will be the label that was set 

in the Feature Attributes column. 

If the column was not previously selected in the Feature Attributes tab, it will 
automatically be selected for you. You cannot uncheck a column that is checked in 
the Feature Attribute column unless it is not used in any Data Display option, or as 

the Unique Identifier or Feature Name. 

The   and   buttons at the bottom of the tab allow you to change the order of 
the columns. 

Indicator Display Mode: Use this drop-down to specify which indicators (if any) 

should be included in the Data Tip and/or Info Tool results. 
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1. None: No indicators will be displayed in the data tip / info tool. 

2. Active Indicators Only: Only active indicators used in the current 
thematic analyses will be displayed in the data tip / info tool. 

3. All Indicators in Active Tables: All indicators from the indicators tables 

used in the current thematic analyses will be displayed in the data tip / info 
tool. 

4. All Indicators: All indicators linked to the layer will be displayed in the 

data tip / info tool. 

Thematic 

The Thematic tab will let you define the thematic data for this layer. The tab lets 
you work with both the data that is attached to the layer, and any additional data 

files that you may also have. 
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If you open this tab, and you do not have any categories or indicator tables 
defined, you will be automatically taken to the add indicator dialog, and a default 
indicator table will be created for you with the indicators you have selected. 

For more information on toolbar in this tab, see the section on the Thematic Layer 

Toolbar. 

For more information on the properties of the various items displayed in this tab, 
see the section on Thematic Layer Properties. 
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Setting Legend Options for Map Layers 

 

When working with map layers in the layer control (or in the Map File Manager), the 

map layer styles are displayed in the tree when you expand a map layer. Each style 
attached to a layer is displayed. 

 

You can double click on the styles to configure what name is displayed in the 
CartoVista layer control and legend windows. 

The Legend Text Box 

Once you double clicked on a style, the Style dialog is displayed. Each Style dialog 
has an legend text box where you can enter text that represent the feature class. 

 

When you publish the map, the CartoVista Publisher uses the legend text to name 

the classes within the layer. 
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Creating Hyperlinks Between Maps 

 

CartoVista maps can be organized as a hierarchy of maps to create effective drill-
down navigation. Drill-down is a natural way to explore map data and understand 
links between geographies. When drilling-down from one level to another, 
CartoVista keeps your indicator variable selection, if applicable. 

To set up a drill-down scenario in the Publisher, you need to link the appropriate 
maps by defining Hyperlink Target. 

1) Setting up the column and hyperlink values 

The first step is to add a column in the layer to store your hyperlinks. Those 

hyperlinks need to be named following a naming convention, using the MAPS folder 
and the name of the configuration file to load for the map. 

For a map called USA, the following hyperlink value would apply: 

 Maps/USA/USAConfig.xml 

2) Choose the Hyperlink column and target 

The second step is to define the Hyperlink Column and the Hyperlink Target to “Drill 
down” in the Layer Properties, Interactivity & Thematics Settings. 

3) Publish Maps 

The last step is to publish the maps: the main map, as well the drill-down maps, 
making sure to follow the naming convention above. 
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Publishing a Map 

 

Once you have created and configured your map, you need to publish the map. 

Before you can publish your map, you need to identify the Map Name, and the 

Output Folder to publish the data to. Use the Publish Options button to bring up the 
Publish Options Dialog where you can set these options. 

Once you have set the Publish Options, use the Publish button to publish the map. 

 

Map Name (Output Files): The name of the map. It is used for a folder name in 
the Output Folder, the name of the default HTML page and the name of the .SWF 

file created. For more information on map name and related files, see Maps Folder. 

Map Title: The map title is displayed in the CartoVista map output, in the title 
section at the top of the map. This setting can also be edited in the Map Settings 

Dialog. 

Output Folder: This is the folder where Maps are published. Each map will have its 
own sub-folder named according to the Map Name setting. By default, the 
installation directory of CartoVista is: 

C:\Users\Public\Documents\CartoVista4\Maps\ 
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To specify a different Maps folder, click on the button beside the text box. 

Relative to the Maps folder, the CartoVista Viewer must be located in one of the 
following 3 directories: 

1. The same directory 

2. A sub directory called “CartoVista4” 

3. The parent directory 

When you select a new location, the Publisher looks to find the CartoVista Viewer 
(CartoVistaViewer.swf) in any one of the directories specified above. 

If the CartoVista Viewer cannot be located, a warning message is displayed below 

the path and a “Restore Default” button will appear. Click on the “Restore 
Default” button to reset the output folder to the default location. 

 

For more information on file outputs and folders for deployment, see The CartoVista 
Viewer. 

Published Files 

Map : Select this option to publish the output map .SWF. 

Map Config File: Select this option to publish the map’s Config.XML file. 

Data: Select this option to publish the map’s thematic Data View. 

Publish Options 

Overwrite HTML File: Check this option to overwrite the default HTML page. If 

this is unchecked and a default HTML file already exists, a new one will not be 
created. 

Open in Browser: Check this option to show the output result in your default web 

browser. 

Map Size: Use the drop down to set the size of the Map in the default HTML page 
that is created when you publish the map. There are three options available: 

1) Map Size: The map will have the same size as it was created in the Map 

Window. 
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2) Full Screen: The map will take up as much room in the page as possible. 

3) Fixed: The map will be sized to the specific size in pixels set in the Width 
and Height edit boxes. 

Width: The width in pixels of the output map. 

Height: The height in pixel of the output map. 

Viewer License Keys 

To deploy a CartoVista map to a web server, you will need to enter your Viewer 
License Key. This key is obtained by contacting CartoVista. The license key is linked 

to the domain name for the web server that the CartoVista Solution will be 
deployed on. If you have multiple domain names to support, the license key for 
each domain must be entered. 

Enter your license key in the text box marked <Insert License Key Here>. Once you 

have hit enter, or moved the focus from the textbox, a new line will be added to the 
list of license keys. If you have entered a valid license key, the domain that key is 

registered for will be displayed in the “Domain” column. If the key is not valid, it 
will display “Invalid License Key”. 

Use the  button to remove a license key that is not needed for the map. The 

Publisher will remember the license keys you previously used and automatically 
enter them for you when you create a new map. 

You do not need a license key if you wish to create and view CartoVista maps on 

your local machine. However a “Demo / Evaluation” watermark will be displayed in 
the Viewer. 
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Creating Thematic Data for CartoVista 

 

The CartoVista Publisher’s secondary focus is to assist you in create the thematic 
data you need to deploy with your CartoVista solution. 

A CartoVista Map can contain one or more thematic layers. Which layers are 
thematic is defined when you setup your map. For more information on setting up a 
thematic layer, see Interactivity and Thematics. 

Both the Layer Properties > Thematics tab and the Data Publisher allow you to 
work with your Data Files to pull indicators together and organize them into a Data 
View.  Once you have created the Data View, publish your data to create the files 

XML files needed for deployment to the CartoVista solution. When working with the 
Data Publisher, you can save the Data View to create a .CVD file. When working 

with a CartoVista Map, the Data View is automatically saved within the Map’s .CVM 
file. 

This chapter will explain the following concepts: 

 Thematic Data Architecture 

 Creating a Data Publisher Window 
 The Data Publisher Window 
 Main Toolbar 

 Thematic Layer Toolbar 
 Adding Indicators 

 Thematic Layer Properties 
 Publishing Your Data 
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Thematic Data Architecture 

 

Thematic data is organized into Indicators, Indicator Tables and Categories. This 
gives you complete flexibility as to how your data is organized and displayed in the 
Viewer. 

 

Indicators 

An Indicator is a specific set of data elements that can be displayed thematically. 

Each data element in the indicator contains a unique identifier and a value. The 
unique identifier will be used to link the data element to the map object, while the 

value will be used for thematic mapping. 

Indicators can be either numeric  or string  values. The type of thematics 

available will depend on the type of data the Indicator represents. 

Indicator Tables 

An Indicator Table is a collection of Indicators. Indicator Tables allow you to group 

together related Indicators. When the end user will switch between related 
Indicators they should all be placed in the same Indicator Table. 

NOTE: There is a default maximum of 20 Indicators per Indicator Table. This limit 

can be changed in the Tools > Preferences dialog. 

Categories 

Categories (and sub-categories) are used to organize your Indicator Tables in a 

meaningful data tree. If you have many Indicator Tables, organizing them into 
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categories will assist the end user in locating the Indicator Table that he is looking 
for. 
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Creating a Data Publisher Window 

 

You can create a Data Publisher Window using one of the following methods: 

1. Open an Existing .CVD file 

From the main menu, select File > Open menu option. A dialog will prompt you 

to locate the .CVD file. Once you have selected a .CVD file, a Data Publisher 
Window will open as defined in the .CVD. 

2. Drag & Drop an existing .CVD file 

You can drag and drop a .CVD file from Windows Explorer onto the main 

application. This will open a Data Publisher window as defined in the .CVD. 

3. Double Click on an existing .CVD file 

You can double click on a .CVD file from Windows Explorer. This will start up 
the Publisher and automatically open the Data Publisher Window as defined in 

the .CVD. If the Publisher is already running, the Data Publisher Window will 
open in the Publisher without starting a new instance. 

NOTE: CartoVista Publisher 3.7 can open any .CVD created with any previous 

version of the CartoVista Publisher. However if you save the data view from 
CartoVista Publisher 3.7, you will not be able to use the .CVD with a previous 
version of the Publisher. 

4. Create from an Existing .CVM file 

From the main menu, select Tools > Data Publisher > From CartoVista Map 
menu option. A dialog will prompt you to locate the .CVM file. Once you have 
selected a .CVM file, a Data Publisher Window will open as defined in the Data 

View contained in the .CVM. 

5. Create a new Data View 

From the Main Menu, select Tools > Data Publisher > New Data View. 
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The Data Publisher Window 

 

The Data Publisher Window visually displays the Data View. It is composed of the 
following 3 parts: 

 

Main Tool Bar 

Allows you to save or publish the Data View as well as Add/Remove/Rename 

thematic layers in the Data View. 

Thematic Layer Tool Bar 

A vertical toolbar on the left side of the Data Publisher Window containing options 

for adding or removing elements to a Thematic Layer. 
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Thematic Layer Display 

A two part window that contains the details about a Thematic Layer. In the left 

panel, a tree of Categories, Indicator Tables and Indicators is displayed. In the right 
panel, the properties associated with the selected Category, Indicator Tables or 

Indicator are displayed. 

NOTE: The proportion of the Thematic Layer Display assigned to the tree versus the 
properties can be changed by dragging the separator between the two sides. 
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Main Toolbar 

 

Save Button 

 

The Save button saves your current Data View to a .CVD file. If you have not 
already saved your Data View, you will be prompted for a file name. 

When you save a .CVD file, you are saving the settings and other attributes 

needed to recreate the Data Publisher Window. You are not saving the underlaying 

data files, simply a reference to them. 

If you want to give someone a copy of your Data View, ensure they already have 
the Data files, or include the source Data files in the package you transfer. 

If you have opened the Data Publisher Window from a .CVM, the Save button will 

save the changes back to the .CVM file. You can still use the main menu File > Save 
As menu option to save the Data View to a .CVD file. 

Publish Button 

 

The Publish button will publish the Data View with the existing settings without any 

user interaction. If you want to change the publish settings, click on the Publish 
Options button. 

NOTE: If you have not previously published the Data View, the Publish Options 
dialog will be displayed so that you can set the map output name. 

Publish Options Button 
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The Publish Options button will display the Publish Options Dialog so that you can 
specify the map output name and specify the output directory. 

Thematic Layer Dropdown 

 

The dropdown displays a list of all the Thematic Layers in the Data View. Selecting 

a Thematic Layer will result in the Thematic Layer Display updating to reflect the 
chosen Thematic Layer. 

Add Button 

 

The Add button will start a dialog to add another Thematic Layer to the Data View. 

There are two possible dialogs that could be displayed: 

1. If your Data Publisher Window was opened from a .CVM, the Add Thematic 

Layer Wizard dialog will appear. See section on Adding Indicators. 

You will only be able to create Thematic Layers for the layers in the CartoVista 
Map that have interactivity enabled and a unique identifier column set. 

If you have already created a Thematic Layer for each layer in the CartoVista 

Map that is interactive, you will be alerted and no additional layer will be 
created. 

2. If your Data Publisher Window is not opened from a .CVM, the Thematic 
Layer Name dialog will appear. See section on the Data Publisher Window. 

You will be able to create as many Thematic Layers with whatever name you wish. 
However in order for the Thematic Layer to be useful in the Viewer, the Thematic 
Layer name must match the name of a layer in the Map that has interactivity 

enabled and a unique identifier column set. 

Remove Button 

The Remove button will remove the current Thematic Layer from the Data Publisher 

Window. 
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Thematic Layer Toolbar 

 

This tool bar is located on the left of the Data Publisher Window or at the top in the 

Layer Properties > Interactivity > Thematics Dialog. This toolbar helps you organize 
your indicator data. You can create a hierarchy of categories for the selected 
Thematic Layer. 

Add Category 

 

Allows you to add a Category to the “root” node or an existing Category (as a sub-
category). You will be prompted to enter a Category Name. 

 

Add Indicator Table 

 

Allows you to add an empty Indicator Table to the “root” node or an existing 
Category. You will be prompted to enter an Indicator Table Name. 

 

Add Indicator 

Allows you to add an Indicator to an Indicator Table. See section on Adding 
Indicators. 
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Remove 

 

Allows you to remove a Category, Indicator Table or Indicator. Removing a 
Category also removes any subcategories and Indicator Tables that are underneath 
it. Removing an Indicator Table also removes any Indicators it contains. 

Rename 

 

Allows you to rename a Category or an Indicator Table. If you wish to change the 

name of an Indicator, use the Label property of the Indicator. 

Copy 

 

Copies to the clipboard the currently selected Indicator, Indicator Table or 

Category. 

Paste 

 

Pastes the Indicator, Indicator Table or Category into the currently selected item. 

This button will only be active if the currently selected item is of the correct type to 

receive what was copied. 

 Indicators can only be pasted into an Indicator Table. 
 Indicator Tables can only be pasted into Categories or the “root” node of the 

Thematic Layer. 
 Categories can only be pasted into other Categories or the “root” node of the 

Thematic Layer. 

Move Up 
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Moves the selected Category, Sub-Category, Indicator Table or Indicator up in the 

tree. 

Move Down 

 

Moves the selected Category, Sub-Category, Indicator Table or Indicator down in 
the tree. 
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Adding Indicators 

 

Once you have added an Indicator Table to your thematic layer, you can add 
indicators to it. 

If you are using the Layer Properties > Interactivity > Thematics page, you can 
only use the Add Indicator wizard to add indicators to your layer. Otherwise, you 

can also use Drag & Drop on Data Files and Data Columns in the Data Source 
Manager to add indicators. Only Data Columns from a Data File that has a Unique 
Identifier set will be allowed to drop onto an Indicator Table. See section Data File 

Properties on Setting Unique Identifier Columns. 

NOTE: Indicators in an Indicator Table do not all have to come from the same Data 
File. You can create an Indicator from any Data File and add it to any Indicator 

Table. 

Add Indicator Wizard 

 

Clicking the Add Indicator button on the Thematic Layer toolbar will present the 

Add Indicator Wizard. Use the options in the first page to indicate where the 
indicator will come from. Select your option and click Next: 

 

The “Select from <Layer Name>” option is ONLY available when adding indicators 

from the Layer Properties > Interactivity > Thematics layer. 
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If you choose “From Data Source Manager” in the first page of the wizard, you will 
be prompted to select from the list of Data Files available in the Data Source 

Manager: 

 

Select the Data File and click Next. 

NOTE: Only Data Files that have a Unique Identifier  set will be listed in the 

dialog. See section on Setting Unique Identifier Columns in Data File Properties. 

 

If you choose “From NEW Data File” in the first page of the wizard, a dialog will 
prompt you to locate the source of the new Data File. You will then be prompted to 

specify the unique identifier column for that Data File. 
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The final step in the wizard is to select the columns from the Data Source that will 

be used as indicators. Selected the columns and then click Finish. 

> Moves the selected column from the Available list to the Selected list 

>> Moves all columns from the Available list to the Selected list 

< Moves the selected column from the Selected list to the Available list 

<< Moves all columns from Selected list to the Available list 
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Thematic Layer Properties 

 

Categories, Indicator Tables and Indicators all have various properties associated 
with them. You will see the properties in the right hand panel of the Thematic Layer 
display when you select something in the tree view. 

 

NOTE: The proportion of the Thematic Layer Display assigned to the tree versus the 
properties can be changed by dragging the separator between the two sides. 

Category Properties 

ID: A unique (within the thematic layer) identifier string. 

Label: The text label for the category. 

Indicator Table Properties 

ID: A unique (within the thematic layer) identifier string. 

Label: The text label for the indicator table. 

URL: The path to the XML data file that will be created for this Indicator Table. The 

data file will contain the definition of all the indicators within it, along with the data. 
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Indicator Properties 

ColumnType: The type of data represented. One of the following values: 

 Integer 

 String 

 Float 

 Numeric 

 Date / Time 

Description: Text description of what the indicator is. 

ID: A unique (within the thematic layer) identifier string. 

Label: The text label for the indicator. 

Precision: Used for numeric data to determine the precision for calculations and 
presentation. 

Source: A text description of the data source. 

SourceColumnName: The name of the data file column used as the source. 

SourceDataFilePath: The path of the source file used for the data. 

TimeStamp: A time stamp that helps identify when the indicator data was 
provided. 

TimeStampType: The accuracy of the time stamp. One of the following values: 

 None 

 Year 

 Month 

 Day 

Units: The data unit description that is displayed in the Viewer (legend, info-tips, 
etc.). 

For Numeric Indicators the following additional properties are available in the “Not 
Available Values” Category: 

Enable: Indicates if the Null Value will be ignored when publishing, which will 

create a ‘no data’ value. 
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Value to Convert: The value to use as “no data”. 

TIP: To save time, you can select multiple indicators at the same time and then use 
the options to setup the units, description, source and other metadata in one 

operation. 
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Publishing Your Data 

 

Once you have created and configured your Data View, you need to publish the 
data.  If you are using the Data Publisher Window, follow the instructions below. If 
you are using the Map Window > Layer Properties > Interactivity > Thematics Tab, 
see the section on Publishing a map. 

Before you can publish your data, you need to identify the Map Name, and the 
Output Folder to publish the data to. If you have opened the Data Publisher from an 
existing .CVM, these values may already be populated for you based on the .CVM 

settings. 

Click the  button to open the Publish Options Dialog. 

Publish Options 

 

Map Name:  The name of the map the thematic data is associated with. It is used 
for a folder name in the Output Folder. For more information on map name and 

related files, see Map Folder Content. 

Output Folder: This is the folder where Maps are published. Each map will have its 
own sub-folder named according to the Map Name setting. By default, the 

installation directory of CartoVista is: 

C:\Users\Public\Documents\CartoVista4\Maps\ 

To specify a different Maps folder, click on the button beside the text box. 

Relative to the Maps folder, the CartoVista Viewer must be located in one of the 
following 3 directories: 
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1. The same directory 

2. A sub directory called “CartoVista4” 

3. The parent directory 

When you select a new location, the Publisher looks to find the CartoVista Viewer 

(CartoVistaViewer.swf) in any one of the directories specified above. 

If the CartoVistaViewer.swf cannot be located, a warning message is displayed 
below the path and a “Restore Default” button will appear. Click on the “Restore 

Default” button to reset the output folder to the default location. 

 

Once these options are set, use the     Button to create the Indicator XML 

data. 
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Creating & Managing Thematic Analysis 

 

This chapter will cover the following items: 

 Themes Configuration Window 

 Map Display 
 Main Tool Bar 
 Themes List 
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Themes Configuration Window 

 

 

The Themes Configuration Window visually displays the published map and allows 
the user to setup the themes that will be present in the map. In this dialog, the 

user will be able to define all themes exposed to the end user through a drop down 
list. 

It is also possible to create a treeview to classify all those themesets within 
categories/sub-categories, allowing the publishing of an unlimited number of 

themesets. 

The Themes Configuration Window is composed of the following 3 parts: 

Map Display 



CartoVista Publisher Documentation 

312 

Displays the map as published by the Map Window using the CartoVista viewer. The 
user can prepare the themesets using the standard CartoVista functionalities. It is 

also possible to set additional parameters using the layer control, such as the 
opacity and the layers and labels visibility. Those settings are saved for each 

themeset. 

Main Tool Bar 

A toolbar containing options for actions that will be performed with the map. 

Themes List 

Lists the Categories, Sub-categories and Themes present in the map and allows the 

user to select the theme to be displayed by default. 
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Map Display 

 

The Map Display area of the Themes Configuration Window uses the CartoVista 
Viewer to display the map. The interface of the CartoVista Viewer is available to 
interact with the map. 

Use the Add > Thematic Analysis to setup the thematic analysis that will be 

available within the CartoVista viewer.  for any layers that will be displayed 
automatically when the selected Theme is activated. 

All of the CartoVista style options are available in this dialog, and the settings will 
be saved for each map. 

 

It is also possible to define the opacity and visibility settings for each themeset, 

using the layer control. 
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Main Tool Bar 

 

Save 

 

Saves the Map Window, Data Publisher (if any) and the Themes Configuration to 

the Map’s .CVM file. 

Publish 

 

Updates all the Theme’s settings to the Map’s configuration file. 

New Category 

 

To create categories/sub-categories to classify the themesets in a treeview. Those 

themesets are then available in the drop down list of the CartoVista Viewer. 

New Theme Button 

 

Removes any Thematic Analysis from the Map, and creates a new Theme. 

Default Theme 
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Sets the selected Theme as the default theme. This theme will automatically be 
loaded when the Map is viewed in the publisher. 

The list of Themes in the window will display a   next to the Theme name to 

indicate which Theme is the default one. 

Rename 

 

Changes the name of the Theme. 

Move Up 

 

Changes the order of the Themes by moving the currently selected Theme up one 

position in the list. 

Move Down 

 

Changes the order of the Themes by moving the currently selected Theme down on 
position in the list. 

  

Delete 

 

Removes a Theme from the list of available Themes. If the Theme removed was 
also the Default theme, the first Theme in the list becomes the new Default Theme. 
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Themes List 

 

Lists the Themes that will be available in the Map, as well as specifying the order 
that they will appear in the dropdown inside the viewer. 

The list is prepared in the publisher: 

 

And is available in the drop down list treeview in the CartoVista Viewer. 
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Creating & Managing Print Templates and 

Print Layouts 
 

  

 Description and Prerequisites 

 Main Toolbar 
 Template List 

 Print Layout 
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Description and Prerequisites 

 

Description  

The Print Configuration Window is used to design Print Templates that will be 
available to end users in the CartoVista Viewer.  

To access the Print Configuration Window, select the Print Configuration Button in 

the active Map Window. 

 

The Print Configuration Window is composed of 3 parts: 

1. The Main Tool Bar 

2. The Template List Area 

3. The Print Layout Area with 3 menu tabs 
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When the Print Configuration Dialog is launched for the first time, a default Print 
Template will be displayed. The Default Print Template includes the following items: 
a map, a legend, a title and the date. 

If Theme Sets have been previously created using the Theme Configuration Dialog, 

the default Theme Set map will appear as the default Print Template map, along 
with the related legend. 

Prerequisites 

1. You must first publish your map to be able to open the Print Configuration 
dialog and view the initial default Print Template. 

2. If you want your CartoVista Viewer users to have access to the Print 
Templates you have defined, the CartoVista Viewer print option must be 
checked in the Viewer Configuration Dialog. (Map Window – Viewer 

Configuration - General Interface Tab > Print checkbox checked). 
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Main Toolbar 

 

The Main Tool Bar (1) contains a set of options to perform Print Template related 
actions.  

 

Save 

 

The Save command saves the Print Configuration in the Map Window’s .CVM file. 

Publish 
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The Publish command updates all the Print Settings in the Map’s configuration file. 
This command should be issued before publishing your map if you want your Print 

Templates available in the CartoVista Viewer. 

New 

 

The New command creates a new blank Print Template. 

Set as Default 

 

The Set as Default command sets the selected Print Template as the default 

Template. The Default Template will be the initial Print Template loaded when the 
Save and Print action is launched in the CartoVista Viewer. 

The    displayed next to the Print Template name indicates which template is 

the default one. 

Rename 

 

The Rename command allows you to rename the selected Print Template. 

Move Up 

 

This action will change the order of the selected Print Template Up one position in 
the template list. 

Move Down 
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This action will change the order of the selected Print Template Down one position 
in the template list. 

Delete 

 

The Delete command removes the selected Print Template from the list of available 
Print Templates. 

If the removed Print Template was the Default Print Template, the first Print 

Template in the list becomes the new Default Print Template. 

Manage Images 

The Manage Images button will access an image management system. You can add 

numerous images links in the image management system (e.g. Logos, photos). 
Stored image links can easily be retrieved and the associated image inserted as a 
Content Item in the Print Layout via the Content Tab > Content > Insert Image 

tool. 
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Template List 

 

This area (2) lists the created Print Templates.  

The listed Print Templates can be individually selected for editing in the Print Layout 

area. 

The Print Templates are listed in the order they will display in the CartoVista Viewer 
dropdown list available in the Save and print dialog. The management of list is done 

using the commands within the Main Tool Bar. 
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Print Layout 

 

The Print Layout area (3) displays the Layout of the Print Template selected in the 

Print Template List (2). 

 

Each Print Layout can be customized using the tools available within the Layout, 

Content and Pages Tabs. These tools provide extensive design options to prepare a 
customized Print Template for your CartoVista Viewer users. 

Layout Tab 
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The Layout Tab is used to define the paper sizes and orientations available in the 
Print Template. 

Each Print Template can include one or several pre-defined or custom paper sizes 

and orientation settings. 

Edit Paper Size 

This tool lets you edit any of the custom paper sizes previously created. 

Note: Provided Default Paper Sizes Can Not be edited. 

 

  

Add Paper Size 

This tool lets you add an existing default paper size and orientation setting or lets 
you create a new custom one. 

To create a new custom setting scroll down the Paper Size Option and select the 

‘custom’ item from the list of available settings. 

Tip: To create a new custom setting based on the values of a default setting, select 
the default setting item first and then select the custom item.  
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Paper size settings are inherent to the current Print Template. Therefore, new and 
custom Paper Size Settings are not duplicated when a new Print Template is 

created. 

Delete Paper Size 

This tool lets you delete any of the listed Paper Sizes Settings. This only impacts 
the Settings included in the Print Template being edited. If you create a new Print 

Template, all default paper sizes settings will be available. 

Tip: If you delete a default setting by mistake, you can add it again using the Add 
Paper Size button (+) 

Locking actions 

 

Checking this box will let the CartoVista Viewer user see the defined page margins 

associated with this Print Template. 

 

This checkbox defines if the CartoVista Viewer user will be allowed to create new 

paper sizes when printing from the CartoVista Viewer. 

 

The Default Paper Size check box specifies which paper size will be used by default 

when loading the Print Template in the CartoVista Viewer. The paper size checked 
by default is the Letter-Landscape size. 

To change the default paper size, you simply need to choose another paper format 
and check the Default Paper Size checkbox. The checkbox will then be greyed out 

for that specific paper size. Only one paper size can be defined as the Default Paper 
Size for each Print Template. 

Content Tab 

The Content Tab is used to define items that will be displayed in the Print Template. 

The Insert Drop Down 
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The Insert Drop Down lists the items that can be inserted in your Print Layout: 

 Map 
 Text Box 

 Date 
 Date and Time 
 Map Title 

 Page Count 
 Page Number 

 Scale Bar 
 Metadata (Sources) 
 Image 

 Legend 
 Graph (if a graph is opened in the CartoVista Viewer) 

 Table (if a table is opened in the CartoVista Viewer) 

Note:  The same type of item can be included several times in the Print Template. 

  

Specific Graphic Design Tools 

Once inserted in your layout each item has a specific graphic design tools set to 

allow you to customize the item within the layout. 

General Content Locking Action 

The User can insert content box allows you to define whether or not content can 
be added by the CartoVista Viewer user in this Print Template. If the box is 

unchecked, the CartoVista user will not be able to add content. If checked he will be 
allowed to add content. 

Item Locking Actions 
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You can apply specific locking action to your items. Item locking actions are 
intended to reduce or increase the capabilities of the CartoVista user to modify the 

Print Template.   

It is possible to lock the position and size of an item in the CartoVista Viewer. If the 
Lock position and size box is checked, the CartoVista Viewer user will not be able 

to change the position and the size of that item in this Print Template. 

Item editing locking actions such as Text Lock and Style Lock can also be applied. 

Note: You can activate or deactivate item locking settings on previously placed 
items. To do so select the placed item and set the required lock setting. 

"Horizontal" and "Vertical" margins Options 

The size and positioning of the content items are automatically adjusted when 
paper settings are changed. 

"Horizontal" and "Vertical" margins Options are available to define the positioning of 

each item in the template when changing the paper size. 

 

Horizontal: 

  - Margin Left and Fixed Width: The left margin remains unchanged, and the 

width of the item is fixed. The size of the right margin will automatically change 
when changing the paper size. 

  - Margin Right and Fixed Width: the right margin remains unchanged, and 

the width of the item is fixed. The size of the left margin will automatically change 
when changing the paper size. 

          - Margin Center and Fixed Width: The item remains centered on the page, 

and its width is fixed. The size of the right and left margins will automatically 
change when changing the paper size. 

          - Margin Left and Right: The margins remain unchanged. The size of the 
item will automatically change when changing the paper size. 

Vertical: The options for the Vertical Margin work as for the Horizontal option, but 

are applied in relationship to the top and bottom margins. 

Pages Tab 
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This tab is use to add and delete additional pages to your Print Template. 

Add a page 

This tool adds a new page to the template. Newly added pages are based on the 

Start Page (Master Page). By default the Start Page is empty. You can design you 
Start Page as required prior to adding a page and subsequently added page will 
duplicate the Start Page.  To access the Start Page scroll down the Page: drop down 

list. 

Newly added page can be further modified if required using the design tools 
available. 

Delete a page 

The delete page icon allows you to remove the active page from your page set. 

Note: You cannot remove the Start Page and at you will not be able to remove all 
pages. At least one page must remain in your Print Template. 

Previous Page - Next Page 

You can navigate among your pages using the page drop down list or by using the 
arrow keys. 

Page Locking Action 

 

The option "User can add or delete pages" defines if the CartoVista Viewer user can 
add a page or not to the Print Template. If the box is unchecked, the end user will 

not be able to add pages. If the box is checked he will be able to add pages in this 
Print Template. 
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Creating & Publishing Tiled Base Maps 

 

Introduction 

The mapping concepts section presented some of the key benefits or using raster 
tiles as part of your web mapping deployment strategy. 

The CartoVista Publisher offers the capacity to package a multitude of map layers 

into your own custom tile base map. Using your GIS data layers (vector or raster), 
you can create your own tile maps with advanced cartographic styles. The publisher 
tile module also features advanced labelling parameters and extended styles to let 

you create atlas quality base maps. 

Chapter Content 

This chapter introduces the concept of tile windows and how to set up and create 

your own tile layers with the CartoVista Publisher. 

 Choosing an Appropriate Tiling System 
 Considerations for Creating Tiles 
 Creating a Tile Map Window 

 Working with a Tile Map Window 
 Toolbar 

 Map Tools 
 Menu 

 Tile Window Layer Glow Effects 

 Understanding Tile Numbers 
 Generating Tiles 

 Tile Generation Dialog 
 Tile Output Content 

 Displaying Your Tile Map in CartoVista 

NOTE: The Tile Publisher Module is an Add-In to the standard CartoVista Publisher. 

It requires the purchase of an additional license in addition to the license for the 
Publisher. 
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Choosing an Appropriate Tiling System 

 

CartoVista supports the following two types of tiling systems. You have to choose 
the type of tiling system to use when you create your tile map window. 

Spherical Mercator Tile System 

This type of tile system, known as the EPSG code 3857, is based on the World 

Mercator Projection and was popularized by tile map providers, including: 

 Google Maps 
 Bing Maps 
 Yahoo Maps 

 Open Street Map 
 Blue Marble 

 Cloud Made 
 ESRI ArcGIS Server Tile Cache 

The term Spherical Mercator is used to refer to the fact that these providers use a 

Mercator projection which treats the earth as a sphere, rather than a projection 
which treats the earth as an ellipsoid. This affects calculations done based on 
treating the map as a flat plane, and is therefore important to be aware of. 

In order to be entirely compatible with the tile providers above and properly overlay 

data on top of these maps, it is necessary to use this projection specifically. 

TECHNICAL NOTE: 

Projections in GIS are commonly referred to by their “EPSG” codes, 

identifiers managed by the European Petroleum Survey Group. One 
common identifier is “EPSG:4326”, which describes maps where 

latitude and longitude are treated as X/Y values. Spherical 
Mercator has an official designation of EPSG:3857. However, 

before this was established, a large amount of software used the 
identifier EPSG:900913. 

The World Spherical Mercator Projection is expressed with the 
following proj4 expression: 

+proj=merc +a=6378137 +b=6378137 +lat_ts=0.0 

+lon_0=0.0 +x_0=0.0 +y_0=0+k=1.0 +units=m 
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Tiles maps created with the Spherical Mercator system share a common number of 
zoom levels, which are established with the same origin. The tile system is 

composed of tiles (images) of 256 x 256 pixels. 

The Global Extents for the Spherical Mercator are the following: 

 XMin: -20037507.0671618 
 YMin: -19971868.8804086 

 XMax: 20037507.0671618 

 YMax: 19971868.8804086 

Please note that in the Mercator Coordinate system, the map scale associated with 
a zoom level depends on the latitude. For example, the nearest equivalent to a 

1:50,000 map is zoom level 13 (nominally 1:54,000 at the equator, but 1:27000 at 
latitude 60). 

Compatibility with existing tile providers 

You can choose to use the Spherical Mercator tiling system if you want your map 

tiles to be compatible with common map providers such as GoogleMaps, Bing Maps, 
 OpenStreetMaps and others. This is very useful to provide alternative tiles in the 

case where one provider is not available or does not provide enough details for an 
area of interest. 

When you choose this tiling system the Tile Map Window that you create uses the 
Spherical Mercator Projection with specific zoom levels. The vector data in your 

map is automatically reprojected properly to the Spherical Mercator projection. 

Zoom Levels and Coverage 
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On zoom level 0 (the lowest zoom level, in which the entire world can be seen on 
one map) there is only one tile containing the whole map. On the next zoom level 

this tile gets divided into 4 subsections, which form the next zoom level. Therefore 
on zoom level 1 you have 4 tiles and so on. 

The number of tiles per zoom level can be calculated as follows: 

Number of tiles per zoom level= 4^zoom_level 

That means on zoom level 20 there are 1,099,511,627,776 tiles ! 

You can choose the zoom levels you need to generate using the Tile Generation 

Dialog. When defining the coverage (by rectangle, polygon or a GIS file) and which 
zoom levels your tiles will provide, it is also important to consider the storage and 

processing requirements. 

CartoVista Tiling System 

The CartoVista tiling system is used when you want to work with a projection that is 

different from Spherical Mercator. The tile system is specifically composed of tiles 
measuring 256x256 pixels. 

This tiling system is defined using the following parameters: 

 The map coordinate system (projection) 

 The map extents (minx, maxx, miny, maxy) for the tile base map 
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 The number of zoom levels (the maximum zoom level) 

Map Extents (Base View) 

The map extents (base view) is the most important parameter as it defines the 
origin of the tile system. The first zoom level is defined as a tile of 256x256 pixels 
that covers the extent specified as the base view. 

When establishing the base view, a buffer zone of about 20% is added for thee first 

tile, to enable zooming and panning around the map edges. You can display the 
base view as well as the tile grid and tile numbers directly in the publisher. 

 

Zoom Levels 

Like with the Spherical Mercator Projection, for each new zoom level in the 
CartoVista Tiling system, there are 4 times more tiles then the previous one. 
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The following table shows how the number of tiles grows exponentially with the 
zoom level (without applying any coverage restrictions). 

Zoom level Number of tiles 

0 1 

1 4 

2 16 

3 64 
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4 256 

5 1,024 

6 4,096 

7 16,384 

8  65,536 

9  262,144 

10  1,048,576 

11  4,194,304 

12  16,777,216 

13  67,108,864 

14  268,435,456 

15  1,073,741,824 

16  4,294,967,296 

17  17,179,869,184 

18  68,719,476,736 

19  274,877,906,944 
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Considerations for Creating Tiles 

 

The CartoVista Publisher is designed to create tile images as fast as possible. It is 
capable of generating about 30 tiles (images) per second on a typical desktop 
computer workstation. The time it takes to generate tiles is highly dependent on 
the number of features and complexity of the cartographic rendering (labelling, 

etc.). 

When you are creating tiles with the CartoVista Publisher it creates images locally 
or on a network drive. The folders created are setup in a structure that is optimized 

for data access. 

Portable Network Graphics (PNG) 

Map tile images created with the CartoVista Publisher are saved in Portable Network 

Graphics (PNG) format, which is optimized for usage on the web. As PNG supports 
transparency, it is also possible to setup a transparent color in the output. This is 
very useful in particular if you plan to overlay different tile layers on top of each 

other. 

Plan the number of images to generate and the required 
storage 

As you define the number of zoom levels and geographical coverage of the tile 
 map you are creating, it is very important to understand the number of tile images 

that will be generated as well as the storage space that will be required for them. 

As you design your tile map, you have to establish the maximum level of details 
you want to provide. A fundamental question to ask is "Do you really need all zoom 

levels?". The number of zoom levels required depends on the nature of the map 
you are producing and the requirement for the end user to understand and make 
use of the map's geographic context. Every additional new zoom level you include 

adds a considerable number of tile images to the output. 

The size of each individual tile images depends on the complexity of the map tile in 
terms of the number of map features and content (colors, redundancy, etc.). 

The following table outlines some sample tiles and their associated size in kilobytes. 

Tile Image Description Size (Kilobytes) 
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Vector map with 
homogenous content 

(mostly water, some 
land) 

12 KB 

 

Vector map with 
moderate content 

(water, land, map 
labels, etc.) 

37 KB 

 

Vector map with dense 
content (streets, water, 

land cover, etc.) 
55 KB 
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Vector map (street 
level) with dense 

content (streets, water, 
land cover, etc.) 

73 KB 

 

Aerial photography 
(Grey scale) with a low 

density 
86 KB 

 

Aerial photography 
(Color) with a low 

density (Mostly water) 
109 KB 
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Aerial photography with 
a medium density 

(medium number of 
colors) 

114 KB 

 

Aerial photography 
(Satellite view) with a 

high density (high 
number of colors) 

196 KB 

The following table outlines the number of tiles per zoom level and associated 
storage size (in kilobytes) for a North American tile dataset in Lambert Conformal 
Conic, for zoom 0 to 7. 

Zoom 
level 

Number of 
tiles 

Total Tile size 
(kb) 

Total Tile size 
(mb) 

Average tile size 
(kb) 

0 1 45 0.05 45 

1 4 210 0.21 52 

2 16 800 0.8 50 

3 64 2,500 2.5 41 

4 256 9,600 9.6 35 

5 1,024 24,000 24 24 

6 4,096 54,000 54 13 

7 16,384 136,000 136 8 
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The Count Tiles Button 

The Count Tiles Button in the Tile Generation Dialog is a very useful way to 

determine how many tiles will be created, without actually generating them. To get 
the count, simply open up the dialog and click on the Count Tiles button. The count 
is displayed in an information window. 
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Creating a Tile Window 

 

You can create a tile window using one of the following 4 methods. 

1. Open an existing .CTM 

This can be done in 3 different ways: 

 From the main menu, select the option File -> Open. A dialog is 
displayed to let you choose the .CTM file that corresponds to the map 

you need. 

 By double clicking on a .CTM file in Windows Explorer 

 By dragging and dropping a .CTM file in the publisher (in a free area) 

Once the .CTM file is selected, the tile map window is opened with the 
configurations that were previously saved in the .CTM. 

2. Convert an existing .CVM or .CSM file 

After opening a .CVM or .CSM file, you can use the menu File - > Convert To - > 
Tile Window. 

A dialog is displayed to specify a name and location for the new .CTM file that will 

be created from the .CVM or .CSM file specified. Once this step is done, the tile map 
window is displayed with the configurations of the original file. If the map is not in 
the Spherical Mercator projection, the projection selection dialog is displayed to let 

you choose the type of tiling system you want. 

 NOTE: 

The configurations of a server map window and a tile window being 

different, there are some attributes and parameters of the .CVM or 
.CSM that may not be transferred in the new .CTM. In reverse, 

some of the parameters of the new .CTM that are not part of a 
.CVM or .CSM will have to be configured for the map tile window to 

work properly. 

  

3. Create a new map tile window from the layer selection 
dialog 
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This can be done in the following 3 ways: 

 From the main menu, choose the option File - > New - > Tile Window 

 By right-clicking in a free area of the map source manager and 
choosing the option New Tile Window. 

 By pressing the F4 key. 

After executing one of the above, the layer selection dialog is displayed. From this 
dialog, you can select map layers that are already loaded in the map source 

manager and add them to your tile window. For more information, see the Layer 
Selection Dialog. 

 

4. Create a new tile window from cartographic sources in 
the map source manager 

This can be done one of the following 3 ways: 

 By dragging and dropping one of more sources (GIS files, etc.) from 

the map source manager in a free area while pressing the ALT key. 
 By right clicking on one or more sources that are selected in the map 

source manager and choosing the option "New tile window". 

 By dragging and dropping one or more selected layers from an existing 
tile window in a free area of the publisher. 

For the first 2 methods, the projection selection dialog is displayed if the selected 

layers are not in the Spherical Mercator projection. If the third method is used, the 
projection of the tile window (where layers were selected) will be maintained. 
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NOTE : 

NOTE: It is not possible to include a layer based on a Tile Map File 
in a Tile Window. If you try to convert a Map Window that includes 

a Tile based layer, that layer will be removed from the Tile 

Window. 

  

Tile System Coordinate System Selection Dialog 

The first time a new Tile Window opens, you will be prompted to select the 
projection to use. 

 

If you choose to use the Global Spherical Mercator, the Tile Window will use the 
Spherical Mercator Tile system. If you select any other projection, the Tile Window 
will use the CartoVista Tile System. For more information on these tile systems, see 

the section on Choosing an Appropriate Tiling System. 
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Working with a Tile Window 

 

Tile Windows allow you to create a tiled base map that you can use in the 
CartoVista Viewer. 

The Tile Window is composed of the following 4 elements: 

Map Display 

Displays the map as determined by the layers seclected and the style and other 
settings applied to each layer. 

Main Tool Bar 

This tool bar contains the options to access the Tile Generation Dialog, the Set Base 
View Dialog (if using the CartoVista tiling system) and the Tile Coverage Dialog. 

Map Tool Bar 

A toolbar containing options for navigating, altering the map. There are also tools 

for defining the geographical coverage of the tiles, selecting the current zoom level 
and displaying additional boundary outlines for the tiles. 

Layer Control 

Lists the layers present in the map and allows the user to adjust the settings used 
for each layer. For more info see Layer Control. 
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Tile Window Main Toolbar 

 

Save Button 

  

The save button saves the current Tile Map to a .CTM file. When you save a .CTM 
file, you save all of the parameters of the tile map, including the base view and the 

attributes required to recreate the tile window. You are not saving the underlying 
GIS files, simply a reference to where they are located. 

If you want to give someone a copy of your map, ensure they already have the GIS 

files loaded into CartoVista publisher with the same names, or include the source 
GIS files in the package you transfer to them so they can add them. 

Generate Tiles Button 

  

The Generate Tiles Button opens the Tile Generation Dialog to create the tiles, 
based on the parameters you have established. 

Set Base View Button 

  

The Set View Button opens accessing the Set Base View Dialog to define the base 

view of your tile system and the extents (limits) of your tile data set. The first zoom 
level (zoom 0) and other zoom levels are established based on the scale of the base 

view. 

NOTE : 

This button is only available when the map is using the CartoVista 

Tile system. When the tile system is Spherical Mercator, the base 
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view is the entire world and cannot be changed. 

  

Set Base View Dialog 

  

Calculate using current map 

Sets the base view extents to the extents currently displayed in the map display. 

Bottom Left Corner 

Manually sets the X and Y coordinates of the bottom left corner of the base view 
extents. 

Top Right Corner 

Manually sets the Y and Y coordinates f the top right corner of the base view 

extents. 

Coverage Button 

 

The Coverage Button opens the Tile Coverage Dialog. This dialog is used to define 

the coverage of your tiles. The active source of the coverage is identified on the 
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button (Current view, user draw, from file). The coverage area is displayed as a 
dashed blue line on the map display. 

Tile Coverage Dialog 

  

Allows you to specify how the geographic coverage will be determined. There are 
three options available: 

1. Current View: the extent of the current map display is used as the coverage 
zone. 

2. User Draw: you must manually draw the coverage on the map display using 
one of the three drawing tools available in the Map Toolbar. 

3. From File: you define the geographic coverage via a GIS file (ESRI Shape File or 
MapInfo .TAB). The GIS file can contain multiple objects of different type (polygons, 

lines or points). For a tile to be generated, at least one pixel of the tile must overlap 
an object in the GIS file. 

NOTE : 

In order for a tile to be included, all that is required is that 1 pixel 
of the tile be overlapping with the coverage zone. 
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Tile Window Map Tools 

 

Map Navigation Tools 

Zoom In Tool 

 

Display a closer view of the map. 

Use this tool to display a closer view in the current map. 

 Select this tool from the tool bar. 

 Click on the map to zoom-in. 
 The map is zoomed-in by a factor of 2. 

  

NOTE : 

Tile windows are behaving differently than normal windows for 
zooming. It is not possible to define a custom scale in a tile 

window. The map scales are fixed based on the defined zoom 
levels and the selected tile system. 

  

TIP: You can also draw a rectangle on the map (click and drag) to 

closely define the area you want to zoom to. 

Zoom Out Tool 

 

Display a wider view of the map. 

Use this tool to display a wider view in the current map. 

 Select this tool from the tool bar. 

 Click on the map to zoom out. 
 The map is zoomed-out by a factor of 2. 
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Pan Tool 

  

Recenter the map. 

Use this tool to re-center the current map. 

 Select this tool from the tool bar. 
 Click and drag the map to recenter. 
 Once the map is recentered as you need it, release the mouse. 

Change View Tool 

 

Change the current map view by entering coordinates. 

The Change View tool is used to access the Change View Dialog to set the view of 
the Map. 

View Entire Layer Tool 

  

Set the map view to the extent of a map layer. 

Use this tool to access the view entire layer dialog to set the map bounds to the 
extent of a specific layer. 

View Entire Layer Dialog 
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To set the map view to all layers in the map window, select <<ALL LAYERS>>. 

To set the map view to a specific layer, select it from the list and click on the Zoom 

button. 

Map Settings Tool 

 

The Map Settings tool is used to access the Map Settings dialog to set the title, 
coordinate system and dimension (width and height) of the map. 

Info Tool 

 

Use this tool to get attribute information about map features. 

Select this tool from the tool bar and click on a map location. The info tool window 
displays a list of all objects at the location of the click. 

Info Tool Window 
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If you have only selected a single object from the map, the field names and values 
for that object are displayed. If the location you clicked has multiple objects (same 
layer or different layer) the Info Tool window displays a list of objects at the top of 

the dialog. Selecting the different objects updates the fields/values to the selected 
object. The status bar at the bottom tells you exactly how many objects have been 

selected from how many layers in the Map Window. 

Coverage Drawing Tools 

 

Drawing the Tile Coverage Area 

When the Tile Coverage option is set to "User Draw", these 3 drawing tools become 

available to define the tile coverage area. The first tool draws a custom polygon for 
the coverage. The second one draws a rectangle. The last tool deletes the coverage 

that was drawn. 

The coverage region will be displayed in the Map Display with no fill and a dashed 
blue stroke. 

Display of scale / zoom width 

Depending on the application preference setting, either the map scale (e.g. 1: x) or 

the Map Width (e.g. x Kilometers) will be displayed after the drawing tools. 
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Zoom Level 

This drop down list displays the current zoom level of the tile map. You can also 

pick from the list to go directly to a specific zoom level without using the zoom tools 
or the mouse wheel. 

Tiles Grid Button 

This button toggles the display of tile outlines at the current zoom level. When 
enabled, each tile’s boundary is displayed with a light blue outline. 

Base View Extent Button 

This button toggles the display of the base view’s extent for the tile system. When 

enabled, the base view is drawn with a red outline. 

Tile Number Button 

This button toggles the display of identifiers for each individual tile displayed. The 

identifier includes the zoom level, row and column numbers.  See Understanding 
Tile Numbers for more information. 
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Tile Window Menu 

 

The Tile Window menu is accessible from the main menu and is present when a tile 
window is the active window. 

Layer Selection... 

Opens the Layer Selection Dialog. See the Layer Selection Dialog section for more 

information. 

Change View... 

Opens the Map View Settings dialog for the current map view. See the Change View 

dialog for more information. 

Previous View 

Returns the map display to the previous zoom/scale and location. If you have not 
moved/panned or otherwise changed the view of the map, this has no effect. 

This option is also available in the popup menu available when you right click in the 
map display. 

View Entire Layer... 

Opens the View Entire Layer Dialog. See the Map Tool Bar for more information. 

Settings 

Opens the Map Settings dialog. 

Set Base View 

Opens the Set Base View dialog to define the base view for your tiles. 

Set Coverage 

Opens the Tile  Coverage Dialog to establish the area covered by your tiles. 

Generate Tiles 
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Opens the Tile Generation Dialog to start generating your tile images. 
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Tile Window Settings 

 

 

This dialog lets you set the size, dimensions and the coordinate system of the tile 
map if using the CartoVista tiling system. 

This dialog can be accessed by choosing Tile Window > Settings from the main 

menu, clicking on the Settings tool button in the Tile Window’s Map Toolbar    or 

by right clicking in the map window and selecting Tile Window Settings from the 
popup menu. 

Size 

In the CartoVista Publisher, the map size is defined in pixels. 

To enter a specific map size in pixels, enter values in the map size width and height 
text boxes. 

NOTE 1: If you resize the map window in the CartoVista Publisher, the width and 

height in pixels also change. To prevent accidentally resizing the window, you can 
Lock the Size of the Map Window. 
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The Lock Size option fixes the map dimensions when enabled. By default, 
CartoVista does not lock the map size. When you resize the map window in the 

publisher, the size of the map in pixels changes. When the Lock Size option is 
enabled, you will not be able to change the size of the map window. 

Window 

The Window section allows you to edit the settings that apply to the Tile Window in 
general. 

Map Window Display Units 

This defines the units used to display linear information such as the map width. 
Choices are: inches, feet, miles, meters, kilometers. 

Background Color 

This defines the color that is in the background of the map. Choose a color with the 

color picker. The default background color can also be specified in the Tools and 
Preferences Dialog - Map Window Settings Tab 

Show Scalebar in Map Window 

This checkbox allows you to display a scale bar in the bottom left corner of the Map 
Window. The scale bar will only show inside the Tile Window. 

Projection 

The Projection section displays the currently selected coordinate system for the Tile 

Window. 

The coordinate system information is dependent on the Publisher application 
settings. (see Tools and Preferences - Projection Settings) There are three ways 

that the information could be presented: Well Known Text (WKT), PROJ4, or a User 
Name. 

If you want to change the map coordinate system, you can click on the Set... 

button to display the Coordinate System Selection dialog and choose a new 
coordinate system. 
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NOTE 1: You can also change the coordinate system by dragging a coordinate 
system from the Coordinate System Manager and dropping it directly onto the Tile 

Window. 

NOTE 2: You can only change the projection is you are using the CartoVista Tiling 
System. 
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Tile Window Layer Glow Effects 

 

Special glow effects have been added to Polygon and Polyline layers in the Tile 
Window. These effects supplement the stroke of the geometry, and provide 
additional effects. The settings are in the Layer Properties dialog in the Style tab. 

 

With no effect, the polygon will look as shown below: 
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Drop Shadow: Check to enable a drop shadow around all the geometries in the 

layer. 

 

Outer Glow: Check to enable a glow effect around all the geometries in the layer. 
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Inner Glow: Check to enable a glow effect around the inside of a geometry’s 
border. For Polylines, the effect is more noticeable with thicker stroke widths. 

 

The following parameters apply to one or more of the effect types: 

Color: Defines what color the effect should be drawn with. 

Opacity: Controls the opacity of the effect when it is composited 

Size: Sets width of the pen used to draw the effect when it is being drawn 

Strength: Configures the amount of blur to apply to the pen being drawn 

Knockout: Instructs the compositor not to fill the polygon area. This should be left 

disabled unless working with transparent fill or stroke patterns (Not applicable to 
inner glow) 

Distance: The number of pixels the drop shadow should be displaced relative to 

the source geometry (Only applicable to drop shadow) 

Angle: The angle the shadow should be moved relative to the source geometry 
(Only applicable to drop shadow) 
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Understanding Tile Numbers 

 

 

A tile number is a unique identifier for each a tile, composed of the zoom level, the 

column and row in the tile grid. When activated, the tile number is displayed in the 
upper left corner of each tile. 

The tile number has a different meaning depending on if you are using the 
Spherical Mercator tile system, or the CartoVista Tile System. 

If you are using the Spherical Mercator Tile System, the tile numbers (zoom level, 
column and row) are absolute. In this tile system, the tiles for a specific area 
always have the same number. The Spherical Mercator projection organizes the 

world into a square system where each hemisphere is a quadrant. The first zoom 
level shows the entire world on one tile. On the next levels, the first column is east 

of the longitude 180°W while the number grows eastbound (to the right of the 
map). The first row goes from latitude 90°N, the numbers increasing southbound 
(to the bottom of the map). 

If you are using the CartoVista Tiling System, the zoom level, column and rows are 

relative. These are established from the Base View that the user has defined with 
the Tile Map. The first zoom level contains the entire base view in one tile and the 

first columns and rows are setup at the top left corner for zoom level 1 and beyond. 

NOTE : 

The first zoom level, the first column and the first row are 

numbered as 0 (zero). In the image above, the tile is then located 
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at column 1187 and row 1467. 
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Generating Tiles 

 

Once you Tile Map has been created and is properly configured, you can start 
generating tiles. 

You can access the Tile Generation Dialog by clicking on the button "Generate Tiles" 

in the tile window or by selecting from the top menu - >Tile Window - > Generate 
Tiles. 

 

The Tile Generation Dialog is then displayed to configure the output (folder, zoom 
levels, etc.) 
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Tile Generation Dialog 

 

 

Output Folder 

The path (folder) where the tile images will be created and stored. This can be 

either local to the computer, or accessible via the network. 

Zoom Levels 

Defines which zoom levels the tile images should be created for. 

 The "All" and "None" buttons turn on or off all zoom levels with one 

click. 
 The buttons in the toggle group change the state (on to off, or off to 

on) of specific zoom levels all at once. (0 to 3, 0 to 9, 0 to 15 and 0 to 
19). Each time you click, the specified zoom levels are toggled. E.g. If 

all zoom levels are off, and you click 0-9, then zoom levels 0 through 9 
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will be toggled on. If you then click 0-3, zoom levels 0, 1, 2 and 3 will 

be toggled off, leaving only levels 4 through 9 toggled on. 

 The check boxes from 0 to 20 allow you to manually turn on or off any 
zoom level. The zoom levels turned on to generate do not have to be 

consecutive. 

Count Tiles Button 

Calculates the number of tile images that will be created based on the selected 

zoom levels and the current coverage zone. The count is displayed in an 
information window. 

 

Export Options 

This zone allows to specify the last parameters before proceeding with the tile 
creation process per say. 

Override Existing Tiles 

When checked, overwrites any tile image that has the same tile number in the 
output folder. 

Set Map Background as Transparent 

Sets areas where there are no features to be transparent. When using this option, 

layers that are below the tiles can still be seen because of the transparency. Unless 
overridden by the Set Transparent Color option, the background color for the Tile 

Window is used as the transparent color. 

Set Transparent Color 

Enables the manual selection of the color used as the transparent background. Use 
the color button at the end of the line to pick the desired color. 

Create CartoVista Tile Set XML File 
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Enables the creation of a CartoVista Tile System XML configuration file. For more 
information see Tile_System_Configuration_File 

Add Tile Layer to Map Source Manager 

Automatically adds the Tile Set created to the Map Source Manager when tile 
generation is completed. 

Generating Tiles 

 

When all of your configurations are completed, you click on the "Generate" button 

to create the tile images. A progress dialog is displayed to indicate the status of the 
tile creation process. It is possible to cancel the process by clicking on the cancel 

button. At the end of the process, if the option "Add Tile Layer to Map Source 
Manager" was selected, a dialog is displayed to enter a name for the tile data set. 

NOTE : 

Generating map tiles can be a tedious process. 

It can take a few minutes to several hours, depending on: 

 Your system performance 
 The number and complexity of your map layers (number of 

features, labeling, rendering, etc.) 
 The number of zoom levels (closer zoom levels generating a 

lot more tiles). 
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Tile Output Content 

 

Output Folder 

The folder you choose as the output for your tiles contains all you need to enable 
the display of the tile layer in a CartoVista application. 

The output directory includes a sub-folder for each of the zoom levels you have 

created and the CartoVistaPublisherTileSettings.xml file. 

 

The tile images are stored within each of these directories, in a folder structure that 
is optimized for data access. 

Tile System Configuration File (XML) 

When creating tiles, the tile output folder also includes an XML file at the root called 
CartoVistaPublisherTileSettings.xml. 

This important file includes the definition of the map tiling system, including: 

 The map coordinate system (Proj4 format) 

 The tile system extent (XMin, YMin, XMax, YMax) 
 The tile system closest zoom (e.g. 12) 

 The tile image extension (PNG, JPG, etc.) 

This file is required by the CartoVista Viewer to load the tile data set and properly 

register your tile coordinate system. 

The following is a sample CartoVistaPublisherTileSettings.xml file for a tile map in 
Canada (Lambert Conformal Conic Projection). 

  

  
<CartoVistaPublisherTileSettings ver="1"> 
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<Proj4><![CDATA[+proj=lcc +lat_1=49 +lat_2=77 
+lat_0=49 +lon_0=-95 +x_0=0 +y_0=0 +ellps=GRS80 
+datum=NAD83 +units=m +no_defs]]></Proj4> 

<XMin>-11705489.2170051</XMin> 
<YMin>-11938897.2470051</YMin> 

<XMax>11323831.6570051</XMax> 
<YMax>11090423.6270051</YMax> 
<ClosestZoom>12</ClosestZoom> 

<TileExtension>PNG</TileExtension> 
</CartoVistaPublisherTileSettings> 

  

  

Procedure to install on a server 

You need to include the tiles in a zip file to deploy them on a web server. Unzip the 
files in a folder, named Tiles for instance. 

You must then open the Internet Service Provider Manager (IIS) and do a right-
click on Managing your website « Add a virtual directory ». You then need to add an 
« alias » (like CanadaTiles) and enter the path to the tiles: c:\Tiles\CanadaTiles.  

  
The tileset can now be added in the publisher, using the following address 

http://mysite.com/CanadaTiles. 
  

To locally deploy the tiles on your computer, you just need to copy them in a local 
directory. You then use the path to the directory instead of the URL to add them in 

the publisher. 
  
To add a Tileset in the publisher, see Adding A Tile Provider in the CartoVista 

Publisher. 
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Displaying Your Tile Map in CartoVista 

 

Once the tile base map is created, it can easily be added to the list of available tile 
providers to quickly create a CartoVista map output. 

To add the custom tile base map you have created, see Adding A Tile Provider in 

the CartoVista Publisher. 

TIP : 

When you generate your tiles, you can use the option "Add tile 

layer to map source manager" in the Tile Generation Dialog to 
complete this automatically. 
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Tools and Preferences 

 

The tools and preferences of the CartoVista Publisher give you information on Bulk 
Publisher Dialog and allow you to setup your working environment by configuring 
the following: 

Tools and Preferences 

 Bulk Publisher Dialog 
 Packaging Maps 

Program Preferences 

 General 

 Map Window 
 Publish 

 Projection 
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Bulk Publisher Dialog 

 

 

The CartoVista Bulk Publisher is a tool to help you automate your map and data 
publishing procedures. 

Once your CartoVista maps (.cvm) and data views (.cvd) are setup and created, 

you can use the bulk publisher to publish all files in a single operation. 

TIP: Only maps and data views that have been published at least once will be 

enabled in the bulk publisher. 

The bulk publisher includes the capabilities to create a list of files and/or directories 
to publish. When adding directories, the process will publish all .cvd and .cvm that 

are inside the specified folder (including all sub-folders). 

Specifying the job content 

Adding Files 
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To add a file to the job you can either: 

 Click on the file (+) icon in the toolbar, or right-click on the files item in the 
treeview and select the Add... menu item. 

 Browse and select the file (.cvm or .cvd) to add 

Adding Directories 

 Click on the directory (+) icon in the tool bar, or right-click on the 

directories item in the treeview and select the Add... menu item. 
 Browse and select the folder to add 

Removing Files or Directories 

To remove a file or directory, select it from the treeview list and click on the Delete 

(X Button) from the toolbar.   

Publishing 

To run a bulk publishing job, click on the Publish button. 

You can also define what to publish by selecting from the list box one of the option: 

 Maps and data (default): Publishes both maps and data (.cvm and .cvd) 
 Maps only: Only publishes maps (.cvm files) 
 Data only: Only publishes data views (.cvd files) 

Saving Bulk Publisher Jobs 

The bulk publisher jobs can be saved in a file (CartoVista Bulk Publisher File with 
the extension .cvb). To save, click on the Save or Save As Button from the tool bar. 

The Bulk Publisher Jobs (.cvb) can be opened again in the tool to regenerate the 

map and data as needed. 
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Packaging Maps 

 

The Package Map tool allows you to transfer a Map that you have created to 
another machine or to another user. The package process creates a .ZIP file that 
contains the .CVM and all the source Map Files that you need. It will also include 
any images that you have used as symbol point style or label backgrounds. 

When the .ZIP file is extracted to a local directory, the .CVM will be able to find all 
the data it needs to recreate the map on the new machine. 

There are two ways to Package a map: 

1. Package an existing .CVM file 

From the main menu, select the Tools > Package Map menu option. A dialog will 

prompt you to locate the .CVM file that defines the map. Once you have selected a 
.CVM file, the map will be packaged into a .ZIP file with the same name as the 
original .CVM file. 

2. Package an open Map Window 

From the main menu, select the File > Package menu option. This option will show 
only if a Map Window is open. A dialog will prompt you to locate and name the .ZIP 
file for the package. Once you have chosen the output location and name, the map 

will be packaged into a .ZIP file. 

If you have changes that you have not saved, you will be prompted to save the Map 
Window prior to the packaging operation commencing. If you do not save a Map 

Window at all, the package will be created, but it will not contain a .CVM file. 

In order to use the packaged map on another computer, simply unzip all the files 
into the same directory. The package command may create additional sub-folders 
within the .ZIP file. Maintain the same directory structure in order to ensure the 

.CVM can find all the required files. 
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Program Preferences 

 

  

This Chapter explains the following items: 

 General 
 Map Window 

 Publish 
 Projection 
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General 

 

 

Language 

The CartoVista Publisher is available in the following languages: 

 English 

 French 

  

To change the language, you just need to select one from the drop down list. 

Map File Directory 

This directory setting is used as the default folder opening and adding map files. 

Default Map File Type 

Choose the default map file type from the list box when opening map files. 

Warning Messages 
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Warning messages are now available to get delete confirmation from users. 3 
checkboxes are available to enable or disable those messages. 
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Map Window 

 

 

Directory for Saving Maps 

The directory specified is the default folder where the CartoVista Publisher saves 

maps (. cvm files). 

Default Measurement Units 

This option allows to choose the default measurement units. Simply select an item 
from the list to change the units. 

Background Color 

This option sets the default background color when creating maps. 

Use "Map Width" instead of Scale 

This option allows to choose what reference to use when specifying scale -
dependant layers and labels. The CartoVista Publisher can work with scale values 
(e.g. 1: 25 000) or map window zoom width (e.g. 500 km). 
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Publish 

 

 

Publish Simplified Configuration File 

Each CartoVista Map that is published contains an XML configuration file. Some of 
the settings that are stored in this file are also stored in the map’s SWF file. By 

checking this option, any optional settings in the XML configuration file are not 
created. 

This setting is disabled by default. 

Maximum Indicator Per Indicator Table 

When publishing data, there is a maximum number of indicators that can be set per 

Indicator Table. Use this setting to adjust the number to a value between 1 and 
1000. 

The more indicators you allow in an indicator table, the bigger the XML data file can 

get, and the longer it will take to download when viewed on the web. The default 
setting of 20 was calculated to allow for a fair number of indicators per table, while 

preventing the XML data file from becoming too large. 
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Projection 

 

 

Projection Display 

You can choose between PROJ and Well Known Text (WKT) display for the 

coordinate system parameters. 

Projection Name 

Check this option to display a “projection name”. Projection names are user 

readable names that can be used to identify specific projections. Projection names 
are also assigned to user defined categories to aid in organizing the projections. 

The CartoVista Publisher comes with over 1400 projections "pre-named". 

If your projection does not have a matching user-defined name, then either the 
WKT or PROJ4 coordinate system information will be displayed depending on the 
setting of the Projection Display drop down. 
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Deploying a CartoVista Solution 

 

This Chapter will explain the following concepts: 

 Deploying a CartoVista Solution 

 The CartoVista Viewer 
 Deploying a Map Locally 
 Deploying a Map on Media 

 Deploying a Map on a Web Server 
 Local & Media Browser Issues 

 Configuring WMS Layers 
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Deploying a CartoVista Solution 

 

The CartoVista Publisher comes with a version of the CartoVista Viewer that you 
can use on the same computer that you installed the Publisher on. This allows you 
to view the published CartoVista solution on the same machine that you installed 
CartoVista Publisher on. 

When the Publisher publishes a Map, it creates a directory in which to store the files 
needed by the Viewer. Publishing data adds additional files to that directory 
containing the data that was published. 

In order to view the CartoVista Solution, the end user simply needs to point his 

browser at the HTML page. This can be a file on his local machine, a file on the 
network, an URL on an internal network or an URL on the internet. 

The HTML page can be the default page created by the Publisher, or it can be an 

HTML page that has the CartoVista Solution embedded into it. This allows complete 
flexibility in how the final map is presented to the end user and the other elements 

on the HTML page along with the CartoVista Map. 

Once the HTML page has been located by the browser, all of the files in the 
CartoVista Solution will be downloaded to the end user’s computer. The map will be 
displayed by the end user’s Flash Player. After the files have been downloaded, all 

processing, updates and rendering are done on the end user’s machine. 
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The CartoVista Viewer 

 

The CartoVista Viewer is installed locally on the computer when you install the 
CartoVista Publisher. This allows you to view published CartoVista solutions locally. 
By default, the CartoVista Viewer is installed in the following folder: 

  

C:\Users\Public\Documents\CartoVista4\ 

NOTE : If you decide to publish your maps on a server (and not locally), you will 

need to manually copy the CartoVista Viewer on that server. The publisher will not 
do it automatically. This means that you will have to ensure you copy the most up 
to date version after each update or upgrade of CartoVista. 

CartoVista Viewer Folder 

This installation folder contains the following files and sub-folders: 

Scripts: Contains JavaScript files to integrate CartoVista in the default HTML 

page and manage the help system. 

Maps: Contains the maps generated by the Publisher. (SEE BELOW) 

CartoVistaViewer.swf: The CartoVista Viewer. 

CartoVistaDrawingTool.swf: The CartoVista Viewer drawing and annotation tools. 

playerProductInstall.swf: A Flash Player minimum version checking routine. If 
the version of Flash Player installed is less than the CartoVista Viewer’s minimum 

required version, the user will be prompted to update the Flash Player 
automatically. 

The following files can also be found in the Viewer Folder. These are all Flash Player 

signed framework libraries from Adobe. They will be downloaded only if the user 
does not have them downloaded already. They are stored in the Flash Player cache 
and will only ever be downloaded once by the Flash Player. 

charts_4.5.1.213284.6.0.23201.swz 

framework_4.5.1.214894.6.0.23201.swz 
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mx_4.5.1.214894.6.0.23201.swz 

spark_4.5.1.214894.6.0.23201.swz 

sparkskins_4.5.1.213284.6.0.23201.swz 

textLayout_2.0.0.2322.0.0.232.swz 

Maps Folder 

Each map that is published by CartoVista is stored in a sub-folder of the Maps 

folder. By default, the Maps folder is expected to be a sub-folder within the 
CartoVista Viewer folder. 

The Publish Map Options dialog will let you specify a different folder for the Maps 

folder. However, relative to the Maps folder, the CartoVista Viewer must be located 
in one of the following 3 directories: 

1. The same directory 

2. A sub directory called “CartoVista 4” 

3. The parent directory 

NOTE: When you publish a Map, the configuration file created and the default HTML 

page created will adjust their settings to properly identify where the CartoVista 
Viewer is located. If the Viewer is not located as specified in the configuration and 
HTML files, the HTML page will be unable to load the Viewer. 

A published map’s folder contains the following files and sub-folders: 

ThematicData: Contains the thematic data XML files generated by the Data 
Publisher. 

<MapName>.html: A default HTML page that can display the map. 

<MapName>.swf: The map SWF file. 

<MapName>Config.xml: An XML configuration file for the map. 

<MapName>Thematic.xml: (OPTIONAL) An XML configuration file for the 
thematic data. This file will not be present if data was not published with the map. 
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Deploying a Map Locally 

 

If you have purchased a depolyment license of CartoVista, you can make a 
CartoVista solution available from your computer. 

 Setup your computer’s web server to allow access to the HTML page in the 
Maps\<MapName> folder as the URL you wish your solution to be available 

from. 

OR 

 Setup your computer to allow access to the HTML page in the 
Maps\<MapName> folder on your computer. 

Your CartoVista solution will now be available on your network. A user simply need 

to point his browser at the URL or folder you have created. 
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Deploying a Map on Media 

 

If you have purchased a deployment license for the CartoVista Viewer, you 
can make your CartoVista solution available on a CD-Rom, DVD or even a 
USB drive. 

When deploying to media, it is advisable to use the 3rd method for placing the 

CartoVista Viewer - a sub folder called “CartoVista4”. This way the HTML page that 
hosts the CartoVista solution easily found at the top of your deployment. 

You can deploy the CartoVista solution to the root folder of your media, or to any 
sub folder. 

1. Choose the root folder of the deployment on the media. 

2. Copy the files from the MAPS\<MapName> folder to the root folder. 
3. Copy the files from the CartoVista4 folder to a sub-folder called “CartoVista4” 

in the root folder. 
4. Distribute your media. 

In order to view your CartoVista solution, a user simply needs to point his browser 

to the HTML page in the root folder of your deployment. 
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Deploying a Map on a Web Server 

 

If you have purchased a deployment license for the CartoVista Viewer, you can 
make your CartoVista solution available on a web server. 

A CartoVista Solution can run on a Windows or Unix/Linux machine. There are no 
server side components to install! 

 Copy the files from the CartoVista 4 folder along with the files from the 

Maps\<MapName> folder to your web server. Keep the folder structure as 
defined when you published your map. 

NOTE: You do not need to copy all of the folders in the Maps folder, just the ones 
containing maps you wish to make available on the web server. 

 Setup the web server to allow access to the HTML page in the 
Maps\<MapName> folder as the URL you wish your solution to be available 
from. 

Your CartoVista solution will now be available at the URL you have created. There 

are no server side components to install. A user simply needs to point his browser 
to the URL you have created. 
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Local & Media Browser Issues 

 

There are two issues that may arise when deploying locally or to media. These 
issues stem from your browser’s and Adobe Flash’s monitoring for dangerous 
content. In order to view a CartoVista Solution that is deployed locally, you may 
have to address one or both issues. 

Internet Explorer - Blocked Content 

When opening the solution in your browser, you may get the following warning: 

 

To view the CartoVista Solution, simply click on "Allow Blocked Content". 

Adobe Flash Security Rules: Flash Player Trust 

The default Adobe Flash Player Security Rules do not allow you to mix local and 
internet content within the browser. If the CartoVista Map you have published 

contains Tile Layer(s) or WMS Layer(s), you will have indicate to the Flash Player 
that the path where the CartoVista solution is located is safe. 

The Adobe Flash Player Trust is a set of files that list one or more directories that 

are "Trusted" by the Adobe Flash Player. By default, when you install the CartoVista 
Publisher, it adds the reference to the installation folder of CartoVista. 

The Flash Player Trust file for CartoVista is installed in the following folder on a 

Windows workstation: 

C:\Documents and Settings\<USERNAME>\Application Data\Macromedia\Flash 
Player\#Security\FlashPlayerTrust\CartoVista.cfg 

If you have mixed local and internet content, you will need to open the 

CartoVista.cfg file (or create a new one in a text editor) and add a reference to the 
folder of the CartoVista solution. 
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Configuring WMS Layers 

 

Determining Available WMS Server Data 

To see what map data is available on a WMS server, first make a call to the server 
with request=GetCapabilities using your web browser. The resulting file that is 
returned can be opened as a text file. This file provides a list of the supported 

image formats, coordinate system and layers available for that WMS server. 

The following is an example of such request: 

http://www2.dmsolutions.ca/cgi-
bin/mswms_gmap?SERVICE=WMS&VERSION=1.1.1&REQUEST=GetCapabilities 

Configuration File 

Configuration of a WMS layer 

As of version 4.1.1 the WMS configuration is accessed and edited directly within the 

CartoVista Publisher via the WMS Tab in Layer Property dialog. 

Default Configuration settings: 

NOTE: You are required to edit the default XML structured text and complete the 
required empty elements with the correct information to properly enable your WMS 

Layer so it can be published and accessible in the CartoVista Viewer. 

http://www2.dmsolutions.ca/cgi-bin/mswms_gmap?SERVICE=WMS&VERSION=1.1.1&REQUEST=GetCapabilities
http://www2.dmsolutions.ca/cgi-bin/mswms_gmap?SERVICE=WMS&VERSION=1.1.1&REQUEST=GetCapabilities
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Sample WMS Layer Configuration: 
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In the above example, two layers determined from the  http://geo.weather.gc.ca 

WMS Service were used and both these layers were query enabled. The SRS 
element was also set based on the information retrieved from the WMS Service. 
The default values for the optional Exception and  Image  elements were used.  

WMS Layer Elements 

HTTP Element (Required) 

The HTTP element determines the WMS Server that will provide the information for 

the WMS GetCapabilities and GetMap services. 
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Example: 

< HTTP GetCapabilities="http://atlas.gc.ca/cgi-bin/atlaswms_en?" 

GetMap="http://atlas.gc.ca/cgi-bin/atlaswms_en?"/> 

GetCapabilities Attribute 

This attribute is used to identify the WMS map server that will provide responses to 

the GetCapabilities service request. 

GetMap Attribute 

This attribute is used to identify the WMS map server that will provide responses to 
the GetMap service request. 

  

SRS Element (Required) 

The SRS element specifies a coordinate system used by the Web Map Service you 
are calling. 

Example: 

<SRS>EPSG:4269</SRS> 

EPSG Attribute 

This attribute specifies the EPSG code (projection) of the SWF map created with the 
Publisher. To get information on the EPSG code of your CartoVista map, access the 

Map Settings Dialog.   

NOTE: The Reference System used in the Publisher must match the EPSG number 
of the reference system (SRS) selected from the WMS Service Data. 

Exception Element (Optional) 

The Exception element specifies the message format when the service is not 
working and an error occurs. 

format Attribute 

The message format for the exception. 

Example (default value): 
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<Exception format="application/vnd.ogc.se_xml" /> 

Image Element (Optional) 

The image element contains the parameters of the requested image from the WMS 
layer. 

Example (default value): 

<Image format="image/png" bgcolor="0xFFFFFF" transparent="true" /> 

format Attribute 

The format (MIME type) of the image returned by the service. The format of the 
image must be one of the ones supported by the WMS server specified. 

bgcolor Attribute 

The background color in hexadecimal or in integer value of the image map 
returned. 

transparent Attribute 

Sets the image map’s transparency, either “true” or “false”. When set to true, the 

bgcolor element has no effect. 

Layer Element (Required) 

A WMS layer can contain a collection of layer elements. These elements correspond 
to the definition of the layers to be included in the map when requesting an image 

from the WMS server. 

Example: 

<Layer> 

          <Name>na_freshwat</Name> 

          <Style></Style>           

</Layer> 

  

Name Element (Required) 

This is the name of the requested layer on the WMS server. 
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Example: 

<Name>na_freshwat</Name> 

  

Style Element (Optional) 

This is the style associated to the requested layer on the WMS server. It is a 

comma-delimited list. If specified it must have the same number of names as the 
layer list. For style names containing spaces, use the '+' sign instead of the space. 

  

<Style></Style> 

  

Query_Layers Element (Optional) 

To enable the CartoVista Viewer info tool on any of the included named layers you 

will need to complete the <query_layers> element.  
  
Note: 

If more than one named layer is required, they must be separated by a comma 
within the Query_Layers element.  

  
Example: 
  

<Query_Layers>na_freshwat</Query_Layers> 

  
  

 


